User’s guide

For v6 of:

Nuance®
Dragon® Professional
Individual for Mac®
## Contents

**Dragon Professional for Mac User Guide** ................................................................. 1

Get started .................................................................................................................. 25

- Using the Dragon menu ......................................................................................... 25
  - Related topics: ........................................................................................................ 26

- The Status Window ................................................................................................. 26
  - To show or hide the Status Window ................................................................... 26
  - To set whether the Status Window should be visible when Dragon starts up ... 26

- Microphone mode button ....................................................................................... 26

- Recognition mode button ....................................................................................... 27

- Window menu button ............................................................................................. 27
  - Related topics: ........................................................................................................ 27

- The Guidance window ............................................................................................ 28
  - Showing or hiding the Guidance window ............................................................ 28
  - Related topics: ........................................................................................................ 28

- Recognition modes .................................................................................................. 28

- Using commands in Dictation mode ....................................................................... 29
  - Example: ................................................................................................................ 29
  - Example: ................................................................................................................ 29
  - Related topics: ........................................................................................................ 29

- Preferences window ................................................................................................ 30
  - To show the Preferences window ....................................................................... 30

- General .................................................................................................................... 30

- Profiles .................................................................................................................... 30

- Dragon Anywhere ................................................................................................... 31

- Shortcuts .................................................................................................................. 31
  - To set a shortcut .................................................................................................... 31
  - To delete a shortcut .............................................................................................. 31
  - To revert to a previous shortcut ........................................................................... 31

- Updates ..................................................................................................................... 32

- Advanced .................................................................................................................. 32

- Correction options: ................................................................................................. 32

- MouseGrid options: ................................................................................................. 32

- Data collection options: .......................................................................................... 32

- License ...................................................................................................................... 33
Enhanced transcription ................................................................. 40
Transcription Batch Mode ............................................................ 40
Updated web and application support .............................................. 40
Improved help .............................................................................. 40
Related topics: ............................................................................ 41

Upgrading from Dragon Dictate 4 or Dragon for Mac 5: FAQ .................. 41
All Upgrades ................................................................................. 41
I just finished upgrading – is there anything I can delete to save disk space? . 41
My profile won’t upgrade. What can I do? ......................................... 41
What happened to Transcription sources? ......................................... 42

Upgrading from Dragon for Mac 5 .................................................... 42
How has the Status Window changed? ............................................. 42

Upgrading from Dragon Dictate version 4 .......................................... 42
I just upgraded from Dragon Dictate version 4 – what do I need to do now? . 42
Where did Dragon go? ................................................................ 42
What happened to Text Macros? ..................................................... 42
Where is the Recognition Window? ................................................ 43
How has the Status window changed? ............................................. 43
Where is the Note Pad? ................................................................ 43
Where is the Express Editor? ......................................................... 43
Related topics: ............................................................................ 43

Activate and Register .................................................................... 43
To activate your license .................................................................. 43
To register your copy of Dragon Professional Individual for Mac ............. 44
To deactivate your Dragon Professional Individual for Mac license .......... 44
Related topics: ............................................................................ 44

Use the microphone ...................................................................... 45
Microphone Setup ......................................................................... 45
To open the Microphone Setup window ............................................ 45
To complete Microphone Setup ....................................................... 45
To manually adjust gain .................................................................. 45
Related topics: ............................................................................ 45

Microphone modes ....................................................................... 46
Changing the microphone mode ...................................................... 46
Related topics: ............................................................................ 46
<table>
<thead>
<tr>
<th>Microphone placement</th>
<th>46</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using your Mac’s built-in microphone</td>
<td>47</td>
</tr>
<tr>
<td>Positioning a headset microphone</td>
<td>47</td>
</tr>
<tr>
<td>Positioning a hand-held microphone</td>
<td>47</td>
</tr>
<tr>
<td>Related topics:</td>
<td>47</td>
</tr>
</tbody>
</table>

**Dictate text** | 48 |
| Getting started with dictation | 48 |
| Creating a new document | 48 |
| Dictation guidelines | 49 |
| How to dictate | 49 |
| Where to dictate | 49 |
| How to add punctuation | 49 |
| How to use commands | 49 |
| Related Topics: | 49 |

**Mixing dictation with typing** | 49 |
| What applications are supported? | 50 |
| What does it mean if my application isn't supported? | 50 |
| About the cache | 51 |
| Related topics: | 51 |

**Dictation overview** | 51 |
| Paragraph and line breaks | 51 |
| Example | 51 |
| Punctuation—General | 52 |
| Example | 52 |
| Quotes | 52 |
| To dictate quotes as you speak | 52 |
| To dictate quotes after dictating a word or phrase | 52 |
| Example 1 | 52 |
| Example 2 | 52 |
| Bullets | 52 |
| Example | 52 |
| Email and Web addresses | 52 |
| Example 1 | 52 |
| Example 2 | 52 |
| Example 3 | 53 |
Proper nouns ........................................................................................................... 53
  Example 1 ........................................................................................................... 53
  Example 2 ........................................................................................................... 53
Hyphenated words .................................................................................................. 53
  Example 1 ........................................................................................................... 53
  Example 2 ........................................................................................................... 53
Compound words .................................................................................................... 53
  Example 1 ........................................................................................................... 53
  Example 2 ........................................................................................................... 53
Abbreviations .......................................................................................................... 53
  Example .............................................................................................................. 53
Acronyms ................................................................................................................ 53
  Example 1 ........................................................................................................... 53
  Example 2 ........................................................................................................... 53
  Related topics: ................................................................................................... 54
Take it back .............................................................................................................. 54
  Example 1 ........................................................................................................... 54
  Example 2 ........................................................................................................... 54
  Example 3 ........................................................................................................... 55
  Related topics: ................................................................................................... 55
Dictating punctuation and symbols ....................................................................... 55
  To place punctuation around text .................................................................... 55
Punctuation and symbols ....................................................................................... 55
  Related topics: ................................................................................................... 57
Dictating letters ...................................................................................................... 57
Recognition modes and spelling ........................................................................... 57
Letters ..................................................................................................................... 57
Dictating Acronyms ............................................................................................... 58
Accents and other non-English letters ................................................................. 59
  Diacritical Letters ............................................................................................ 59
  Ligatures and Non-Latin Letters .................................................................... 59
  Related topics: ................................................................................................... 60
Dictating numbers .................................................................................................. 60
Dictating numbers ................................................................................................. 60
  Example 1—Numerals ...................................................................................... 60
Example 2—Decimals ................................................................. 60
Example 3—Fractions ............................................................... 60
Example 4—Phone numbers ..................................................... 60
Example 5—Postal codes ........................................................ 60
Example 6—Currency .............................................................. 61
Example 7—Dates ................................................................. 61
Example 8—Time ................................................................. 61
Example 9—Weight ............................................................... 61
Forcing numerals ................................................................. 61
Example ................................................................. 61
Superscripts ................................................................. 61
Example ................................................................. 61
Roman numerals ................................................................. 61
To dictate lowercase Roman numerals .................................. 61
Example 1 ................................................................. 61
Example 2 ................................................................. 61
Numbers mode ................................................................. 61
To dictate numbers in Numbers mode .................................. 61
Example ................................................................. 61
Related topics: ................................................................. 61

Correct mistakes ................................................................. 63
Correcting recognition errors ............................................... 63
Correction vs. editing .......................................................... 63
Example ................................................................. 63
Use Correction if ............................................................... 63
Use select and replace if ..................................................... 63
Related topics: ................................................................. 63
Using Correction ................................................................. 63
Showing the Correction window ............................................ 64
Making a correction ........................................................... 64
Smart Formatting ............................................................... 65
Related topics: ................................................................. 65

Edit text ................................................................. 66
Revising text ................................................................. 66
Making a selection ........................................................... 66
Replacing text ................................................................. 67
Inserting text ................................................................. 67
Deleting text ................................................................. 67
  To delete the last thing you said ........................................ 67
  To delete a specific word or string of words .................... 67
Copying, cutting and pasting text ................................... 67
  To cut text ..................................................................... 67
  To copy text ................................................................... 67
  To paste text ................................................................... 67
  Related topics: ................................................................... 67
Hearing your text ............................................................ 68
  Related topics ................................................................... 68

Format text ........................................................................... 69

Auto Formatting .................................................................... 69
  To open the Auto Formatting window: ............................ 69
Street Addresses .............................................................. 69
  Example .......................................................................... 69
UK and Canadian postcodes .............................................. 70
  Example .......................................................................... 70
Web and email addresses .................................................. 70
  Example 1—Email ............................................................ 70
  Example 2—Website ........................................................ 70
Phone numbers ............................................................... 70
  Example .......................................................................... 70
Abbreviated titles ............................................................ 70
  Example .......................................................................... 70
Dates ................................................................................ 70
  Example .......................................................................... 70
Times ................................................................................ 70
  Example .......................................................................... 70
Use numerals starting with ............................................. 70
  Example 1 ....................................................................... 70
  Example 2 ....................................................................... 71
Partially format "-illion" numbers ......................................... 71
  Example .......................................................................... 71
All Caps ................................................................................................................. 74
To make a word ALL-CAPS as you dictate .......................................................... 74
To make the next string of words all-caps as you dictate .................................. 74
To make text you have already dictated all-caps .................................................. 74
Related topics: ....................................................................................................... 74
Spacing .................................................................................................................. 74
To insert a space .................................................................................................... 74
To adjust spacing as you dictate ........................................................................... 74
To delete a space before a word you already dictated ........................................... 74
Related topics: ....................................................................................................... 74
Aligning text .......................................................................................................... 75
To align the current paragraph ............................................................................. 75
To justify text ......................................................................................................... 75
To align the whole document .................................................................................. 75
Related topics: ....................................................................................................... 75
Transcription ......................................................................................................... 76
Transcribing recorded audio .................................................................................. 76
Selecting an audio file for Transcription .............................................................. 76
Editing a transcribed file ...................................................................................... 77
Where are my transcriptions? ................................................................................ 78
Deleting a Transcription speaker ......................................................................... 78
Exiting Transcription mode ................................................................................... 78
Related topics: ....................................................................................................... 78
Transcription Training ........................................................................................... 78
Related topics: ....................................................................................................... 78
Control your computer .......................................................................................... 80
Launching and quitting applications .................................................................... 80
Related topics: ....................................................................................................... 80
Navigating application windows .......................................................................... 81
To open a new file or window .............................................................................. 81
To close the current file or window ..................................................................... 81
To switch between windows or applications ..................................................... 81
To hide or show windows or applications ............................................................ 81
Related topics: ....................................................................................................... 81
OS X controls ....................................................................................................... 81
To put your computer in sleep mode ................................................................. 81
To restart your computer .................................................................................. 81
To quit unresponsive applications ...................................................................... 81
To toggle full screen mode .................................................................................. 81
To capture images of your screen .................................................................... 81
Related topics: .................................................................................................... 82

Working with the Finder .................................................................................... 82
Adjusting the window display ............................................................................ 82
To show or hide bars in Finder windows ............................................................ 82
To show or hide the Dock .................................................................................. 82
To toggle Zoom view ......................................................................................... 82
Adjusting the folder display ............................................................................. 82
To change the way items are displayed .............................................................. 82
To arrange items in your view ........................................................................... 82
To create a Sidebar shortcut to the selected item ............................................. 82

Managing files and folders ................................................................................ 83
To open the selected file or folder ...................................................................... 83
To rename the currently selected item ............................................................... 83
To rename another item in the current folder .................................................. 83
To view a Quick Look heads up display of the selected item ............................. 83
To view the original file associated with a selected alias .................................. 83
To deselect all items in the current folder .......................................................... 83

Creating and deleting items .............................................................................. 83
To create a new folder ....................................................................................... 83
To create a copy of the selected item(s) ............................................................. 83
To create an alias of the selected item ............................................................... 83
To create a compressed Zip file of the selected folder ....................................... 83
To delete the selected item(s) ........................................................................... 83
To permanently delete all files in the Trash folder .......................................... 83

Navigating windows ......................................................................................... 83
To go to the next or previous view in the active window ................................ 83
To go to the enclosing folder for the selected item .......................................... 83
To go to a specific folder .................................................................................. 83
To open the Go to Folder dialog in the Finder ................................................ 84
To search the Finder ....................................................................................... 84
Navigating folders ................................................................. 84
To open the Connect to Server window ........................................ 84
To cycle through the open Finder windows ................................. 84
To bring all Finder windows to the front .................................... 84
To close all Finder windows .......................................................... 84
Ejecting a drive or disc .................................................................. 84
Related topics: ................................................................. 84
Using dialog controls ............................................................... 84
Related topics: ................................................................. 84
Key commands ......................................................................... 85
How to say a key command ....................................................... 85
Key names ............................................................................. 85
Modifier keys .......................................................................... 86
Related topics: ................................................................. 86
Menu Walking ........................................................................ 86
Related topics: ................................................................. 86
Mouse commands ..................................................................... 87
Moving the mouse .................................................................... 87
To make the cursor begin moving in a specified direction .......... 87
To move the cursor a specified number of units in the specified direction ................................................. 87
Clicking the mouse .................................................................. 87
Related topics: ................................................................. 87
MouseGrid ............................................................................ 87
Opening the MouseGrid .............................................................. 88
Zooming in ............................................................................ 88
Dismissing the MouseGrid .......................................................... 88
Changing MouseGrid settings .................................................... 88
Related topics: ................................................................. 88
Create documents .................................................................... 89
Working with Microsoft Word ..................................................... 89
Creating a document ............................................................... 89
Navigating within your document ............................................... 89
Selecting text ........................................................................... 89
Editing your document .............................................................. 90
Formatting your document .......................................................... 90
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change the font size</td>
<td>90</td>
</tr>
<tr>
<td>To insert a page break</td>
<td>90</td>
</tr>
<tr>
<td>Saving your document</td>
<td>90</td>
</tr>
<tr>
<td>Printing your document</td>
<td>90</td>
</tr>
<tr>
<td>Closing your document</td>
<td>90</td>
</tr>
<tr>
<td>Related topics:</td>
<td>90</td>
</tr>
<tr>
<td>Working with TextEdit</td>
<td>90</td>
</tr>
<tr>
<td>Creating or open a document</td>
<td>91</td>
</tr>
<tr>
<td>Navigating within your document</td>
<td>91</td>
</tr>
<tr>
<td>Finding text in your document</td>
<td>91</td>
</tr>
<tr>
<td>Selecting text</td>
<td>91</td>
</tr>
<tr>
<td>Editing your document</td>
<td>91</td>
</tr>
<tr>
<td>To paste text using the font formatting of the paste location</td>
<td>91</td>
</tr>
<tr>
<td>Formating your document</td>
<td>91</td>
</tr>
<tr>
<td>To increase or decrease the font size</td>
<td>92</td>
</tr>
<tr>
<td>To apply text spacing, such as indenting and Tabs, from one part of the text to another</td>
<td>92</td>
</tr>
<tr>
<td>Saving your document</td>
<td>92</td>
</tr>
<tr>
<td>To undo all your changes since the last time you saved</td>
<td>92</td>
</tr>
<tr>
<td>Printing your document</td>
<td>92</td>
</tr>
<tr>
<td>Closing your document</td>
<td>92</td>
</tr>
<tr>
<td>Adjusting your view</td>
<td>92</td>
</tr>
<tr>
<td>To wrap text</td>
<td>92</td>
</tr>
<tr>
<td>To bring all TextEdit windows to the front</td>
<td>92</td>
</tr>
<tr>
<td>To toggle Zoom view for the current window</td>
<td>92</td>
</tr>
<tr>
<td>To close all TextEdit windows</td>
<td>92</td>
</tr>
<tr>
<td>Related topics:</td>
<td>92</td>
</tr>
<tr>
<td>Navigating within a document</td>
<td>92</td>
</tr>
<tr>
<td>To move the cursor to the first or last position in the current document</td>
<td>93</td>
</tr>
<tr>
<td>To move the cursor a specified number of words from its current position</td>
<td>93</td>
</tr>
<tr>
<td>To insert the cursor before a specified word or phrase</td>
<td>93</td>
</tr>
<tr>
<td>To move the cursor to its previous position</td>
<td>93</td>
</tr>
<tr>
<td>To move the cursor up, down, left or right</td>
<td>93</td>
</tr>
<tr>
<td>To move the cursor to a new text field</td>
<td>93</td>
</tr>
<tr>
<td>Related topics:</td>
<td>93</td>
</tr>
<tr>
<td>Use applications</td>
<td>94</td>
</tr>
</tbody>
</table>
Working with Mail ................................................................. 94
Creating a new message ...................................................... 95
To reply to the selected message ......................................... 95
To forward the selected message .......................................... 95
To resend the selected message ............................................. 95
Navigating within your message .......................................... 95
Selecting text .................................................................. 95
Editing your message ......................................................... 96
Formatting text .................................................................. 96
Sending your message .......................................................... 97
Navigating messages and threads ......................................... 97
To scroll within a message or thread ..................................... 97
To toggle viewing threads in the Mailbox pane ....................... 97
To move between messages ................................................ 97
To view your selected message or thread in the Mailbox ......... 97
To check for new messages .................................................. 97
Printing a message ............................................................... 97
Managing your messages ..................................................... 97
To sort your messages .......................................................... 97
To label the selected message .............................................. 97
To delete the selected message .......................................... 97
To clear deleted or junk messages ........................................ 98
Searching your messages ..................................................... 98
To search the text of the current message ................................ 98
To search your Mailbox ....................................................... 98
Navigating your mailboxes ................................................... 98
To switch to the Viewer Window .......................................... 98
To navigate between Mailboxes ........................................... 98
Creating and deleting mailboxes .......................................... 98
To create a new Mailbox ....................................................... 98
To rename the selected Mailbox ......................................... 98
To delete the selected Mailbox: ........................................... 98
Adjusting your view ............................................................ 98
Related topics: .................................................................. 99
Working with TextEdit ........................................................ 99
To switch between tabs ................................................................. 103
Navigating within a page ............................................................ 103
To scroll .................................................................................. 103
To scroll to the top or bottom of the current page ................................ 103
To jump to the selected text on the current page ................................ 103
To move between editable text fields ............................................ 104
Searching a website .................................................................... 104
To find specific text on a page ..................................................... 104
To navigate between instances of the search term .......................... 104
Loading pages ........................................................................... 104
Using tabs .................................................................................. 104
To create a tab ........................................................................... 104
To close tabs ............................................................................. 104
To move a tab into a new window ............................................... 104
Safari windows ........................................................................... 104
To close all Safari windows ........................................................... 104
To reopen Safari windows ........................................................... 104
To bring all Safari windows to the front ....................................... 104
To merge all current Safari windows ............................................ 104
Adding or editing Bookmarks ....................................................... 104
To show or hide the Bookmarks Bar .............................................. 104
To add a bookmark .................................................................... 104
To show or hide the Bookmark Manager ....................................... 105
To create a shortcut in Dragon for the current page ....................... 105
Auto Fill ..................................................................................... 105
Sharing a Web page ..................................................................... 105
Printing ....................................................................................... 105
Changing your view ...................................................................... 105
History ......................................................................................... 105
Related topics: ........................................................................... 105
Working with Firefox ................................................................... 105
Opening a Web page .................................................................... 105
Dictating text ............................................................................. 106
Related topics: ........................................................................... 106
Working with Calendar ............................................................... 106
To create a new event .............................................................. 106
To delete an event ................................................................. 106
To search Calendar ............................................................... 106
To refresh your calendars ...................................................... 106
To back up the selected calendar ............................................ 107
Adjusting your calendar view ................................................ 107
To change the time period shown .......................................... 107
To move to a different date .................................................... 107
To show or hide all-day events on your calendar ...................... 107
To show or hide events on a specific calendar ......................... 107
Showing and hiding windows ................................................ 107
To show or hide Calendar panels .......................................... 107
To toggle Zoom view for the current window ......................... 107
Related topics: ...................................................................... 107
Working with Messages ......................................................... 107
Related topics: ...................................................................... 108

Browse the web ...................................................................... 109
Dragon Web Extensions ......................................................... 109
Installing Dragon Web Extensions ......................................... 109
Upgrading Dragon Web Extensions ........................................ 109
Setting up Dragon Web Extensions—Safari ............................ 110
To allow Dragon to run on all websites ................................. 110
Setting up Dragon Web Extensions—Firefox .......................... 111
To allow Dragon to run on all websites ................................. 111
Using Dragon Web Extensions to access links and other Web controls ......................................................... 112
To click a link or other website control ................................. 112
To show all controls ............................................................. 112
To hide the numbers ............................................................. 112
Disabling or Uninstalling Dragon Web Extensions—Firefox .... 112
To disable or uninstall Dragon Internet Extension ................ 112
To disable Dragon Internet Plug-In ...................................... 112
Disabling or Uninstalling Dragon Web Extensions—Safari .......... 113
To uninstall Dragon Dictate Web Extensions (v4) .................. 113
To disable or uninstall Dragon Web Extensions (v5 or later) ..... 113
Related topics: ...................................................................... 113
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening a Web page</td>
<td>116</td>
</tr>
<tr>
<td>Dictating text</td>
<td>116</td>
</tr>
<tr>
<td>Related topics:</td>
<td>117</td>
</tr>
<tr>
<td>Posting to Facebook and Twitter</td>
<td>117</td>
</tr>
<tr>
<td>To post the last text you dictated or selected</td>
<td>117</td>
</tr>
<tr>
<td>To dictate text to post</td>
<td>117</td>
</tr>
<tr>
<td>Related topics:</td>
<td>118</td>
</tr>
<tr>
<td><strong>Make Dragon more accurate</strong></td>
<td>119</td>
</tr>
<tr>
<td>Editing Dragon's Vocabulary</td>
<td>119</td>
</tr>
<tr>
<td>To open the Vocabulary Editor window</td>
<td>119</td>
</tr>
<tr>
<td>The Vocabulary list</td>
<td>119</td>
</tr>
<tr>
<td>Searching for vocabulary</td>
<td>120</td>
</tr>
<tr>
<td>Adding a User vocabulary item</td>
<td>120</td>
</tr>
<tr>
<td>Editing a user vocabulary item</td>
<td>120</td>
</tr>
<tr>
<td>Training a vocabulary item</td>
<td>121</td>
</tr>
<tr>
<td>Deleting a user vocabulary item</td>
<td>121</td>
</tr>
<tr>
<td>Exporting vocabulary items</td>
<td>121</td>
</tr>
<tr>
<td>Importing vocabulary items</td>
<td>121</td>
</tr>
<tr>
<td>Related topics:</td>
<td>121</td>
</tr>
<tr>
<td>Voice Training</td>
<td>121</td>
</tr>
<tr>
<td>Related topics:</td>
<td>122</td>
</tr>
<tr>
<td>Vocabulary Training</td>
<td>122</td>
</tr>
<tr>
<td>To open the Vocabulary Training window</td>
<td>122</td>
</tr>
<tr>
<td>To select a file for Vocabulary Training</td>
<td>122</td>
</tr>
<tr>
<td>Related topics:</td>
<td>123</td>
</tr>
<tr>
<td><strong>Use email</strong></td>
<td>124</td>
</tr>
<tr>
<td>Working with email</td>
<td>124</td>
</tr>
<tr>
<td>Creating a new message from anywhere on your Mac</td>
<td>124</td>
</tr>
<tr>
<td>Working with email applications</td>
<td>124</td>
</tr>
<tr>
<td>Other email applications</td>
<td>125</td>
</tr>
<tr>
<td>Related topics:</td>
<td>125</td>
</tr>
<tr>
<td>Working with Mail</td>
<td>125</td>
</tr>
<tr>
<td>Creating a new message</td>
<td>125</td>
</tr>
<tr>
<td>To reply to the selected message</td>
<td>125</td>
</tr>
<tr>
<td>To forward the selected message</td>
<td>126</td>
</tr>
</tbody>
</table>
Forwarding an email .......................................................... 130
Deleting an email ............................................................ 131
Navigating Gmail ............................................................. 131
Related topics: ................................................................. 131

AutoTexts ........................................................................... 132
Auto-text commands ......................................................... 132
Why you should use Auto-text commands ......................... 132
Creating an Auto-text command ......................................... 133
Editing an Auto-text command ............................................ 133
Related topics: ................................................................. 133
Using fields with Auto-text commands ............................... 133
Setting up your fields ....................................................... 134
Navigating fields and specifying their values ....................... 134
To fill in the text fields .................................................... 134
Related topics: ................................................................. 134

Manage Dragon Commands ................................................ 135
The Commands window ..................................................... 135
Viewing the commands list ............................................... 135
To return to the contexts list ............................................ 136
To filter commands ........................................................ 136
Viewing command details ............................................... 136
Creating a custom command ............................................ 137
Editing a custom command ............................................. 137
Deactivating a command .................................................. 137
Deleting a custom command ............................................ 137
Related topics: ................................................................. 137
Create a command ........................................................... 138
What are custom commands? .......................................... 138
Creating a custom command ............................................ 138
Menu Item ................................................................. 139
Keystroke ................................................................. 139
Bookmark ................................................................. 140
File or Folder ............................................................ 141
Application .............................................................. 142
Advanced commands .................................................... 143
AppleScript ................................................................. 143
Automator Workflow .................................................. 143
Shell Script ................................................................. 143
Related topics: ............................................................... 144
Import and export commands ........................................ 144
Exporting commands ................................................... 144
Importing commands ................................................... 145
Related topics: ............................................................... 145
Troubleshooting .......................................................... 146
Troubleshooting overview ............................................. 146
Recognition is poor ...................................................... 146
Have you gotten better results from Dragon in the past? .... 146
Yes: ................................................................. 146
No: ................................................................. 147
Are you having trouble with a specific word? .................... 147
Cursor is jumping to the wrong place ................................ 147
Dragon is only responding to commands .......................... 147
No audio detected ....................................................... 147
Commands are not working .......................................... 148
Are you using a custom command? ................................. 148
Yes: ................................................................. 148
No: ................................................................. 148
Correction is not working ............................................. 148
Dragon is not working with my Web browser ..................... 148
Are you using Firefox or Safari? ..................................... 148
No: ................................................................. 148
Yes: ................................................................. 148
Dragon menu is not showing in the menu bar .................... 149
Auto Sleep is not working ............................................. 149
Dragon is not responding ............................................. 149
Related topics: ............................................................... 149
Troubleshooting audio and recognition ......................... 149
Supported Devices ...................................................... 149
No audio signal ......................................................... 150
Check your microphone mode ................................. 150
Check your connection .......................................................... 150
Check microphone settings ...................................................... 150
Restart .................................................................................. 150
Poor audio quality .................................................................. 151
Check your microphone placement ........................................... 151
Recalibrate your microphone or reset the gain ......................... 151
Reduce background noise ....................................................... 151
Listen to your audio ............................................................... 151
Poor recognition .................................................................... 151
Check your profile .................................................................. 151
Voice Training ......................................................................... 152
Vocabulary Training ............................................................... 152
Re-create dictation source ....................................................... 152
Related topics: ....................................................................... 154
Troubleshooting Dragon Web Extensions .................................. 154
Dictation is not working properly in my Web browser ................ 155
Related topics: ....................................................................... 155
Troubleshooting Commands ...................................................... 155
MouseGrid does not appear on my second display .................... 156
New or duplicated commands do not work ............................... 156
Custom commands are missing ............................................... 157
Commands from Dragon Dictate 4 do not work ....................... 158
Related topics: ....................................................................... 158
Troubleshooting Vocabulary ..................................................... 158
I can't add documents to Vocabulary Training ......................... 158
My custom vocabulary words are missing ............................... 158
Related topics: ....................................................................... 158
Issues with Upgraded Profiles .................................................. 158
Profile upgrade failed .............................................................. 158
Option 1: ............................................................................... 159
Option 2 ............................................................................... 159
Transcription profile is missing ............................................... 159
Related topics: ....................................................................... 160
Uninstall Dragon Professional Individual for Mac version 6 ........... 160
To uninstall Dragon ............................................................... 160
To remove Dragon’s data from your hard drive ............................................. 160
To remove Dragon Anywhere data ................................................................. 160
To remove the Dragon Web Plug-in ............................................................... 160
To remove the Dragon Web Extension for Safari .......................................... 160
To remove the Dragon Web Extension for Firefox ........................................ 161
Related topics: ......................................................................................... 161
Get started

New to Dragon? Read these topics to learn the basics about Dragon’s features and user interface.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using the Dragon menu</strong></td>
<td>• How do I access Dragon’s features through the Dragon menu?</td>
</tr>
<tr>
<td><strong>The Status Window</strong></td>
<td>• What can I do with the Status Window?</td>
</tr>
<tr>
<td><strong>The Guidance window</strong></td>
<td>• How do I show or hide the Guidance window?</td>
</tr>
<tr>
<td><strong>Recognition modes</strong></td>
<td>• What are recognition modes?</td>
</tr>
<tr>
<td><strong>Using profiles and dictation sources</strong></td>
<td>• How can I tell what recognition mode I’m in?</td>
</tr>
<tr>
<td><strong>Using DragonPad</strong></td>
<td>• How do I switch modes?</td>
</tr>
<tr>
<td><strong>Dragon Anywhere</strong></td>
<td>• What is Dragon Anywhere?</td>
</tr>
<tr>
<td><strong>FAQs</strong></td>
<td>• What is a profile?</td>
</tr>
<tr>
<td><strong>What’s New?</strong></td>
<td>• What is a dictation source?</td>
</tr>
<tr>
<td><strong>Using DragonPad</strong></td>
<td>• How can I tell what recognition mode I’m in?</td>
</tr>
<tr>
<td><strong>Dragon Anywhere</strong></td>
<td>• How do I switch to a different profile or dictation source?</td>
</tr>
<tr>
<td><strong>FAQs</strong></td>
<td>• How do I create a new profile or dictation source?</td>
</tr>
<tr>
<td><strong>What’s New?</strong></td>
<td>• How do I delete a profile or dictation source?</td>
</tr>
<tr>
<td><strong>Using the Dragon menu</strong></td>
<td>• What is DragonPad?</td>
</tr>
<tr>
<td><strong>Show / Hide Commands…</strong></td>
<td>• How do I switch to Transcription mode or back to Dictation mode</td>
</tr>
<tr>
<td><strong>Show / Hide Status Window</strong></td>
<td>• How do I create a new profile or dictation source?</td>
</tr>
<tr>
<td><strong>Show / Hide Guidance</strong></td>
<td>• How do I delete a profile or dictation source?</td>
</tr>
<tr>
<td><strong>Using DragonPad</strong></td>
<td>• What is DragonPad?</td>
</tr>
<tr>
<td><strong>Show / Hide Commands…</strong></td>
<td>• How do I switch to Transcription mode or back to Dictation mode</td>
</tr>
<tr>
<td><strong>Show / Hide Guidance</strong></td>
<td>• How do I create a new profile or dictation source?</td>
</tr>
<tr>
<td><strong>Show / Hide Guidance</strong></td>
<td>• How do I delete a profile or dictation source?</td>
</tr>
<tr>
<td><strong>Editing Vocabulary…</strong></td>
<td>• Frequently Asked Questions about Dragon Professional Individual for Mac version 6</td>
</tr>
<tr>
<td><strong>Add New Auto-text</strong></td>
<td>• What’s new in Dragon Professional Individual for Mac version 6?</td>
</tr>
</tbody>
</table>

**Using the Dragon menu**

The Dragon menu gives you access to everything you need to use Dragon. To access the menu, click the ⬇️ icon in your menu bar.

Select a feature in the Dragon menu to access it, or click a link below to find out more about each feature.

- **Turn Microphone On / Off**—Toggle the microphone on or off
- **Switch to Transcription / Dictation**—Change to Transcription mode or back to Dictation mode
- **Show / Hide Status Window**—Toggle the Status window
- **Show / Hide Commands…**—Toggle the Commands window
- **Show / Hide Guidance**—Toggle the Guidance window
- **Edit Vocabulary…**—Access the Vocabulary Editor
- **Add New Auto-text**—Create an Auto-text command to insert frequently used text, such as an address.
- **Recent Profiles**—Choose between recently used profiles and dictation sources. The currently selected profile is shown with a check mark beside it.
- **Manage Profiles…**—Opens the Profiles pane of the Preferences window
- **Improve Recognition >**
- **Voice Training**—Access the Voice Training window (available only in Dictation mode)
- **Transcription Training**—Access the Transcription Training window (available only in Transcription mode)
- **Vocabulary Training**—Access the Vocabulary Training window
- **Microphone Setup**—Access the Microphone Setup window

**Preferences**—Open the Preferences window

**Help**
- **About Dragon**—See information about the version of Dragon Professional Individual for Mac that you are running
- **Dragon Help**—Access Dragon Professional Individual for Mac online help.
- **Tutorial**—Open the Dragon tutorial.
- **DragonPad**—Access the DragonPad.
- **Deactivate or Activate**: Deactivate your license for Dragon Professional Individual for Mac, or activate a license if you are using the free trial period.
- **Register for Support**: Register your copy of Dragon Professional Individual for Mac

**Quit Dragon**: Exit Dragon

### Related topics:
- The Status Window
- The Guidance window
- Getting started with dictation

### The Status Window

The Status Window gives you quick access to Dragon's most important features, like the microphone and recognition mode, and offers access to the Guidance, Commands, and Correction windows.

When the Status Window is showing, it floats over all applications.

**To show or hide the Status Window**
- Say “Show Status Window” or “Hide Status Window.”
  - Or
  - Click the 🆕️ icon in the menu bar, then select Show Status Window or Hide Status Window.

**To set whether the Status Window should be visible when Dragon starts up**
1. Click the 🆕️ icon in the menu bar and select Preferences…
   - The Preferences window opens.
2. In the General pane, check or uncheck Show Status Window at Startup.

**Microphone mode button**

The microphone button's icon indicates the microphone mode:
<table>
<thead>
<tr>
<th>Indicator button</th>
<th>Mode</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>On</td>
<td>Dragon is listening to your speech.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Dragon is not listening. Click the button to turn the microphone on.</td>
</tr>
<tr>
<td></td>
<td>Sleep mode</td>
<td>Dragon will only respond to the command &quot;Wake up.&quot; All other speech is ignored.</td>
</tr>
</tbody>
</table>

Click the microphone button to toggle the microphone on or off.

See [Microphone modes](#) for more information.

### Recognition mode button

The Recognition mode determines what you can say to Dragon. The mode button indicates the current recognition mode:

<table>
<thead>
<tr>
<th>Indicator button</th>
<th>Mode</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dictation mode</td>
<td>Dictate text to be typed and issue commands</td>
</tr>
<tr>
<td></td>
<td>Command mode</td>
<td>Issue commands</td>
</tr>
<tr>
<td></td>
<td>Spelling mode</td>
<td>Dictate letters, numbers, and punctuation</td>
</tr>
<tr>
<td></td>
<td>Numbers mode</td>
<td>Dictate numbers and some punctuation</td>
</tr>
</tbody>
</table>

Click the Recognition mode button to open the Recognition mode menu.

See [Recognition modes](#) for more information.

### Window menu button

Click the icon to view the Window menu. Here, you can show or hide the following Dragon windows:

- **Commands**: View and edit Dragon’s commands. See [The Commands window](#) for more information.
- **Correction**: While dictating text, you can view the Correction window to see corrections for the last utterance spoken. See [Using Correction](#) for more information.
- **Guidance**: View Dragon’s current status and common command suggestions based on your current state. See [The Guidance window](#) for more information.

### Related topics:

- [Using the Dragon menu](#)
- [Getting started with dictation](#)
The Guidance window

The Guidance window offers information about Dragon's current status as well as suggested commands. When the Guidance window is showing, it floats over all applications.

The Guidance window offers information about:

- Dragon's current state, including:
  - The most recent command you spoke, transcribed into text.
  - Special states such as Caps On.
  - How Dragon works in the current application.

For details on how Dragon works in different applications, see Mixing dictation with typing.

- Common next steps based on what you are doing right now.

Click the Commands button to view and edit all of Dragon's commands. For information, see The Commands window.

Click the Help button to view the Dragon online help.

Showing or hiding the Guidance window

To show or hide the Guidance window, do one of the following:

- Say "Show Guidance" or "Hide Guidance."
- In the Status window, click the icon and choose Show Guidance or Hide Guidance.
- Click the icon in the menu bar and select Show Guidance or Hide Guidance.

Related topics:
- Mixing dictation with typing
- The Commands window
- The Status Window

Recognition modes

You use recognition modes to tell Dragon what to listen for. Your current mode is displayed in the Status window.

To select modes, do one of the following:

- Say "Switch to Dictation mode," "Switch to Command mode," "Switch to Spelling mode" or "Switch to Numbers mode."
- Click the Recognition mode icon in the Status Window and select a mode from the menu.
- Press the keyboard shortcut (by default, ⌘F10) for cycling between recognition modes. See Preferences window: Shortcuts for more information on setting keyboard shortcuts.
<table>
<thead>
<tr>
<th>Status window icon</th>
<th>Mode</th>
<th>What you can do:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dictation mode</td>
<td>In Dictation mode, you can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Dictate text to be typed, including punctuation, letters and numbers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See <a href="#">Using commands in Dictation mode</a>, below, for tips on getting the best results in Dictation mode.</td>
</tr>
<tr>
<td></td>
<td>Command mode</td>
<td>In Command mode, you can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you say something that Dragon can't interpret as a command, nothing happens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open the Guidance Window for suggested commands based on your recent actions.</td>
</tr>
<tr>
<td></td>
<td>Spelling mode</td>
<td>In Spelling mode, you can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Dictate letters, numbers, and punctuation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No automatic spacing or capitalization will be applied.</td>
</tr>
<tr>
<td></td>
<td>Numbers mode</td>
<td>In Numbers mode, you can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Dictate numbers and some punctuation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Issue commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All numbers are typed as numerals. You can also enter certain punctuation, such as mathematical symbols.</td>
</tr>
</tbody>
</table>

**Using commands in Dictation mode**

Because Dictation mode allows you to dictate and use commands, Dragon uses pauses to determine whether a phrase should be considered a command or dictated text. For best recognition when issuing a command, speak the command smoothly and continuously, but pause before and after it.

If you speak smoothly and continuously, Dragon will interpret your words as *dictation*, even if they include words that might be a command.

**Example:**

*Say:* "Select date and time."

*Result:* "Select date and time."

If you pause before and after a phrase, Dragon will consider that phrase as a possible *command*.

**Example:**

*Say:* "What is today’s date" [pause] “Select date."

*Result:* "What is today’s date."

**Related topics:**

- **Recognition mode button**
- **Dictation overview**
- **Dictating letters**
- **Dictating numbers**
- **The Commands window**
Preferences window

In this topic, learn how to use the Preferences window to customize Dragon settings, including:

- General preferences
- Profiles and dictation sources
- Dragon Anywhere accounts
- Keyboard shortcuts
- Update Dragon
- Advanced preferences
- License keys or Dragon accounts

The Preferences window allows you to customize various Dragon settings.

To show the Preferences window

- Say "Access Dragon Preferences window."
- Or
- Click the ☰ icon in the menu bar, then select Preferences…

There are six panes in the Preferences window:

General

In the General pane of the Preferences window, you can control basic aspects of Dragon's appearance and behavior.

See more…

Startup options:

- **Microphone in Sleep instead of Off at Startup**—Select to change the default microphone mode when Dragon launches to sleep. Otherwise, Dragon launches with the microphone turned off.
  This allows you to turn the microphone on by saying "Wake up" rather than having to use your mouse.
- **Show Status Window at Startup**—Select to show the Status Window at launch time. Otherwise, you will have to show the Status Window by saying "Wake up". For more information, see The Status Window.
- **Launch Dragon at Startup**—Select to allow Dragon to launch when you turn on your computer. This means Dragon will always be available to you – just turn on your microphone and speak.

Command Generation options:

- **Generate Application Launch Commands**—Select to allow Dragon to create globally available commands you can use to launch any application on your computer. See Launching and quitting applications for details.
- **Generate Email Commands**—Select to allow Dragon to create globally available commands to create and address an email message to anyone in your Contacts list. See Working with Mail for details on email commands.

Restart Dragon to see changes to your generated command preferences.

Auto Sleep options:

Adjust the slider to change how long the microphone takes to go to sleep when you are not using it.

Allowing the microphone to go to sleep prevents Dragon from interpreting background noise as dictation while you are not using it.

Profiles
The Profiles pane allows you to add, edit and delete profiles and audio sources.

See more...
Existing profiles are listed in the Profiles (Voices) box. Dictation sources are listed in the Dictation Sources (Microphones) box. The name of the active profile and dictation source are each marked with a green dot.

Existing profiles from an earlier versions of Dragon are marked in the Profiles pane with a special icon (⚠️) and need to be upgraded before you can continue using them. Please note that you can't upgrade a profile that has a missing microphone.

For detailed information, see Using profiles and dictation sources.

Dragon Anywhere
Enter your Dragon Anywhere login credentials to link your desktop version of Dragon to your Dragon Anywhere account and enable resource sharing.

See Dragon Anywhere for more details.

See more...
Once you are logged in, click Sync Now to share your custom words and Auto-texts with your mobile device. Select Sync when loading profiles to allow Dragon Anywhere to sync automatically whenever you change profiles.

Click Sign Out to sign out of your Dragon Anywhere account.

Shortcuts
The Shortcuts pane lets you set global keyboard shortcuts (hot keys) for four Dragon actions.

See more...

- **Toggle Microphone.** Turns the microphone on or off. Default is ⌘ F11.
  
  See Microphone modes for more information.

- **Select Speech Mode.** Cycles through the recognition modes. Default is ⌘ F10.
  
  See Recognition modes for more information.

- **Show Correction Window.** Shows and hides the Correction Window. Default is ⌘ F9.
  
  See Using Correction for details.

- **Dismiss MouseGrid.** Hides the MouseGrid. Default is ⌘ F12.
  
  See MouseGrid for more details.

To set a shortcut

- Click in the oval shortcut region and type the desired shortcut.

To delete a shortcut

- Click the ✗ at the right end of the oval shortcut region.

To revert to a previous shortcut

- Click the curved arrow (↩️) at the right end of the oval shortcut region.
Important Note: OS X includes built-in dictation that can cause conflicts with assigned hot keys. You should **not** assign keys F9 through F11 to Apple's hot key sequence for dictation. You should also never assign any hot key sequence in Dragon that is the same as the one for that operating system's built-in dictation.

Before using F-key keyboard shortcuts in Dragon, you should double-check your settings in the **Keyboard** pane of your Mac's **System Preferences**. Look for the **Use all F1, F2, etc. keys as standard function keys** checkbox. By default, this option is **unchecked**, which means you need to add the **fn** (Function) key to your **⌘-F-key** shortcuts in Dragon. If you check that box, you don’t need to use the **fn** key with your **⌘-F-key** shortcuts in Dragon, but you **do** need to use the **fn** key to access volume controls, brightness settings, and other quick access functions printed on the F keys.

Updates

Check for updates to Dragon and choose whether to allow Dragon to automatically download and install updates when they are available.

Advanced

In the Advanced pane of the Preferences window, you can make less common changes to Dragon's behavior and appearance.

See more...

**Correction options:**

- **Always Show Correction Window When Dictating**—Select to always show the Correction Window while you are dictating.
- **Close Correction Window After Each Choice**—Select to close the Correction Window automatically once you have selected a correction option.
- **Maximum Recognition Alternatives**—Adjust the slider to set the maximum number of alternatives shown in the Correction Window.
- **Show Smart Format Rules**—Select to allow Dragon to ask you how to format the text you just corrected in future.

See [Using Correction](#) for more information.

**MouseGrid options:**

- **Switch to Command mode**—Select if you want Dragon to switch to Command mode when you turn on the MouseGrid.
- **Enable zoom**—Select if you want the MouseGrid to display the magnification window when you focus on an area too small to show the grid.
- **Obscure Transparency**—Use the slider to determine how light or dark the MouseGrid section numbers should be. The lighter it is, the easier it will be to see what’s under it.
- **Grid color**—Click the box next to the option to view a color wheel where you can select a new color for the MouseGrid section numbers.
- **Mouse down color**—Click the box next to the option to open a color wheel where you can select a new color to indicate when the mouse is in a "down" state (e.g. "Press mouse").

See [MouseGrid](#) for more information.

**Data collection options:**

- **Send anonymous usage data**—Click to allow Dragon to collect anonymous data to improve future
products and services. You can opt out at any time by deselecting the checkbox.

License

In the License pane, view information about the type of license you are using with Dragon.

See more...

The contents of the License tab vary based on your license type. See Activate and Register for more information on Dragon licenses.

If you are using the 14-day free trial of Dragon Professional Individual for Mac, you can:
  - Click Activate to purchase the product.

If you purchased a perpetual Dragon Professional Individual for Mac license, you can:
  - View your serial number.
  - Click Deactivate to revoke your computer’s license.
    You may wish to do this if you want to transfer Dragon Professional Individual for Mac to a new computer.

If you purchased a subscription to Dragon Professional Individual for Mac, you can:
  - View the Nuance account you are using.
  - View the expiration date for your account.
  - Click Deactivate to remove the license for this copy of Dragon Professional Individual for Mac.
  - Click Manage Account to visit the Nuance website.

Related topics:
- The Status Window
- Microphone modes

Using profiles and dictation sources

In this topic, learn how to:
  - Switch between profiles and dictation sources (microphones)
  - Create a new profile
  - Create a new dictation source
  - Change the default dictation source for a profile
  - Delete a profile or dictation source

About profiles and dictation sources

A profile is a set of data on how you speak. Each user of Dragon must create his or her own profile, with a name that uniquely identifies it.

A dictation source is a microphone you use to dictate with Dragon. For example, you can use:
  - Your Mac’s internal microphone
  - A USB headset
  - A Bluetooth microphone

In order to use Dragon, you must have at least one profile and one available dictation source.

Switching profiles and dictation sources

When you start up Dragon, it activates the profile you used most recently. The name of the active profile is shown with a check mark in the Dragon menu.
1. Click the icon in the menu bar and select a profile from the Recent Profiles list. Dragon loads the profile with its default dictation source.

2. If you have configured more than one dictation source for your profile, you can select a different microphone from the sub-menu.

If there is only one dictation source, your profile does not include a dictation source sub-menu.

If you do not see your profile in the Recent Profiles list:

1. Click the icon in the menu bar and select Manage Profiles…
2. Select your profile from the list on the left.
3. Click the Load button.

Missing dictation sources

If the selected dictation source is missing (for example, your USB microphone is unplugged), Dragon displays a warning message. To use Dragon, you must do one of the following:

- Connect the missing microphone
- Select a different microphone
- Set up a new microphone for your profile

Working with profiles and dictation sources

You can create, edit and delete profiles and dictation sources in the Profiles pane in the Preferences window.

To open the Profiles pane, do one of the following:

- Say "Access Profiles window."
- Click the icon in the menu bar and select Manage Profiles…
- Open the Preferences window and click the Profiles icon.

To add a profile

1. Click the button at the bottom of the Profiles (Voices) list in the Profiles pane.
   The Profile Enrollment process begins.

2. Give the profile a name and click Continue.
   The Audio Source screen appears.

3. Select the Microphone you plan to use from the dropdown menu.

4. Optional: Enter a Name for your microphone.
   The name will appear in the Dictation Source (Microphones) list.

5. Click Continue.
   The Region screen appears.

6. Select your Region from the dropdown menu and click Continue.
   The Region setting helps Dragon determine appropriate spelling and vocabulary.

7. Select the Accent from the dropdown menu that most accurately describes how you speak, then click Continue.
   Dragon saves your new profile. This process may take several minutes. When the profile has been saved, the Microphone Setup window appears.

8. Complete the Microphone Setup to dictate with the new profile.

You must complete Microphone Setup or Dragon will not be able to adequately recognize your speech. Complete the Microphone Setup process for each microphone you use with your profile.
To add a dictation source to an existing profile

1. Click the button under the Dictation Sources (Microphones) field in the Profiles pane. The dictation source pop-over dialog appears.
2. In the Microphone dropdown menu, select the microphone you wish to add.
3. Optional: Enter a Name for your microphone.
4. Click Continue.
   The Microphone Setup window appears.
5. Complete Microphone Setup before using your new Dictation Source.

To change the default dictation source

- In the Default dropdown menu under Dictation Sources (Microphones), select your preferred microphone.

To change the Auto Formatting settings for a profile

1. Click the Auto Formatting… button. The Auto Formatting dialog box opens.
2. Change the settings as needed.
3. Click Apply to save changes and close the Auto Formatting dialog box.

To delete a profile and dictation sources

Do one of the following:

- Select the profile and click the button at the bottom of the Profiles (Voices) list.
- Select the dictation source and click the button at the bottom of the Dictation Sources (Microphones) list.

You cannot delete a profile or dictation source if it is currently in use. You must always have at least one profile and one audio source.

Related topics:
- Microphone Setup
- Preferences window
- Auto Formatting

Using DragonPad

While Dragon offers dictating and editing capabilities in most applications, you can also use the DragonPad to dictate and edit your text, then transfer it into your document or text field.

If you want to mix dictation and typing in an unsupported application, use DragonPad to avoid navigation errors. See Mixing dictation with typing for more on this topic.

DragonPad allows you to:

- Dictate text
- Use Correction
- Select and replace text
- Cut, copy and paste
- Adjust capitalization and spacing

You cannot apply text formatting such as bold or italic.
To dictate and transfer text

1. Make sure the target application – the application you want to dictate into – is open, and the cursor is in the field where you want the text to appear.

2. Say "Show DragonPad," or click the icon in the menu bar and select Help > DragonPad.

   The target application should appear in the Title Bar.

3. Dictate your text.

4. Revise your text as needed.

5. Say "Click Transfer" or click the Transfer button.

DragonPad closes, and the text you dictated appears in the target application.

Closing DragonPad

To close DragonPad without transferring the dictated text:

- Say "Hide DragonPad."
  - Or
  - Click the icon in the upper left corner of the DragonPad window.

Your text is automatically saved, and will appear next time you open DragonPad.

Related topics:
- Using Correction
- Mixing dictation with typing
- Revising text

FAQs

In this topic, get answers to commonly asked questions about:

- Using Dragon
- Improving Dragon’s recognition
- Accessibility
If you are upgrading from Dragon Dictate 4 or Dragon for Mac version 5, see Upgrading from Dragon Dictate 4 or Dragon for Mac 5: FAQ

About Dragon Professional Individual for Mac

I just installed Dragon. Where did it go?

It’s in your Applications folder. Open the Applications folder and double-click Dragon to launch. All of Dragon’s features are available in the Dragon menu ( ), located in the menu bar.

See Using the Dragon menu for more information.

Bonus tip: In the General Preferences, select Launch Dragon at Startup to ensure Dragon is always running, even after a reboot.

Do I need a unique profile for each user?

Yes. A profile contains specific information about each person’s voice. Each profile also contains one or more dictation sources (microphones) that have been calibrated for use with the user’s voice.

See Using profiles and dictation sources for more information.

How can I tell what mode Dragon is in?

Check the Status Window. The microphone button, to the left, indicates the microphone mode – to dictate, the microphone needs to be on ( ).

The Recognition mode icon in the center of the Status Window indicates what Dragon is listening for – general dictation and commands (Dictation mode), commands only (Commands mode), letters (Spelling mode), or numbers (Numbers mode). For most purposes, you should be in Dictation mode ( ). See Recognition modes for more information.

If you don’t see the Status Window, click the ( ) icon in the menu bar and select Show Status Window. See The Status Window for more details.

Note: If you are in Transcription mode, you cannot dictate with Dragon, and the Status Window is hidden. To exit Transcription mode, click the Switch to Dictation button on the Transcription window, or click the ( ) icon in the menu bar and select Switch to Dictation... to exit Transcription mode. See Transcribing recorded audio for more information.

Why isn’t there any punctuation in my dictated text?

You need to dictate punctuation marks as you speak – with a few exceptions, such as apostrophes and hyphenated words, Dragon will not attempt to guess where punctuation should be placed. See Punctuation—General for details on dictating punctuation.

Recognition

I’m not happy with the recognition. What can I do?

First, check your microphone placement: if you are using a headset, the microphone should generally be about an inch from the side of your mouth. See Microphone placement for more tips.

Next, try running Microphone Setup again. Click the ( ) icon in the menu bar and select Improve Recognition > Microphone Setup... This will ensure that your microphone is properly calibrated for your current environment. See Microphone Setup for more details.

If you are still having problems, Voice Training can help Dragon understand how you speak. Click the ( ) icon in the menu bar and select Improve Recognition > Voice Training... The more Dragon hears you speak, the better it can recognize your voice. See Voice Training for more details.

For more tips on improving recognition, see Poor recognition in the Troubleshooting section.
Dragon entered text into my document when I was trying to dictate a command. Why?
To make sure Dragon understands that you are dictating a command, pause slightly before and after speaking the command. If you are still having trouble, try switching to Command mode. See Recognition modes for more information.

To remove a command mistakenly typed into your document, say “Scratch that.” See Take it back for more on undoing dictated text and commands.

How can I make Dragon recognize my name correctly?

You can add your name to Dragon’s vocabulary by using Correction. Just say “Correct that” or “Correct <your name>” after Dragon types the wrong word, then choose the correct name from the list, or edit one of the options and change it to your name. For detailed instructions, see Correcting recognition errors.

Alternatively, you can open the Vocabulary Editor and add your name manually. For detailed instructions, see Adding a User vocabulary item.

If your name is in Dragon’s vocabulary, but Dragon’s recognition of it is poor, try training the vocabulary term to teach Dragon how you pronounce your name. See Training a vocabulary item for detailed instructions.

Accessibility

I have color blindness. How can I tell what mode the microphone is in?

If you cannot distinguish the color of the microphone button, look for other visual distinctions between the button states, as described in the table below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Visual characteristics</th>
</tr>
</thead>
</table>
| ![Icon] | - White outline on a green background  
- Small white lines around the top of the microphone  
- Button pulses based on the volume of the detected audio.  
  
  If you do not see any pulsing movement when you speak, the microphone may be off. |
| ![Icon] | - Dark red outline on a red background |
| ![Icon] | - White outline on a light blue background  
- Moon and star icons to the left  
- Button pulses based on volume of the detected audio |

![Icon] Dragon detects audio in sleep mode, but only responds to the command Wake up."

You can also tell whether the microphone is on by checking the Dragon menu:

1. Click the ![Icon] icon in the menu bar to open the Dragon menu.
2. Check the first option in the Dragon menu.
   - If the microphone is on, the first option in the Dragon menu is Turn Microphone Off.
   - If the microphone is off or in sleep mode, the option is Turn Microphone On.

I have difficulty using a mouse. How can Dragon help me navigate my Mac?

Dragon includes many ways to control your computer by voice:
• Use commands like "Activate TextEdit" to launch an application.
  See Launching and quitting applications for more details.
• Use commands like "New file," "Close window," or "Switch to next application" to open and close windows or change which window has focus.
  See Navigating application windows for more information.
• Use commands like "Click OK" to control dialog box buttons by voice.
  See Using dialog controls for more information.
• Use commands like "Click File menu" to access menus and menu items in any application.
  See Menu Walking for more information.
• Use commands like "Press the keys Command S" to access keys and keyboard commands by voice.
  See Key commands for more information.
• Use commands like "Move mouse up" and "Mouse click" to control your mouse by voice.
  See Mouse commands for more information.
• Say "Open MouseGrid" to use a 3 x 3 grid to move your mouse to a particular area of the screen.
  See MouseGrid for more information.

Related topics:
• Getting started with dictation
• Using the Dragon menu
• The Status Window
• Troubleshooting overview

What's New?
This topic describes enhancements and new features in Dragon Professional Individual for Mac version 6.

Faster and more accurate than ever
Dragon Professional Individual for Mac v6 expands the possibilities of speech recognition innovation with a next-generation speech engine, significantly increasing accuracy over previous versions. Dragon uniquely brings consistent, optimal accuracy to the Mac, with Deep Learning technology and adaptation techniques that continuously adjust to your voice or environmental variations, even while you're dictating. Dragon v6 provides:

• Up to 14% improved accuracy out of the box without training
• Continuous learning—even during dictation—for individually adapted accuracy improvements that enhance the user experience
• Optimal accuracy achieved for speakers with accents or in slight noisy environments such as in a cubicle environment

Formatting and other recognition improvements, for minimal editing
Dragon delivers improved recognition of number and email address formatting, hyperlink formatting in auto-texts, and place names based on how we naturally speak, resulting in fewer overall corrections. Examples include:

• "three double two five" → 3225
• "two point five million" → 2.5 million
• "oh point five" → 0.5
• "quarter of five" → 4:45
• "eight pounds fifty" → £8.50
• "John dot Smith at Nuance dot com" → john.smith@nuance.com
• Better overall handling of Roman numerals

Improved setup

Dragon provides simplified microphone selection for faster, easier setup:

• No transcription setup option needed
• No smartphone option needed (since built-in mic is already supported along with numerous other microphone options)
• Audio playback and troubleshooting button to allow the user to hear their audio passage read during setup, so that they be assured their microphone is working or troubleshoot if there is an audio issue

Improved user interface and experience

Dragon delivers an improved user experience that makes powerful features easier to discover and use.

• Clearer Full Text Control indicator on the new Guidance Window for an enhanced dictation experience
• Improved Status Window, Correction Window and streamlined Profiles management
• New License preference pane to manage licenses or subscriptions
• New automated backups of commands and vocabulary
• Improved Command management
• Faster startup time with optimizations throughout

Enhanced transcription

The enhanced transcription process leverages all the accuracy improvements gained from the state-of-the-art engine, while reducing the number of steps required to getting your audio recordings transcribed.

• Simplified user interface and better speaker management
• No training is required for transcription; you no longer need to initially transcribe and correct a short 90-second clip to achieve transcription accuracy
  • Acoustic and language model adaptation are automatically leveraged for the current user
• No training is required for third-party transcription; there is also better separation of current user data versus third-party speaker data

Transcription Batch Mode

Now use Batch Mode and save time if you have multiple audio files to transcribe. In the Transcription Window, simply drop as many files as you need to have transcribed to the Audio Files to Transcribe list, and Dragon Professional Individual for Mac transcribes them all together, quickly and efficiently.

Updated web and application support

Dragon empowers you to work even more quickly and accurately by voice with support for Full Text Control* within the latest business applications. Web and desktop applications with enhanced support include for example:

• Apple Pages
• Apple Keynote
• Apple Numbers
• Microsoft Outlook 2016
• Scrivener

* Full Text Control requires adoption of Apple’s Accessibility API

Improved help

Contextual guidance tailored to your usage helps you maximize the power of Dragon and complete documentation more efficiently than ever before. Dragon offers multiple ways to accelerate proficiency and get the most out of your
speech recognition investment—even offering productivity tips and helping you discover advanced Dragon features. You can take advantage of:

- Helpful tips always available in the Guidance Window
- Improved online Help:
  - Enhanced Help that gives users easier access to top searches
  - Changing content on main help page with highly used topics featured
  - New troubleshooting sections
  - Expanded navigational text that gives users more information/context
  - More task-based dialog box help

**Related topics:**
- The Status Window
- The Guidance window
- Transcribing recorded audio

**Upgrading from Dragon Dictate 4 or Dragon for Mac 5: FAQ**

In this topic, find out answers to common questions about upgrading, including:

- What files can I remove after upgrading?
- What can I do if my profile won't upgrade?
- What happened to Transcription sources?
- Upgrading from Dragon for Mac 5
- Upgrading from Dragon Dictate 4

**All Upgrades**

**I just finished upgrading – is there anything I can delete to save disk space?**

You can remove old Dragon files from your hard drive once you are sure that Dragon Professional Individual for Mac 6 is working properly:

1. In the Finder, select Go > Go to Folder...
2. Copy and paste the following: /Library/Application Support/Dragon
3. Click the Go button.
   A Finder window opens, displaying the contents of the specified folder.
4. Drag the file named Speech Engine Data (English) 4.0 or Speech Engine Data (English) 5.0 to the Trash.

   **Important:** Do not move any other files in the Dragon folder.

5. Once you have successfully upgraded your profile and verified that it works as expected, you can delete the backup copies of your old profiles. In the /Documents/Dragon/Support folder, find the zipped backup copies of your old profiles and drag them to the trash.

**My profile won't upgrade. What can I do?**

Make sure the microphones listed as Dictation sources in your profile are connected. Missing microphones are marked with a ⚠️ in the Profiles pane.

See [Issues with Upgraded Profiles](#) for more information. If you don't have any custom words, it may be better to create a new profile.
What happened to Transcription sources?

Transcription sources are no longer stored in the Profiles pane. If your Dragon for Mac 5 or Dragon Dictate 4 profile included Transcription sources, they are available in the Speaker dropdown list in the Transcription window.

Upgraded Transcription sources appear in the format "<Transcription source> (<Profile name>)." For example, if you had a Transcription source named "iPhone" and a user named "Marie," the Speaker appears as "iPhone (Marie)."

Upgrading from Dragon for Mac 5

How has the Status Window changed?

Dragon Professional Individual for Mac 6 features a new, compact Status window. Here’s what you need to know:

- Guidance is now its own window. Click the button and select Show Guidance to view hints and common commands based on your current state.
- Correction is also its own window. The Correction window appears whenever you use a Correction command, like "Correct that." You can also show the Correction window by clicking the button and selecting Show Correction.
- The Recognition mode dropdown list has been consolidated into an indicator button: . Click the button to select a different Recognition mode.

See The Status Window for more information.

Upgrading from Dragon Dictate version 4

I just upgraded from Dragon Dictate version 4 – what do I need to do now?

- Be sure to update your Web Extensions. Go to http://www.nuance.com/extensions and follow the instructions.
- Remove the Dragon Dictate 4 icon from your dock. By default, Dragon Professional Individual for Mac 6 doesn’t appear in the dock and works differently from Dragon Dictate.
  1. Control-click the Dragon Dictate 4 icon.
  2. In the pop-up menu, select Options > Remove from Dock.
- Dragon creates a folder called Dragon in your Documents folder and automatically places all new profiles in this folder. You can move your existing profiles into this folder or leave your existing profiles where they are.
- Go to the top of the page for information about files you can delete after upgrading.

Where did Dragon go?

Dragon Professional Individual for Mac 6 only appears in the menu bar, not the dock, and is designed to stay running constantly. You no longer need to switch from your current application to Dragon and switch back to use any of Dragon’s features. You can even change profiles from the menu bar without ever leaving your application!

To launch Dragon, you can do any of the following:

- Go to the Applications folder and double-click the Dragon icon.
- Use Spotlight to search for and launch Dragon.

To make sure Dragon is always running, even if you restart your computer, open Dragon and do the following:

1. Click the icon in the menu bar and select Preferences....
2. In the General pane, select Launch Dragon at Startup.

What happened to Text Macros?

Text Macros are now Auto-texts. They work just like Text Macros.
To add an Auto-text, click the icon in the menu bar and select Add New Auto-text…

See Auto-text commands for more information.

Where is the Recognition Window?
The Recognition Window in Dragon Dictate 4 is now the Correction window. To show the Correction window:

1. Click the Windows menu in the Status Window.
2. Select Show Correction.

The Correction window also appears automatically when you use Correction commands, like “Correct <text>.” See Using Correction for more information.

How has the Status window changed?
Dragon Professional Individual for Mac 6 features a completely new Status Window. Here’s what you need to know:

- Use the microphone indicator ( ) to toggle the microphone mode.
- Use the Recognition mode indicator ( ) to choose a recognition mode (Dictation, Commands, Numbers, or Spelling).
- Use the Windows menu ( ) to show or hide the Commands, Correction or Guidance window.

See The Status Window for more information.

Where is the Note Pad?
In Dragon Dictate, you could use the Note Pad to edit text and mix talking with typing. In Dragon Professional Individual for Mac 6, fully supported applications like Microsoft Word 2016 or TextEdit can be used to replace the functionality of the Note Pad.

Dragon Professional Individual for Mac 6 supports editing and navigation commands, like “Select <text>” or “Go to end,” in nearly every application, but only fully supported applications allow you to use these commands even if you used your keyboard or mouse while dictating. See What applications are supported? for a complete list.

Where is the Express Editor?
The Express Editor has been renamed the DragonPad. It has the same features as the Express Editor. See Using DragonPad for more information.

You may find that using TextEdit to edit text and then copying and pasting into another application is a better workflow.

Related topics:
- FAQs
- What’s New?
- Issues with Upgraded Profiles

Activate and Register
If you completed your initial installation without activating the product, you will need to enter a valid serial number or subscription before your trial period is over to continue using Dragon.

To activate your license
1. Click the icon in the menu bar and select Help > Activate.
   Dragon opens the Activation window.
2. If you have not purchased a license or subscription, click the Learn More link, or click here to purchase a license from the Nuance website.
   If you have already purchased a license or subscription, proceed to the next step.
3. Click the appropriate button:
   - Click **Serial Number** if you have purchased a perpetual Dragon Professional Individual for Mac license.
     The Serial Number screen appears.
   - Click **Nuance Account** if you have purchased a subscription for Dragon Professional Individual for Mac.
     The Nuance Account screen appears.

4. Enter the required information.

5. Click **Activate Now** (for serial numbers)
   Or
   Click **Sign In** (for subscription accounts)

**To register your copy of Dragon Professional Individual for Mac**

After activating your Dragon Professional Individual for Mac license, Dragon prompts you to register your product. If you choose to skip registration, you can access it at any time by clicking the ⌁ icon in the menu bar and selecting Help > Register for Support.

1. Choose **New** or **Existing** Nuance Customer, then click **Continue**.
2. Enter your email address, a password, and your first and last name.
   Your password can be up to 12 characters, and should not contain punctuation or symbols.
3. Click **Continue** to move to the next screen.
4. Enter your company name, street address, city, state, postal or Zip code, country and phone number.
   You must select a country from the dropdown list: the other fields are optional.
5. Click **Continue**.
   On the next screen, Dragon confirms the Model, Memory, and Processor Speed and Cores for your Mac.
6. Select **Yes** to allow Dragon to collect this information for technical support purposes, or **No** to prevent it. Then click **Continue**.
7. Complete the survey (optional), and check which products you want to receive news and offers about. Then click **Complete Registration**.

**To deactivate your Dragon Professional Individual for Mac license**

1. Click the ⌁ icon in the menu bar and select Help > Deactivate.
   A confirmation dialog appears.
2. Click **OK** to confirm deactivation.
   Your license number or login information are removed, and Dragon quits.

**Related topics:**
- **Microphone placement**
- **Getting started with dictation**
- **Using profiles and dictation sources**
Use the microphone

Read these topics to learn about using your microphone with Dragon.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn more about:</th>
</tr>
</thead>
</table>
| Microphone modes              | • What are microphone modes?  
• How can I tell what mode the microphone is in?  
• How do I switch modes?                                                                                                                                                                                                 |
| Microphone Setup              | • How do I access Microphone Setup?  
• Why do I have to go through Microphone Setup?                                                                                                                                                                          |
| Microphone placement          | • How do I position my microphone for optimal recognition?                                                                                                                                                               |

Microphone Setup

Microphone Setup allows Dragon to adjust the audio input settings for optimal recognition. Microphone Setup appears automatically whenever you create a new profile or add a new dictation source. You must complete the setup process for each new profile and each microphone you associate with a profile.

You can also run the Microphone Setup at any time if you encounter problems with your microphone. For more information about improving your audio quality, see Poor audio quality.

To open the Microphone Setup window

- Say "Show Microphone Setup window."
- Or
  - Click the icon in the menu bar and select Improve Recognition > Microphone Setup.

To complete Microphone Setup

1. Click the microphone button ( ) to turn the microphone on.
2. Read aloud the text that appears in the window. Repeat the text if needed.
   - The Microphone Setup is Finished screen appears when Dragon has finished adjusting the audio input.
3. Click Play to hear the last few seconds of your speech. If it seems too loud or too soft, you may want to set the gain manually (see below).
4. Click Done to exit the Microphone Setup window.

To manually adjust gain

2. Drag the slider to about 60.
3. Click the microphone button ( ) to turn the microphone on.
4. Read aloud the text in the window until the Microphone Setup is Finished screen appears.
5. Click Play to hear the last few seconds of your speech. If it seems too loud or too soft, click the Back button and adjust the gain again.
6. When you are satisfied with the volume of your speech, click Done to exit the Microphone Setup window.

Related topics:

- Microphone placement
- Getting started with dictation
- Using profiles and dictation sources
Microphone modes

Your microphone is always in one of three modes. The current mode is indicated by the Microphone button in the Status Window and by the Dragon menu icon.

<table>
<thead>
<tr>
<th>State</th>
<th>Status Window button</th>
<th>Menu icon</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>🎤</td>
<td>📁</td>
<td>Dictate text and issue commands.</td>
</tr>
<tr>
<td>Off</td>
<td>🔴</td>
<td>📁</td>
<td>Dragon does not respond to any spoken commands. You must use your mouse or keyboard to turn your microphone back on.</td>
</tr>
<tr>
<td>Sleep</td>
<td>🎤</td>
<td>📁</td>
<td>Dragon ignores all speech except “Wake up.”</td>
</tr>
</tbody>
</table>

Changing the microphone mode

If your microphone is off, do one of the following:

- Click the 📁 icon in the menu bar and select Turn Microphone On.
- Click the microphone button in the Status Window (this will turn the microphone on).
- Use the keyboard shortcut to toggle the microphone (default is ⌘F11).

If your microphone is on, do one of the following:

- Say "Microphone off" or "Go to sleep."
- Click the 📁 icon in the menu bar and select Turn Microphone Off.
- Click the microphone button in the Status Window (this will turn the microphone off).
- Use the keyboard shortcut to toggle the microphone (default is ⌘F11).

If your microphone is in sleep mode, do one of the following:

- Say "Wake Up" or "Turn microphone on."
- Click the 📁 icon in the menu bar and select Turn Microphone On.
- Click the microphone button in the Status Window (this will turn the microphone on).
- Press the keyboard shortcut to toggle the microphone (default is ⌘F11).

By default, Dragon’s microphone will go to sleep after one minute of inactivity. You can change the Auto Sleep setting in the General pane of the Preferences window.

Related topics:
- Microphone placement
- Microphone Setup
- Getting started with dictation
- Preferences window

Microphone placement

Correct microphone positioning is one of the most important ways to enhance recognition accuracy. Even slight variations can deteriorate accuracy significantly.
If you are having trouble with audio quality after optimizing your microphone placement, see Troubleshooting audio and recognition.

**Using your Mac's built-in microphone**

- Keep your mouth a consistent distance from your device's microphone. Consult your Mac manual if you're not sure where the microphone is on your computer.
- Keep your face directed towards your Mac. Avoid turning your head while dictating.

**Positioning a headset microphone**

- Place the microphone element to the side of your mouth to avoid noise from breathing.
- Keep the microphone element about an inch from the side of your mouth, but not touching it.
- Make sure the front of the microphone points toward your mouth. The front may be labeled with, for example, a colored dot or the word "Talk."
- Position the headset consistently every time you use it.
- Depending on the microphone you are using, you may need to manually set Gain. See Microphone Setup for more information.

**Positioning a hand-held microphone**

- Do not hold the microphone directly in front of your mouth. Hold it below or to the side of your mouth to avoid noise from breathing.
- Keep the microphone element about 1 to 3 inches away from your mouth.
- Point the front of the microphone toward your mouth. Don't talk into the side of it.
- Be careful not to move the microphone or your head suddenly.
- Do not use a microphone stand or holder. This will make it harder to maintain a consistent position, and the stand may conduct noise.
- Hold the microphone consistently every time you use it.
- Depending on the microphone you are using, you may need to manually set Gain. See Microphone Setup for more information.

**Related topics:**

- Microphone Setup
- Getting started with dictation
Dictate text

Read these topics to learn how to dictate with Dragon.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
</table>
| **Getting started with dictation** | • How to start dictating  
• Dictation best practices                                                          |
| **Mixing dictation with typing**  | • What is Full Text Control?  
• Using cache commands to resolve issues relating to typing and dictating          |
| **Dictation overview**             | • Dictating text, including:  
• Line and paragraph breaks  
• Punctuation  
• Quotes  
• Bullets  
• Email and Web addresses  
• Proper nouns  
• Hyphenated words  
• Compound words  
• Abbreviations  
• Acronyms |
| **Dictating punctuation and symbols** | • Dictating punctuation and special characters                                |
| **Dictating letters**              | • Spelling words and phrases                                                  |
| **Dictating numbers**              | • Dictating numbers, including:  
• Currency  
• Dates  
• Decimals  
• Fractions  
• Numerals  
• Phone numbers  
• Postal codes  
• Roman numerals  
• Time  
• Weight |
| **Take it back**                   | • How to undo incorrect or misrecognized commands                           |

**Getting started with dictation**

**Creating a new document**

1. Click the microphone button in the Status Window to turn the microphone **on**.
2. Say "Open <application>." For example, "Open Microsoft Word."
3. Say "New file."
4. Begin dictating.
Dictation guidelines

How to dictate

- Speak clearly and naturally, at your normal conversational tone and pace.
- Pronounce each word clearly, but in a way that is comfortable for you. If you are not sure how to do this, imagine how a newscaster reads a story and try to copy that style.
- For best recognition, dictate using longer phrases rather than pausing after a each word or every few words. Hearing a whole phrase helps Dragon predict what words you are likely to say in context, which makes it more accurate.

Remember, in some applications, it's better not to use your mouse and keyboard while dictating text. See Mixing dictation with typing for more information, including a list of currently supported applications.

Where to dictate

- For best results, dictate in an area with minimal background noise, as Dragon hears and transcribes everything.

How to add punctuation

- Pause briefly before and after you dictate punctuation.
- Say all punctuation as you dictate. Except for some in-word punctuation such as apostrophes and hyphens, Dragon will not insert any punctuation unless you dictate it.
  
  For example, if you want to enter the text "Good morning, Mike!" say "Good morning comma Mike exclamation point."

How to use commands

- Pause briefly before and after you dictate commands.
- Check the Guidance window for suggested commands based on what you are doing.

Related Topics:

- Dictation overview
- Microphone modes
- Microphone placement
- Microphone Setup

Mixing dictation with typing

In this topic, learn how to:

- Find out what Dragon can do in your current application
- What applications support mixing dictating and typing
- What it means if you are dictating in an unsupported application
- What to do if your cursor is jumping to the wrong place

Dragon allows you to dictate text in virtually any application. In order to use commands such as "Select <text>" or "Correct <word>,” Dragon needs to know where your cursor is within the document. In some applications, including Microsoft Word 2011 or 2016, Microsoft Outlook 2016, and TextEdit, Dragon can always get that information, even if you use your keyboard and mouse to change text while you are dictating. Some applications, however, do not allow Dragon to find out whether you have moved your cursor. If you dictate in these applications, avoid using your mouse or keyboard.

Dragon notifies you when you are dictating into an application that does not support typing while dictating.
To make sure you see these notifications:

- Say "Show Guidance Window."
- Or
- Click the ⌥ icon in the menu bar and select Show Guidance.

If you use your keyboard or mouse to edit your text or move your cursor within the text, you may lose access to certain features, such as editing text or using Correction.

What applications are supported?

Dragon is working to support as many applications as possible. Check this page for updates to the supported applications list.

<table>
<thead>
<tr>
<th>Supported</th>
<th>Not supported*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Book</td>
<td>Apple Mail</td>
</tr>
<tr>
<td>Keynote 6.6 or later</td>
<td>BBEdit/TextWrangler</td>
</tr>
<tr>
<td>Messages</td>
<td>Evernote</td>
</tr>
<tr>
<td>Microsoft Word 2011 or 2016</td>
<td>Microsoft Excel</td>
</tr>
<tr>
<td>Numbers 3.6 or later</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>Outlook 2016 version 15.24 or later</td>
<td></td>
</tr>
<tr>
<td>Pages 5.6 or later</td>
<td></td>
</tr>
<tr>
<td>Scrivener 2</td>
<td></td>
</tr>
<tr>
<td>Skype</td>
<td></td>
</tr>
<tr>
<td>Slack</td>
<td></td>
</tr>
<tr>
<td>Stickies</td>
<td></td>
</tr>
</tbody>
</table>

What does it mean if my application isn't supported?

You can dictate into an unsupported application. If you want to dictate into an application that is not on the supported list, you can still dictate text, but try not to use your keyboard or mouse to add or edit text while dictating.

Dragon works with applications that support Apple’s Accessibility API. Please check with your applications developer to ask about adding support for Apple’s Accessibility API.
<table>
<thead>
<tr>
<th>Supported</th>
<th>Not supported*</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextEdit</td>
<td></td>
</tr>
</tbody>
</table>

*This list is a selection of common applications Dragon is not able to support. Check the Guidance window for information about an application before attempting to mix dictation and typing.

**About the cache**

If you mix typing and dictating in an unsupported application, Dragon will lose track of where the cursor is, causing unpredictable behavior. If this happens, say "Cache document." This command tells Dragon to read the whole document's contents. When it does this, several things happen:

1. Dragon forgets what it entered in this document.
2. Dragon throws away its recordings of your voice, so using Correction on existing text is no longer possible.
3. Dragon reads all of the document's text from scratch. This means Dragon knows exactly what text the document contains.

**Related topics:**
- Dictation overview
- Using Correction
- Navigating within a document
- Revising text

**Dictation overview**

In this topic, learn how to dictate:

- Line and paragraph breaks
- Punctuation
- Quotes
- Bullets
- Email and Web addresses
- Proper nouns
- Hyphenated words
- Compound words
- Abbreviations
- Acronyms

Start using Dragon to dictate text into most applications in just three steps.

1. Open the application you want to use.
2. Click inside the window or field where you want to place your dictated text.
3. Turn on your microphone and speak!

In general, you can dictate text the same way you would speak, but with punctuation added. Below are examples of some common types of special text, and how to dictate them.

**Text Type**

<table>
<thead>
<tr>
<th>Text Type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paragraph and line breaks</strong></td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td>To add line or paragraph breaks to your document, say one of the following:</td>
<td>Say: &quot;Hi Mark comma new paragraph It was good to see you today period.&quot;</td>
</tr>
<tr>
<td>&quot;New line&quot;</td>
<td>Result: Hi Mark,</td>
</tr>
<tr>
<td>&quot;New paragraph&quot;</td>
<td>It was good to see you today.</td>
</tr>
<tr>
<td>&quot;Click Enter / Return&quot;</td>
<td></td>
</tr>
</tbody>
</table>
## Text Type

### Punctuation—General

Most punctuation needs to be dictated to appear in the text. Say the punctuation at the appropriate places in your dictation. Pause briefly before and after you dictate punctuation.

See [Dictating punctuation and symbols](#) for more information.

**Example**

Say: "We're going to the park comma then for ice cream period would you like to come question mark"

**Result:** We’re going to the park, then for ice cream. Would you like to come?

Dragon will automatically add some punctuation within a word (such as an apostrophe) based on the context of your dictation. For example, when you say "John's hat," Dragon adds the apostrophe automatically.

Dragon may also add punctuation in certain cases, such as street addresses or dates, based on your Auto Formatting preferences. See [Auto Formatting](#) for more information.

### Quotes

You can add quotation marks before and after you speak a word or phrase, as you would when typing, or by saying the text first and then putting quotation marks around it.

**To dictate quotes as you speak**

1. Say "Open quote."
2. Dictate a word or phrase.
3. Say "Close quote."

**To dictate quotes after dictating a word or phrase**

- Say "Put quotes around that" to put quotation marks around the last phrase you spoke.
- Say "Put quotes around &lt;text&gt;" to put quotation marks around the specified text.
- Say "Put quotation marks around the selection" to put quotation marks around the selected text.

**Example 1**

Say: "Open quote Don't find fault comma find a remedy period close quote"

**Result:** "Don't find fault, find a remedy."

**Example 2**

**Sample text:** My Mom said, my kids are my life.

**Say:** "Put quotes around my kids are my life"

**Result:** My Mom said, "my kids are my life".

### Bullets

- Say "Bullet selection" to make the selected text into a bulleted list item.
- Say "Bullet that" to make the last phrase you spoke into a bulleted list item.
- Say "Bullet &lt;text&gt;" to make the specified text into a bulleted list item.

**Example**

Say: "go to the grocery store"

Then say: "Bullet that"

**Result:** • go to the grocery store

### Email and Web addresses

Dictate email and Web addresses as you would say them conversationally. Many domain names are already in Dragon's vocabulary.

- To make sure Dragon recognizes that your are dictating a Web address, include "www dot" at the beginning of the address.
- If you do not include "www dot" in the Web address, you can say "No space on" to prevent Dragon from inserting spaces in

**Example 1**

Say: "info at nuance dot com"

**Result:** info@nuance.com

**Example 2**

Say: "www dot Boston Globe dot com"

**Result:** www.BostonGlobe.com
**Longer addresses.**
- Use Spelling mode to enter complex URLs.
- Say "No Caps on" if you want to prevent Dragon from capitalizing words within an address.

**Proper nouns**
Most common names are already in Dragon's vocabulary. When you say the name, Dragon capitalizes it automatically.
For less common proper nouns, or names that may also be words (e.g., Chase, Sandy or Iris), you can say "Cap" before the word.

**Hyphenated words**
Most common hyphenated words are already in Dragon's vocabulary. When you say the word, Dragon automatically hyphenates it.
For less common hyphenated words, you can say "Hyphen" in the appropriate place.

**Compound words**
Most common compound words are already in Dragon's vocabulary. Say the word, and it will be typed correctly.
If you want to create a compound word where Dragon has typed two words:
- Say "No space" before dictating the second word.
  - Or
  - Say "Insert before <word>" to insert the cursor before the second word, then say "No leading space."

**Abbreviations**
Most common abbreviations are already in Dragon's vocabulary. When you say the word, Dragon abbreviates it automatically.
If Dragon is not abbreviating as expected, check your Auto Formatting preferences.

**Acronyms**
Most common acronyms are already in Dragon's vocabulary. Say the acronym, and Dragon formats it automatically.
For less common acronyms, you can say "All caps on" followed by the acronym letters. For best results, switch to Spelling mode to do this.
Text Type

Examples

See Dictating Acronyms for more information.

Example 2

Say: "Spelling mode" [pause] "All caps on M R S A"

Result: MRSA

If you frequently dictate text – such as proper nouns, hyphenated or compound words, abbreviations or acronyms – that Dragon does not recognize, or does not format correctly, say "Correct <text>" to train Dragon how to recognize the word, or use the Vocabulary Editor to add it to Dragon's vocabulary. See Using Correction and Editing Dragon's Vocabulary for more information.

Related topics:
- Getting started with dictation
- Dictating punctuation and symbols
- Dictating letters
- Dictating numbers

Take it back

Sometimes Dragon makes a mistake and does something you didn't want it to do, like entering the text "save the document" instead of actually saving your document.

Other times, you may accidentally use the wrong command, like saying "Cut the selection" when you wanted to say "Copy the selection."

No matter what happened, or what application you were using, you can use these global commands to undo the mistake:

- "Undo last action" works like the keyboard shortcut ⌘ Z. It will undo the last command you dictated, or remove the last paragraph of text you dictated.
- "Redo last action" works when you said "Undo last action" and then changed your mind: it will restore deleted text or redo a command.
- "Scratch that" deletes the last utterance you dictated. The amount of text deleted depends on where you paused while dictating.
- "Scratch word" deletes the word to the left of the cursor.
- "Undo dictation" undoes the last thing you said, whether that was a command (such as "Bold that") or an utterance.

Example 1

1. Say: "The meeting will be held at 12 PM in the assembly room"
   Result: "The meeting will be held at 12 PM in the assembly room"

2. Say: "Scratch word"
   Result: "The meeting will be held at 12 PM in the assembly"

Example 2

1. Say: "The meeting will be held at 12 PM in the assembly room"
   Result: "The meeting will be held at 12 PM in the assembly room"

2. Say: "Undo last action"
   Result: <removes text>
3. **Say**: "Redo last action"
   
   **Result**: "The meeting will be held at 12 PM in the assembly room"

### Example 3

1. **Say**: "The meeting will be held at 12 PM in the assembly room"
   
   **Result**: "The meeting will be held at 12 PM in the assembly room"

2. **Say**: "Bold 12 PM"
   
   **Result**: "The meeting will be held at 12 PM in the assembly room"

3. **Say**: "Undo last action"
   
   **Result**: "The meeting will be held at 12 PM in the assembly room"

### Related topics:
- [Revising text](#)

### Dictating punctuation and symbols

To dictate punctuation or symbols, say the name of the punctuation or symbol at the appropriate places in your dictation.

In Dictation mode, Dragon will insert intelligent spacing around punctuation. In Spelling and Numbers modes, all spaces must be inserted by saying "Space bar."

#### To place punctuation around text

- Say "**Put <punctuation> around selection**" to place punctuation at the beginning and end of the selected text.
- Say "**Put <punctuation> around that**" to place punctuation at the beginning and end of the last phrase you dictated.
- Say "**Put <punctuation> around <text>**" to place punctuation at the beginning and end of the specified text.

You can use these commands with:
- Quotation marks
- Parentheses
- Brackets
- Braces
- Spanish exclamation marks
- Spanish question marks

### Punctuation and symbols

<table>
<thead>
<tr>
<th>To enter</th>
<th>Say</th>
<th>To enter</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>U.S. dialects:</td>
<td>?</td>
<td>Question mark</td>
</tr>
<tr>
<td></td>
<td>• Period</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Dot</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non-U.S. dialects:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Full stop</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All dialects:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>• Exclamation mark</td>
<td>,</td>
<td>Comma</td>
</tr>
<tr>
<td>:</td>
<td>• Colon</td>
<td>;</td>
<td>Semicolon</td>
</tr>
<tr>
<td>-</td>
<td>• Hyphen</td>
<td>–</td>
<td>Dash</td>
</tr>
</tbody>
</table>

55
<table>
<thead>
<tr>
<th>To enter</th>
<th>Say</th>
<th>To enter</th>
<th>Say</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Minus sign</td>
<td></td>
<td>• En-dash</td>
<td></td>
</tr>
<tr>
<td>—</td>
<td>• Em-dash</td>
<td>'</td>
<td>• Apostrophe</td>
</tr>
<tr>
<td>'s</td>
<td>• Apostrophe ess</td>
<td>`</td>
<td>• Backquote</td>
</tr>
<tr>
<td>'</td>
<td>• Begin single quote</td>
<td>'</td>
<td>• Close single quote</td>
</tr>
<tr>
<td></td>
<td>• Open single quote</td>
<td></td>
<td>• End single quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>• Open quote</td>
<td>&quot;</td>
<td>• Close quote</td>
</tr>
<tr>
<td></td>
<td>• Begin quote</td>
<td></td>
<td>• End quote</td>
</tr>
<tr>
<td>(</td>
<td>• Left parenthesis</td>
<td>)</td>
<td>• Right parenthesis</td>
</tr>
<tr>
<td></td>
<td>• Open parenthesis</td>
<td></td>
<td>• Close parenthesis</td>
</tr>
<tr>
<td>[</td>
<td>U.S. and Canada:</td>
<td>]</td>
<td>U.S. and Canada:</td>
</tr>
<tr>
<td></td>
<td>• Left bracket</td>
<td></td>
<td>• Right bracket</td>
</tr>
<tr>
<td></td>
<td>• Open bracket</td>
<td></td>
<td>• Close bracket</td>
</tr>
<tr>
<td></td>
<td>All dialects:</td>
<td></td>
<td>All dialects:</td>
</tr>
<tr>
<td></td>
<td>• Left square bracket</td>
<td></td>
<td>• Right square bracket</td>
</tr>
<tr>
<td></td>
<td>• Open square bracket</td>
<td></td>
<td>• Close square bracket</td>
</tr>
<tr>
<td>{</td>
<td>• Left brace</td>
<td>}</td>
<td>• Close brace</td>
</tr>
<tr>
<td></td>
<td>• Open brace</td>
<td></td>
<td>• Right brace</td>
</tr>
<tr>
<td></td>
<td>• Left curly bracket</td>
<td></td>
<td>• Right curly bracket</td>
</tr>
<tr>
<td></td>
<td>• Open curly bracket</td>
<td></td>
<td>• Close curly bracket</td>
</tr>
<tr>
<td>&lt;</td>
<td>• Left angle bracket</td>
<td>&gt;</td>
<td>• Right angle bracket</td>
</tr>
<tr>
<td></td>
<td>• Open angle bracket</td>
<td></td>
<td>• Close angle bracket</td>
</tr>
<tr>
<td>\</td>
<td>• Backslash</td>
<td>/</td>
<td>• Forward slash</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Slash</td>
</tr>
<tr>
<td>&amp;</td>
<td>• ampersand</td>
<td>*</td>
<td>• Asterisk</td>
</tr>
<tr>
<td>&amp;</td>
<td>• and sign</td>
<td></td>
<td></td>
</tr>
<tr>
<td>@</td>
<td>• At sign</td>
<td>_</td>
<td>• Underscore</td>
</tr>
<tr>
<td></td>
<td>When dictating an email</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>address:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• At</td>
<td></td>
<td></td>
</tr>
<tr>
<td>©</td>
<td>• Copyright sign</td>
<td>®</td>
<td>• Registered sign</td>
</tr>
<tr>
<td>^</td>
<td>• Caret</td>
<td>...</td>
<td>• Ellipsis</td>
</tr>
<tr>
<td>+</td>
<td>• Plus sign</td>
<td>=</td>
<td>• Equal sign</td>
</tr>
<tr>
<td>×</td>
<td>• Multiplication sign</td>
<td>÷</td>
<td>• Division sign</td>
</tr>
<tr>
<td>±</td>
<td>• Plus or minus sign</td>
<td>%</td>
<td>• Percent sign</td>
</tr>
<tr>
<td>&lt;</td>
<td>• Less than sign</td>
<td>&gt;</td>
<td>• Greater than sign</td>
</tr>
<tr>
<td>#</td>
<td>U.S. and Canada:</td>
<td>°</td>
<td>• Degree sign</td>
</tr>
<tr>
<td></td>
<td>• Pound sign</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number sign</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Other dialects:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To enter | Say
---|---
Hash sign
Sharp sign
$ | Dollar sign
£ | U.S. and Canada:
  * Pound sterling sign
Other dialects:
  * Pound sign
\( |\) | Vertical bar
\( |\|\) | Paragraph sign
):( | Frowny face
:) | Winky face

| To enter | Say |
---|---|
€ | Euro sign
$ | Yuan sign
£ | Pound sterling sign
\$ | Dollar sign
¥ | Yen sign
| |

Related topics:
- Dictation overview
- Recognition modes

### Dictating letters

In this topic, learn how to:
- Spell words in Dictation mode and Spelling mode
- Dictate letters
- Dictate acronyms
- Dictate accents and other non-English letters

If you are trying to dictate a very unusual word, you may find you need to spell it out. If you use the word frequently, you can add it to Dragon's vocabulary. See Adding a User vocabulary item for more information.

### Recognition modes and spelling

You can say the names of letters in Dictation mode.

Spelling mode, however, will generally produce better results because:
- It only understands letters and numbers, so it is less likely to misinterpret your speech.
- It will not attempt to insert spaces if you pause between letters.

To switch to spelling mode, just say "Switch to Spelling mode." Remember to say "Switch to Dictation mode" to return to Dictation mode when you are done spelling.

### Letters

To type a letter:
- Say the name of the letter, e.g. "A," "B," etc.
- If you are in Spelling mode, you can use the International Radio Alphabet name of the letter.

### Click to view the International Radio Alphabet letters

<table>
<thead>
<tr>
<th>Say</th>
<th>Result</th>
<th>Say</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>a</td>
<td>November</td>
<td>n</td>
</tr>
<tr>
<td>Say:</td>
<td>Result:</td>
<td>Say:</td>
<td>Result:</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>Bravo</td>
<td>b</td>
<td>Oscar</td>
<td>o</td>
</tr>
<tr>
<td>Charlie</td>
<td>c</td>
<td>Papa</td>
<td>p</td>
</tr>
<tr>
<td>Delta</td>
<td>d</td>
<td>Quebec</td>
<td>q</td>
</tr>
<tr>
<td>Echo</td>
<td>e</td>
<td>Romeo</td>
<td>r</td>
</tr>
<tr>
<td>Foxtrot</td>
<td>f</td>
<td>Sierra</td>
<td>s</td>
</tr>
<tr>
<td>Golf</td>
<td>g</td>
<td>Tango</td>
<td>t</td>
</tr>
<tr>
<td>Hotel</td>
<td>h</td>
<td>Uniform</td>
<td>u</td>
</tr>
<tr>
<td>India</td>
<td>i</td>
<td>Victor</td>
<td>v</td>
</tr>
<tr>
<td>Juliet</td>
<td>j</td>
<td>Whiskey</td>
<td>w</td>
</tr>
<tr>
<td>Kilo</td>
<td>k</td>
<td>X-ray</td>
<td>x</td>
</tr>
<tr>
<td>Lima</td>
<td>l</td>
<td>Yankee</td>
<td>y</td>
</tr>
<tr>
<td>Mike</td>
<td>m</td>
<td>Zulu</td>
<td>z</td>
</tr>
</tbody>
</table>

When saying a standard English letter name, you can precede the name of the letter by "Letter," e.g. "Letter A," "Letter B." This can help clarify what you are trying to say if you are in Dictation mode. For example, "B" and "bee" sound the same, so "Letter B" helps Dragon interpret your speech correctly.

To repeat a letter (that is, to say a letter that appears twice in succession):
- Say the letter name twice, e.g. "A A" or "T T."
- Say the letter name preceded by "Double," e.g. "Double A" or, in Spelling mode only, "Double Alpha."

Since "Double U" sounds the same as "W," say "U U" or, in Spelling mode, "Double Uniform."

**Spelling mode** is designed for spelling out unusual words, so letters are lowercase by default. To capitalize a letter:
- Say "Cap" followed by the name of the letter.
- Say "Caps on" mode to capitalize multiple letters in a row.

Because **Dictation mode** is not optimal for spelling out words, it assumes dictated letters are initials or acronyms (see examples below). Letters are uppercase by default, unless Dragon interprets the letter as a word (such as "a"). To lowercase a letter:
- Say "Lowercase" followed by the name of a letter.
- Say "No Caps on" to lowercase multiple letters in a row.

See **Capitalization** for more on using upper and lower case in Dictation mode.

**Dictating Acronyms**

Dragon recognizes many acronyms and will automatically format them correctly. In Dictation mode, you can pronounce acronyms the way you would normally, whether they are pronounced as words (e.g. NATO, AIDS) or letters (e.g. HTML, BBC).

You can also use Spelling mode to dictate acronyms, but what you say will be slightly different:

<table>
<thead>
<tr>
<th>Dictation mode</th>
<th>Spelling mode</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;UNICEF&quot;</td>
<td>&quot;Caps on U N I C E F&quot;</td>
<td>UNICEF</td>
</tr>
</tbody>
</table>

See page 58.
<table>
<thead>
<tr>
<th>Dictation mode</th>
<th>Spelling mode</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;No space on UNICEF&quot;</td>
<td>&quot;Caps on A A R P&quot;</td>
<td>AARP</td>
</tr>
<tr>
<td>&quot;A A R P&quot;</td>
<td>&quot;Caps on Double A R P&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;L period M period Montgomery&quot;</td>
<td>&quot;Cap L period Cap M period Cap MONTGOMERY&quot;</td>
<td>L.M. Montgomery</td>
</tr>
<tr>
<td>&quot;H A L nine thousand&quot;</td>
<td>&quot;Caps on H A L nine zero zero zero&quot;</td>
<td>HAL 9000</td>
</tr>
</tbody>
</table>

If you frequently dictate an acronym that Dragon does not recognize, you can teach it to Dragon using Correction or the Vocabulary Editor.

**Accents and other non-English letters**

**Diacritical Letters**

A diacritical letter is a letter with a marking above or below it, such as Â or ç. You can add a diacritical letter by saying the name of the letter, then the type of accent or mark you want to use (see table below for available diacriticals).

You can use diacritical letters in both Dictation mode and Spelling mode.

<table>
<thead>
<tr>
<th>Say:</th>
<th>Result:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;[Accent] Acute&quot;</td>
<td>á é í ó ú ý</td>
</tr>
<tr>
<td>&quot;[Accent] Circumflex&quot;</td>
<td>â ê î ô û</td>
</tr>
<tr>
<td>&quot;[Accent] Grave&quot;</td>
<td>à è ì ò û</td>
</tr>
<tr>
<td>&quot;[Accent] Umlaut&quot;</td>
<td>ä è ï ö ù ý</td>
</tr>
<tr>
<td>&quot;[Accent] Tilde&quot;</td>
<td>ã ë ï ö</td>
</tr>
<tr>
<td>&quot;Ring Above&quot;</td>
<td>â</td>
</tr>
<tr>
<td>&quot;[Accent] Cedilla&quot;</td>
<td>ç</td>
</tr>
</tbody>
</table>

**Ligatures and Non-Latin Letters**

You can also say the following ligatures and non-Latin letters:

<table>
<thead>
<tr>
<th>Say:</th>
<th>Result:</th>
<th>Say:</th>
<th>Result:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;A E Diphthong&quot;</td>
<td>æ</td>
<td>&quot;O E Diphthong&quot;</td>
<td>œ</td>
</tr>
<tr>
<td>&quot;A E Ligature&quot;</td>
<td></td>
<td>&quot;O E Ligature&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Ligature A E&quot;</td>
<td></td>
<td>&quot;Ligature O E&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Eszet&quot;</td>
<td>ß</td>
<td>&quot;O Slash&quot;</td>
<td>ø</td>
</tr>
<tr>
<td>&quot;Sharp S&quot;</td>
<td></td>
<td>&quot;O Oblique stroke&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;German Sharp&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;German Sharp S&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Say: | Result: | Say: | Result: |
---|---|---|---|
• “Icelandic Eth” | ð | • “Icelandic Thorn” | þ |
• “S Wedge” | š

Related topics:
- Dictation overview
- Recognition modes

**Dictating numbers**

In this topic, learn how to:
- Dictate numerals, decimals, and fractions
- Dictate phone numbers and postal codes
- Dictate currency
- Dictate dates and times
- Dictate weights and measurements
- Dictate superscripts
- Dictate Roman numerals
- Dictate in Numbers mode

You can dictate numbers in Numbers mode, Dictation mode or Spelling mode.

Results below are based on a profile with the default formatting settings. If Dragon is not formatting numbers as expected, check your Auto Formatting preferences. See [Auto Formatting](#) for more information.

<table>
<thead>
<tr>
<th>Number type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dictating numbers</strong></td>
<td><strong>Example 1—Numerals</strong></td>
</tr>
</tbody>
</table>
| In general, you can dictate numbers by saying them as you would conversationally. | Say: "One hundred forty two thousand fifteen"
| Result: 142,015 | **Example 2—Decimals** |
| | Say: "Five point four two three"
| Result: 5.423 | **Example 3—Fractions** |
| | Say: "Two and three fourths"
| Result: 2 3/4 | **Example 4—Phone numbers** |
| | Say: "Seven eight one five six five five thousand"
| Result: 781-565-5000 | **Example 5—Postal codes** |
| | Say: "Boston Massachusetts 0 2 1 1 0"
<table>
<thead>
<tr>
<th>Number type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result: Boston, MA 02110</td>
<td></td>
</tr>
<tr>
<td>Example 6—Currency</td>
<td></td>
</tr>
<tr>
<td>Say: &quot;Ninety nine dollars and fifty cents&quot;</td>
<td></td>
</tr>
<tr>
<td>Result: $99.50</td>
<td></td>
</tr>
<tr>
<td>Example 7—Dates</td>
<td></td>
</tr>
<tr>
<td>Say: &quot;May fifteenth two thousand fifteen&quot;</td>
<td></td>
</tr>
<tr>
<td>Result: May 15, 2015</td>
<td></td>
</tr>
<tr>
<td>Example 8—Time</td>
<td></td>
</tr>
<tr>
<td>Say: &quot;Eight thirty pm&quot;</td>
<td></td>
</tr>
<tr>
<td>Result: 8:30 PM</td>
<td></td>
</tr>
<tr>
<td>Example 9—Weight</td>
<td></td>
</tr>
<tr>
<td>Say: &quot;Two hundred kilograms&quot;</td>
<td></td>
</tr>
<tr>
<td>Result: 200 kg</td>
<td></td>
</tr>
</tbody>
</table>

Forcing numerals

If your dictated numbers appear in text form ("four") rather than numeral form ("4"), you can force Dragon to interpret your numbers as numerals:

- Say "Numeral <number>".

Superscripts

- Say "Superscript <number>".

Roman numerals

- Say "Roman numeral," and then say your number.

To dictate lowercase Roman numerals

1. Say "Roman numeral."
2. Say your number.
3. Say "Lowercase that."

Numbers mode

If you want to dictate many numbers that must be in numeral form, you can switch to Numbers mode.

To dictate numbers in Numbers mode

1. Say "Numbers mode."
2. Dictate your numbers.
3. Say "Dictation mode" when you are done to switch back.
Related topics:

- Dictation overview
- Recognition modes
Correct mistakes

Read these topics to learn how to correct text that Dragon interpreted incorrectly.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correcting recognition errors</td>
<td>• What is Correction?</td>
</tr>
<tr>
<td></td>
<td>• When to use Correction</td>
</tr>
<tr>
<td>Using Correction</td>
<td>• Correcting misrecognized dictations</td>
</tr>
</tbody>
</table>

Correcting recognition errors

When you correct your dictation, you tell Dragon that it made a mistake interpreting your speech. Over time, this process improves your recognition by teaching Dragon not to make the same mistakes.

Before you learn how to correct your dictation, let's examine when you should use this feature.

Correction vs. editing

There are two ways to modify the existing dictated content of a document: you can use Editing commands, such as selecting and replacing a word, or you can use Correction. It's important to know when to use each:

- Use Editing commands if Dragon heard you correctly, but you want to make changes to the content, just as you would edit something you typed yourself.
- Use Correction when Dragon did not hear you correctly and typed something other than what you actually said.

Example

**Use Correction if**

- You said "I'm going out to brunch," and Dragon typed "I'm going out to lunch."

In this case, Dragon made a mistake, and using Correction will teach it not to misrecognize the word "brunch" in the future.

**Use select and replace if**

- You said "I'm going out to lunch," but meant to say "I'm going out to brunch."

In this case, Dragon correctly interpreted what you said, but you made a mistake. Using Correction would teach Dragon that when you said "lunch," it should have recognized it as "brunch." This may make your recognition less accurate.

If you're not sure what you said, say "Select <text>," then say "Play the selection."

**Related topics:**

- Using Correction
- Revising text
- Hearing your text
- Take it back

Using Correction

In this topic, learn how to:

- Show the Correction window
- Correct recognition errors
- Use Smart Formatting to change your formatting preferences
When Dragon has incorrectly typed what you said in Dictation mode, use Correction to correct Dragon's interpretation of what you said. This helps improve recognition over time.

Correction may not be available while you are dictating in certain applications. Check the Guidance window for information about what Dragon can do in your current application.

**Showing the Correction window**
- If you want the Correction window showing whenever you dictate:
  1. Click the in the menu bar and select Preferences…
  2. Open the Advanced pane.
  3. Select **Always Show Correction Window When Dictating**.
- To open the Correction window during a specific dictation session:
  1. Click the Windows menu in the Status window.
  2. Select **Show Correction**.
- To call the Correction window when you need it, use Correction commands, such as "Correct that" or "Correct <text>".

The Correction Window presents a phrase as Dragon understood it, which may sometimes be slightly longer or shorter than the text you had selected. Dragon understands your speech in short phrases, or utterances, which it defines partly based on where you paused while dictating.

**Making a correction**

1. Do one of the following to select text for correction:
   - Say "Correct <text>", "Correct that."
   - Select the text, then use the Correction hot key (by default, ⌘F9).

   The Correction window presents alternative interpretations of the word or phrase you selected to correct.

   - **Correction**
     - Say "Choose" or "Edit" and a number.
     1. Christina
     2. Kristina
     3. Cristina
     4. Krystyna
     5. Krystina

   The number of alternatives is limited by your setting for **Maximum number of alternatives** in the Advanced Preferences pane.

2. Review the list of options.
   - If one of the Correction alternatives is correct, say "Choose <number>" (select the number corresponding to the correct choice).
   - If none of the Correction alternatives are correct, edit one of the alternatives to match what you said:
     1. Say "Edit <number>." It doesn't matter which alternative you choose to edit.
The alternative you are editing is now the "target" for dictation and commands. You can edit using Dictation mode or Spelling mode, or use your keyboard to type in edits to Correction alternatives.

2. Say "Choose <number>" (choose whichever alternative you edited) when you are done.
   - To exit Correction without making a change, say "Cancel correction" or "Cancel edit."

When you choose a correction, Dragon modifies its speech model and saves this information into your profile.

**Smart Formatting**

After some types of corrections, Dragon's smart formatting feature may ask how you want to automatically format this text in the future.

For example, if you dictate "kilograms," Dragon will write "kg" if the default Auto format settings are selected.

1. To write out the word "kilogram," say "Correct kilograms."
   
The Correction window offers a list of options similar to the one below.

   ![Correction Window]

2. Say "Choose 2" to select "kilograms."
   
The Smart Format Rules window appears, asking whether you want Dragon to write out the word "kilograms" every time you say "kilograms."

   ![Smart Format Rules Window]

3. To change the Auto Format rule, say "Choose <number>" (in this case, "Choose 1").
   
If you don't want to change the formatting rules – in this case, if you normally want Dragon to write "kg" when you say "kilogram" – simply resume dictating text, and the Smart Format Rules window will close.

Smart formatting rules are turned on by default when you install Dragon, but you can turn them off in the Advanced Preferences pane.

**Related topics:**
- Correcting recognition errors
- The Guidance window
- Correction options:
- Auto Formatting
## Edit text

Read these topics to learn how to use your voice to edit what you have written.

<table>
<thead>
<tr>
<th>Click</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revising text</td>
<td>• Selecting text • Replacing existing text • Inserting text • Deleting text • Copying, cutting and pasting text</td>
</tr>
<tr>
<td>Hearing your text</td>
<td>• Hearing text read back to you</td>
</tr>
</tbody>
</table>

### Revising text

In this topic, learn how to use your voice to:

- Select text
- Replace existing text
- Insert text
- Delete text
- Copy, cut and paste text

These Dictation mode commands are designed for basic text editing – to correct your own errors or to modify what you dictated.

If what you dictated was not correctly recognized by Dragon, use Correction to improve future recognition. See [Using Correction](#) for more information.

When using fully supported applications, such as TextEdit or Microsoft Word 2011 or 2016, you can edit your text manually using your keyboard and mouse if you prefer. If you are using a different application, see [Mixing dictation with typing](#) for information on how to avoid errors caused by mixing dictation and typing.

### Making a selection

<table>
<thead>
<tr>
<th>Say</th>
<th>To select:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Select that&quot;</td>
<td>The last word or phrase you spoke</td>
</tr>
<tr>
<td>&quot;Select &lt;text&gt;&quot;</td>
<td>A specified word or phrase</td>
</tr>
<tr>
<td>&quot;Select next / previous&quot;</td>
<td>The next or previous instance of the same text</td>
</tr>
<tr>
<td>&quot;Select &lt;text&gt; to &lt;text&gt;&quot;</td>
<td>A range of text from the first word specified through the second word</td>
</tr>
<tr>
<td>&quot;Select the paragraph&quot;</td>
<td>The current paragraph</td>
</tr>
<tr>
<td>&quot;Select next / previous word&quot;</td>
<td>The word before or after your cursor</td>
</tr>
<tr>
<td>&quot;Select next / previous &lt;number&gt; words&quot;</td>
<td>The specified number of words (between 1 and 99) before or after your cursor</td>
</tr>
<tr>
<td>&quot;Select all&quot;</td>
<td>All the text in the document</td>
</tr>
<tr>
<td>&quot;Unselect that&quot;</td>
<td>Undo your selection</td>
</tr>
</tbody>
</table>

Dragon defines a “phrase” based on how it detects pauses in your speech.
When you specify a word to select ("Select <text>"), Dragon selects the nearest instance, based on the location of the cursor. To move to a different instance of the word, say "Select next / previous."

### Replacing text

1. Using the Select voice commands above, select the text you want to replace.
2. Dictate the text you want to use instead.

### Inserting text

1. Place the cursor where you want to insert the text. For example, say "Insert before <text>." or "Insert after the paragraph."
2. Dictate the text.

### Deleting text

**To delete the last thing you said**

Say one of the following:

- "Scratch that"
- "Delete that"
- "Undo that"
- "Undo dictation"

**To delete a specific word or string of words**

- Say "Scratch word" to delete the word to the left of your cursor.
- Say "Delete <text>" to delete a specified word or phrase.
- Say "Delete next" or "Delete previous" to delete the next or previous instance of the same text.
- Say "Delete <text> to <text>" to delete from the first word specified through the second word.
- Say "Delete selection" to delete the selected text.
- Say "Delete the paragraph" to delete the entire paragraph.

### Copying, cutting and pasting text

**To cut text**

- Say "Cut <text>" to cut a specified word or phrase.
- Say "Cut selection" to cut the selected text.
- Say "Cut that" to cut the last word or phrase you spoke.
- Say "Cut the paragraph" to cut the entire paragraph.

**To copy text**

- Say "Copy <text>" to copy a specified word or phrase.
- Say "Copy selection" to copy the selected text.
- Say "Copy that" to copy the last word or phrase you spoke.
- Say "Copy the paragraph" to cut the entire paragraph.

**To paste text**

- Say "Paste from clipboard" or "Paste it here."

### Related topics:

- Correcting recognition errors
- Using Correction
- Navigating within a document
- Take it back
- Formatting
Hearing your text

Dragon can access your OS X Text to Speech capabilities, allowing you to hear text read back to you.

Say one of the following to listen to your text:

- "Read That" – Reads the last sentence or utterance before the cursor
- "Read the selection" – Reads selected text
- "Read the words <word> to <word>" – Reads the first specified word through the second specified word
- "Read the paragraph" – Reads the current paragraph
- "Read the document" – Reads the whole document

While the specified text is being read, Dragon will put the microphone in Sleep mode. The microphone will turn on automatically when the reading is done. To stop listening to the text, say "Wake up" to turn the microphone back on, then say "Stop reading:"

If you want to change the pace of the reading, or the voice you hear, go to your System Preferences and select Dictation & Speech, then click the Text to Speech tab.

Related topics

- Revising text
- Using Correction
Format text

Read these topics to learn how to use text to apply formatting to your dictated text.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Formatting</td>
<td>• Overview: Automatic formatting rules</td>
</tr>
<tr>
<td>Capitalization</td>
<td>• Formatting text capitalization:</td>
</tr>
<tr>
<td></td>
<td>• Initial caps</td>
</tr>
<tr>
<td></td>
<td>• Uppercase</td>
</tr>
<tr>
<td></td>
<td>• Lowercase</td>
</tr>
<tr>
<td>Spacing</td>
<td>• Inserting a space</td>
</tr>
<tr>
<td></td>
<td>• Removing a space</td>
</tr>
<tr>
<td>Formatting</td>
<td>• Formatting text:</td>
</tr>
<tr>
<td></td>
<td>• Bold</td>
</tr>
<tr>
<td></td>
<td>• Italic</td>
</tr>
<tr>
<td></td>
<td>• Underline</td>
</tr>
<tr>
<td></td>
<td>• Outline</td>
</tr>
<tr>
<td>Aligning text</td>
<td>• Left-aligning text</td>
</tr>
<tr>
<td></td>
<td>• Right-aligning text</td>
</tr>
<tr>
<td></td>
<td>• Centering text</td>
</tr>
</tbody>
</table>

Auto Formatting

In this topic, learn how to let Dragon automatically format text, including:

- Street, web and email addresses
- Phone numbers
- Abbreviated titles, such as "Mr." or "Mrs."
- Dates and Times
- Numerals
- Currencies
- Units of measure, such as "km."
- U.S. Social Security Numbers
- Common abbreviations, such as "vs."

Dragon can format addresses, dates and times, numbers, common abbreviations and contractions, and the number of spaces after a period.

To open the Auto Formatting window:

1. Click the  icon in the menu bar and select Manage Profiles…
2. Click the Auto Formatting… button.

![Changes to the Auto Formatting settings affect the current profile, marked with a green circle in the Profiles pane. See Using profiles and dictation sources for more information.]

<table>
<thead>
<tr>
<th>Text type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Street Addresses</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Check to allow Dragon to format addresses correctly.</td>
</tr>
<tr>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td>Say: &quot;forty-nine Orchard Lane, Boston, Massachusetts oh two four four six&quot;</td>
</tr>
<tr>
<td></td>
<td>Result: 49 Orchard Lane, Boston, MA 02446</td>
</tr>
</tbody>
</table>
Some addresses can be difficult to interpret. For example, if you say "Two hundred forty fifth street," you might mean "245th Street," "200 45th Street," or "240 5th Street." In this case, you may need to switch to Spelling mode to get the results you want.

If you frequently dictate a specific address, you can create custom Auto-text commands to insert them into your dictation. See Auto-text commands for more information.

### UK and Canadian postcodes
Check to format postcodes correctly for the UK and Canada.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;W two four R J&quot;</td>
</tr>
<tr>
<td>Result: W2 4RJ</td>
</tr>
</tbody>
</table>

### Web and email addresses
Check to format electronic addresses correctly.

<table>
<thead>
<tr>
<th>Example 1—Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;name at Nuance dot com&quot;</td>
</tr>
<tr>
<td>Result: <a href="mailto:name@nuance.com">name@nuance.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example 2—Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;W W W dot Nuance dot com&quot;</td>
</tr>
<tr>
<td>Result: <a href="http://www.nuance.com">www.nuance.com</a></td>
</tr>
</tbody>
</table>

### Phone numbers
Check to display properly-formatted phone numbers when you say seven- or ten-digit sequences.

- **Example**
  - Say: "eight hundred five five five one two one two"
  - Result: 800-555-1212

- Vanity phone numbers, such as 1-800-EXAMPLE, are not supported, nor is automatic formatting of US phone numbers for UK English users.

### Abbreviated titles
Check to shorten common forms of address.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;Mister Smith&quot;</td>
</tr>
<tr>
<td>Result: Mr. Smith</td>
</tr>
</tbody>
</table>

### Dates
Check to format spoken dates. The dropdown menu offers a number of formatting choices; a few examples are shown here.

- **Example**
  - Say: "January fifth 2016"
  - Result 1: January 5, 2016
  - Result 2: 5 January, 2016
  - Result 3: 01/05/2016

- Omitting the year when you speak produces the month and day as a word and a number, regardless of the formatting you've selected. For example, "January five" or "January fifth" produces January 5.

### Times
Check to format times correctly.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;three twenty A M&quot;</td>
</tr>
<tr>
<td>Result: 3:20 AM</td>
</tr>
</tbody>
</table>

### Use numerals starting with
Dragon will interpret numbers below the number specified in the dropdown menu as words, and numbers equal to or greater than that number as numerals.

<table>
<thead>
<tr>
<th>Example 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say: &quot;three&quot;</td>
</tr>
<tr>
<td>Result: Three</td>
</tr>
<tr>
<td>Text type</td>
</tr>
<tr>
<td>-----------------------------------------</td>
</tr>
<tr>
<td><strong>Partially format &quot;-illion&quot; numbers</strong></td>
</tr>
<tr>
<td>Check to display a combination of numbers and text for numbers higher than 999,999.</td>
</tr>
<tr>
<td><strong>Prices and currencies</strong></td>
</tr>
<tr>
<td>Check to display money amounts properly.</td>
</tr>
<tr>
<td><strong>ISO currency codes</strong></td>
</tr>
<tr>
<td>Check to display the three-letter ISO code rather than the currency symbol.</td>
</tr>
<tr>
<td><strong>Units of measure</strong></td>
</tr>
<tr>
<td>Check to display symbols and abbreviations for common measurements.</td>
</tr>
<tr>
<td>Example 2</td>
</tr>
<tr>
<td><strong>Social Security Numbers</strong></td>
</tr>
<tr>
<td>Check to display properly-formatted US Social Security numbers when you dictate nine-digit sequences.</td>
</tr>
<tr>
<td><strong>All other numbers</strong></td>
</tr>
</tbody>
</table>
| Check to format numbers not covered elsewhere in this section, including:  
  - Negative numbers  
  - Decimals  
  - Ordinals (1st, 2nd, etc.) | Say: "negative five" Result: -5             |
| Example 2—Decimals                      | Say: "eight point two five" Result: 8.25     |
| Example 3—Ordinals                      | Say: "tenth" Result: 10th                     |
| **Common abbreviations**                | Example                                       |
| Check to automatically convert words to their common abbreviations. | Say: "versus"                                |
### Text type

<table>
<thead>
<tr>
<th>Expand contractions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check to expand spoken contractions.</td>
<td>Say: &quot;haven't&quot;</td>
</tr>
<tr>
<td></td>
<td>Result: have not</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Insert two spaces after period</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check to insert two spaces after each period.</td>
<td>Say: &quot;three&quot; [pause] &quot;point one four&quot;</td>
</tr>
<tr>
<td></td>
<td>Result: 3.14</td>
</tr>
</tbody>
</table>

*While this was once a common convention, today most style guides recommend a single space after a period.*

### Related topics:
- [Dictation overview](#)
- [Dictating numbers](#)
- [Using Correction](#)

### Formatting

Use these commands to adjust the formatting of your text. These commands are available only in applications that support text formatting.

#### To toggle bold formatting

- Say "Bold that" to bold the last phrase you dictated.
- Say "Bold <text>" to bold the specified word or words.
- Say "Bold Next" or "Bold Previous" to bold the next or previous instance of the same text.
- Say "Bold the paragraph" to bold the entire paragraph.
- Say "Select <text>," then say "Make the selection bold" to bold selected text.

#### To toggle italic formatting

- Say "Italicize that" to italicize the last phrase you dictated.
- Say "Italicize <text>" to italicize the specified word or words.
- Say "Italicize Next" or "Italicize Previous" to italicize the next or previous instance of the same text.
- Say "Italicize the paragraph" to italicize the entire paragraph.
- Say "Select <text>," then say "Make the selection italic" to italicize selected text.

#### To toggle underlined formatting

- Say "Underline that" to underline the last phrase you dictated.
- Say "Underline <text>" to underline the specified word or words.
- Say "Underline Next" or "Underline Previous" to underline the next or previous instance of the same text.
- Say "Underline the paragraph" to underline the entire paragraph.
Say "Select <text>," then say "Make the selection underlined" to underline selected text.

**Related topics:**
- Making a selection

## Capitalization

Dragon automatically capitalizes most words when appropriate. For example, Dragon recognizes and automatically capitalizes the first word in a sentence, most names and places, and many acronyms.

If you need to make adjustments to the capitalization, use these commands.

### Title Case

**To capitalize a word as you dictate**
- Say "Cap <word>" to capitalize the next word you dictate.
- Say "Capitalize word" to capitalize the last word you dictated.

**To capitalize the next string of words as you dictate**
- Say "Caps on" to capitalize the first letter of every word you dictate.
- Say "Caps off" to go back to normal capitalization.

**To capitalize words you have already dictated**
- Say "Capitalize that" to capitalize the last utterance you dictated.
- Say "Capitalize <text>" to change the specified text to title case.
- Say "Capitalize Next" or "Capitalize Previous" to capitalize the next or previous instance of the same text.
- Say "Capitalize <text> to <text>" to change a range of text from the first specified word through the second to title case.
- Say "Capitalize the paragraph" to capitalize the entire paragraph.
- Say "Select <text>," then say "Capitalize selection" to change the selected text to title case.

### Lowercase

**To lowercase a word as you dictate**
- Say "No Caps <word>" to make the next word you dictate lowercase.
- Say "Lowercase word" to make the last word you dictated lowercase.

**To lowercase the next string of words as you dictate**
- Say "No Caps on" to make every word you dictate lowercase.
- Say "No Caps off" to go back to normal capitalization.

**To lowercase text you have already dictated**
- Say "Lowercase that" to make the last utterance you dictated lowercase.
- Say "Lowercase <text>" to change the specified text to lowercase.
- Say "Lowercase Next" or "Lowercase Previous" to change the next or previous instance of the same text to lowercase.
- Say "Lowercase <text> to <text>" to change a range of text from the first specified word through the second to lowercase.
- Say "Lowercase the paragraph" to change the entire paragraph to lowercase.
- Say "Select <text>," then say "Lowercase selection" to change the selected text to lowercase.
All Caps

To make a word ALL-CAPS as you dictate
- Say "All Caps <word>" to make the next word you dictate all-caps.

To make the next string of words all-caps as you dictate
- Say "All Caps on" to make every word you dictate all-caps.
- Say "All Caps off" to go back to normal capitalization.

To make text you have already dictated all-caps
- Say "Uppercase <text>" to change the specified text to all-caps.
- Say "Uppercase Next" or "Uppercase Previous" to change the next or previous instance of the same text to all-caps.
- Say "Uppercase <text> to <text>" to change a range of text from the first specified word through the second to all-caps.
- Say "Uppercase the paragraph" to change the entire paragraph to all-caps.
- Say "Select <text>," then say "Uppercase selection" to change the selected text to all-caps.

Related topics:
- Making a selection
- Dictation overview
- Revising text

Spacing

In general, Dragon will automatically insert or suppress spacing where appropriate. For example, spaces are inserted between words and after punctuation such as periods and commas, but suppressed around hyphens. If you need to make special adjustments, use these commands.

To insert a space
- Say "Space bar."

To adjust spacing as you dictate
- Say "No space <word>" to prevent automatic insertion of a space before the next word.
- Say "No space on" to prevent automatic insertion of a space between a string of words (such as a Web address).
- Say "No space off" to go back to normal spacing.

To delete a space before a word you already dictated
1. Say "Insert before <word>" to place the cursor before the word.
2. Say "No leading space" or "Press the key Delete."

Remember, in some applications, it's better not to use your mouse and keyboard while dictating text. See Mixing dictation with typing for more information, including a list of currently supported applications.

Related topics:
- Dictation overview
- Auto Formatting
- Revising text
Aligning text

Use these commands to adjust the alignment of your text. These commands are available only in applications that support text formatting.

To align the current paragraph

- Say "Align the text left / center / right."

To justify text

1. Say "Select <text>" to select the text you want to justify.
2. Say "Justify the text"

To align the whole document

1. Say "Select all."
2. Use the alignment commands above.

Related topics:

- Making a selection
- Formatting
- Spacing
Transcription

Read these topics to learn how to use Dragon to transcribe audio files into text.

Click: | To learn about:
--- | ---
Transcribing recorded audio | • Selecting an audio file for Transcription  
• Viewing a transcribed file  
Transcription Training | • The Transcription Training process

Transcribing recorded audio

In this topic, learn how to:

• Switch to Transcription mode  
• Select an audio file for Transcription  
• Edit a transcribed file  
• Delete a Transcription speaker  
• Exit Transcription mode

To switch to Transcription mode, do one of the following:

• Say "Switch to Transcription mode."
• Click the ⏯ icon in the menu bar and select Switch to Transcription…

The Transcription window appears, and the Status Window and Guidance Window are hidden.

Selecting an audio file for Transcription

When you switch to Transcription mode, the Transcription window appears:
1. Choose a **Speaker** from the list:
   - Choose **Me** if you are transcribing your own speech.
   - Choose **Someone Else** if you are transcribing another person’s speech.

2. If you chose **Someone Else** in the previous step, Dragon prompts you to set up a new profile for Transcription. Follow the prompts
   1. Enter a unique name for the profile, then click **Continue**.
   2. Choose a region, then click **Continue**.
      The region affects spelling, vocabulary, and formatting of the transcribed text.
   3. Choose the accent that best describe the recorded voice, then click **Continue**.
      Dragon takes a few moments to create the new profile.

   Once you have created a Transcription profile, it will appear in the Speaker dropdown for future use.

3. **Optional**: Select a **Format** for the transcribed text, and an application to open the file.

4. **Optional**: Select a **Destination** folder for the transcribed text.

   By default, Dragon automatically saves your files in Documents/Dragon/Transcribed Files.

5. To select an audio file for transcription, drag the file onto the **Audio Files to Transcribe** list, or click **+** to browse to the file.

   Dragon can transcribe audio files in mp3, mp4, wav, aif, aiff, m4v, and m4a formats.

6. Click **Start** to begin the transcription process.

   Depending on the size and number of audio files, this may take several minutes. If you want to stop the transcription, click the **x** button to the right of the progress bar. Dragon provides a partial transcript of the portion of the file that was processed.

   When Dragon has finished transcribing your file, a notification appears.

7. Click **OK** to dismiss the message, or do one of the following:
   - If you transcribed a single audio file, click **Open** to view the file in the application you selected in step 3.
   - If you transcribed multiple audio files, click **Show** to open a Finder window showing the transcribed files folder you selected in step 4.

**Editing a transcribed file**

When Dragon transcribes an audio file, you can choose to open the results in a new Microsoft Word or TextEdit document. The text will not include any punctuation, unless you dictated punctuation in the transcribed audio file. If you switch to Dictation mode (see **Exiting Transcription mode** below), you can select, replace, and format text using commands such as:

- "**Bold <word>**"
- "**Insert before <word>**"
- "**Select <text>**"

Note that you cannot say "**Correct <text>**" to fix Transcription errors. Correction requires audio to compare against the selected text – Dragon doesn’t have that data in transcribed files. What you can do is say "**Select <text>**", then dictate over it. If what you just spoke is misrecognized, then you can say "**Correct <text>**" to correct your **dictated** text. See **Using Correction** for more information.

See **Mixing dictation with typing** for information on how to avoid errors caused by mixing dictation and typing.
Where are my transcriptions?

Dragon automatically saves your files in Documents/Dragon/Transcribed Files, or the Destination you chose before starting transcription. Click Open Transcribed Files Folder to open the folder in a Finder window.

By default, transcribed files will share the name of the audio file you selected. For example, if you selected a file called Notes08Jul.wav, Dragon would create the text file Notes08Jul.rtf.

Deleting a Transcription speaker

1. In the Speaker dropdown menu, select Edit Speaker List…
   A popup window appears.
2. Select the speaker from the list.
3. Click Delete Speaker.
   A confirmation dialog appears.
4. Click OK to continue.
5. Click Done to return to the main Transcription window.

Exiting Transcription mode

To return to Dictation mode, do one of the following:

- In the Transcription window, click Switch to Dictation.
- Click the icon in the menu bar and select Switch to Dictation…

Related topics:
- Transcription Training
- Revising text

Transcription Training

If you want to improve the accuracy of Dragon’s transcription, use Transcription Training to teach Dragon to understand your recordings. You will need an audio sample in mp3, mp4, wav, aif, aiff, m4v, and m4a format that is at least 6 minutes long.

To switch to Transcription mode, do one of the following:

- Say "Switch to Transcription mode."
- Click the icon in the menu bar and select Switch to Transcription…

The Transcription window appears, and the Status Window and Guidance Window are hidden.

Once you are in Transcription mode:

1. Click the icon in the menu bar and select Improve Recognition > Transcription Training…
   A Finder window opens.
2. Browse to your sample audio file, select it, and click Open.
   Dragon transcribes the audio. This process may take several minutes. When the transcription is complete, the first utterance is selected, and a popup dialog appears with an audio player.
3. In the popup, press **Play** to listen to the first audio segment.

4. Make sure the words Dragon transcribed, shown in the popup window, are the exact words you hear in the audio.
   - If there are words that were recognized incorrectly, use your keyboard and mouse to select them and type in the correct words. Press play to listen again, if needed.

   **Do not add punctuation during Transcription Training.** Punctuation will cause Dragon to skip the selected segment of audio.

5. When the text is correct for that section, click **Accept**.
   - In most cases, the text for that segment turns **green**, and the training popup moves to the next utterance.
   - If there is a problem with a segment of audio, such as a dog barking in the background, click **Ignore**. The text turns **red** and Dragon will not use that audio segment for the Transcription Training.
   - If you made many corrections to a segment of text, the text may also turn **red**.

6. Repeat the process until you have reviewed enough audio to train.

   The blue bar across the Transcription Training window tells you how many seconds of audio are required, and how many seconds of audio you have accepted.

   When you have accepted enough audio, the **Train** button appears.

7. Click the **Train** button.

   Dragon takes a few minutes to train the new profile.

**Related topics:**
   - Transcribing recorded audio
Control your computer

Dragon allows you to use your voice to control your mouse and keyboard, application windows, menus, and more. Read these topics to learn how to use your voice to navigate and control your computer.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Launching and quitting applications</strong></td>
<td>• Launching applications&lt;br&gt;• Quitting applications</td>
</tr>
<tr>
<td><strong>Navigating application windows</strong></td>
<td>• Opening windows&lt;br&gt;• Closing, hiding or minimizing windows&lt;br&gt;• Switching between active windows</td>
</tr>
<tr>
<td><strong>Menu Walking</strong></td>
<td>• Using an application’s menus</td>
</tr>
<tr>
<td><strong>Key commands</strong></td>
<td>• Controlling the keyboard with your voice</td>
</tr>
<tr>
<td><strong>Mouse commands</strong></td>
<td>• Controlling your mouse with your voice</td>
</tr>
<tr>
<td><strong>MouseGrid</strong></td>
<td>• Moving your mouse using numbered sections of a grid.</td>
</tr>
<tr>
<td><strong>Using dialog controls</strong></td>
<td>• Clicking a button in a dialog box</td>
</tr>
<tr>
<td><strong>OS X controls</strong></td>
<td>• Restarting your Mac&lt;br&gt;• Putting your Mac to sleep&lt;br&gt;• Opening the Force Quit dialog&lt;br&gt;• Changing your screen view&lt;br&gt;• Taking a screenshot</td>
</tr>
<tr>
<td><strong>Working with the Finder</strong></td>
<td>• Changing the display of Finder windows&lt;br&gt;• Managing files and folders&lt;br&gt;• Creating and deleting folders, files, and aliases&lt;br&gt;• Navigating the Finder&lt;br&gt;• Ejecting drives</td>
</tr>
</tbody>
</table>

Launching and quitting applications

To launch applications using Dragon, just say “Activate <application>” (for example, “Activate Safari”). If the application is not running currently, it will be launched. If it is already running, this command will bring it to the front.

You can also quit applications by saying “Quit this application” or “Quit <application>” (for example, “Quit TextEdit”).

If this is the first time you have launched Dragon, the “Activate” commands will not yet be available. Next time you launch the application, Dragon will look through all the applications on your computer and generate Activate commands for each of them.

If you are still unable to use “Activate” commands, click the ‌ in the menu bar and select **Preferences**… In the General pane, make sure that **Generate Application Launch Commands** is checked in the General pane.

Related topics:

- Navigating application windows
- Preferences window
- Working with the Finder
- OS X controls
Navigating application windows

These commands are universally available to navigate between windows in your open applications.

To open a new file or window
- Say "New file" to open a new file or window in the current application.
- Say "Open file" to access the Open File dialog in the current application.

To close the current file or window
- Say "Close file" or "Close window."

To switch between windows or applications
- Say "Next / Previous application window" to switch to the next or previous open window in the current application.
- Say "Switch to next / previous application" to switch to the next or previous open application.

To hide or show windows or applications
- Say "Minimize this window" to minimize the current window.
- Say "Show / Hide this application" to show or hide all windows in the active application.
- Say "Hide other applications" to hide all but the current application.
- Say "Show / Hide all applications" to show or hide all currently running applications.

Related topics:
- Launching and quitting applications
- Menu Walking
- Working with the Finder
- Navigating within a document

OS X controls

These commands access OS X functions from any application.

To put your computer in sleep mode
- Say "Put computer to sleep."
- Say "Special sleep" to force the computer to go to sleep.

To restart your computer
- Say "Restart the computer."
- Say "Special Restart" to force the computer to restart without waiting for other tasks to complete.

To quit unresponsive applications
- Say "Access Force Quit."

To toggle full screen mode
- Say "Switch to full screen" to view the current window in full screen mode.
- Say "Exit full screen" to exit full screen mode.

To capture images of your screen
- Say "Capture screen" to create a screenshot of your entire screen and save it to your
Say "Capture selection" to define an area of your screen to capture.

Related topics:
- Menu Walking
- Navigating application windows
- Launching and quitting applications
- Working with the Finder

Working with the Finder

In this topic, learn how to use your voice to:
- Change the display of Finder windows
- Manage files and folders
- Create and delete folders, files, and aliases
- Navigate the Finder
- Eject drives

Use these commands to navigate and control the Finder. Use menu walking commands to access other Finder features. For example, say "Click File menu," then "Click Get Info."

Adjusting the window display

To show or hide bars in Finder windows
- Say "Show / Hide Path Bar."
- Say "Show / Hide Status Bar."
- Say "Show / Hide Toolbar."

To show or hide the Dock
- Say "Turn Dock Hiding on / off."

To toggle Zoom view
- Say "Zoom this window."

Adjusting the folder display

To change the way items are displayed
- Say "View as <style>." You can view items as:
  - Icons
  - Lists
  - Columns

To arrange items in your view
- Say "Arrange by <property>" to sort items by the specified property. You can sort items by:
  - Name
  - Date modified
  - Date created
  - Size
  - Kind
  - Label

To create a Sidebar shortcut to the selected item...
• Say "Add to Sidebar."

Managing files and folders

To open the selected file or folder
• Say "Open selection."

To rename the currently selected item
1. Say "Select name of selection."
2. Dictate the new name of the item.

To rename another item in the current folder
• Say "Select next / previous name."

File or folder names are selected in alphabetical order.

To view a Quick Look heads up display of the selected item
• Say "Quick look selection."

To view the original file associated with a selected alias
• Say "Show original."

To deselect all items in the current folder
• Say "Deselect All."

Creating and deleting items

To create a new folder
• Say "Make new folder."
  Or
• Say "Make new Smart folder."

To create a copy of the selected item(s)
• Say "Duplicate selection."

To create an alias of the selected item
• Say "Make alias."

To create a compressed Zip file of the selected folder
• Say "Compress selection."

To delete the selected item(s)
• Say "Move to Trash."

To permanently delete all files in the Trash folder
• Say "Empty Trash."

Navigating windows

To go to the next or previous view in the active window
• Say "Go back / forward."

To go to the enclosing folder for the selected item
• Say "Go to enclosing folder."

To go to a specific folder
• Say "Go to <folder>.

Available folders include:

• Computer
• Home
• Desktop
• Utilities
• Network
• Downloads
• Music
• Movies
• Applications folder

To open the Go to Folder dialog in the Finder

• Say "Access Go to Folder window."

To search the Finder

1. Say "Access Find window."
2. Dictate the text you want to search for.
3. Say "Press key Return."

Navigating folders

To open the Connect to Server window

• Say "Access Connect to Server window."

To cycle through the open Finder windows

• Say "Cycle through windows."

To bring all Finder windows to the front

• Say "Bring all to front."

To close all Finder windows

• Say "Close all windows."

Ejecting a drive or disc

1. Select the drive or disc you want to eject.
2. Say "Eject selection."

Related topics:

• Menu Walking
• Navigating application windows
• Launching and quitting applications
• OS X controls

Using dialog controls

Most applications use pop-up dialog boxes to confirm your actions, warn you of a problem, or even make suggestions. Dragon knows many common dialog button names, allowing you to click buttons with your voice:

• "Click Done"
• "Click OK"
• "Click Continue"
• "Click Save"
You can also say "Click Enter" or "Click Return" to choose the default (highlighted) button in a dialog.

For more complex dialogs, such as a sign-in window, say "Click next field" or "Click previous field" to navigate between text fields.

**Related topics:**
- Key commands
- Menu Walking

## Key commands

Key commands allow you to enter a keystroke with your voice, as if you had typed that key manually on your keyboard.

Key commands allow you to use keyboard shortcuts you already know to perform tasks, whether or not there a separate Dragon command for that task. For example, if you want to create a new document in any application, you can say "New file" or you can say "Press the key combo Command N."

### How to say a key command

- Say "Press the key <KEYNAME>" to press a single key.
  - Example: "Press the key Escape."
- Say "Press the key <MODIFIER-KEYNAME>." to press a key combination.
  - Example: "Press the key Command S."

### Key names

<table>
<thead>
<tr>
<th>Key type</th>
<th>Example command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter keys (A, B, C, etc.)</td>
<td>&quot;Press the key S&quot;</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>&quot;Press the key Sierra&quot;</td>
</tr>
<tr>
<td>Note: Single letter names are often misrecognized. Use the International Radio Alphabet (Alpha, Bravo, Charlie, etc.) for better recognition. See Letters for the full International Radio Alphabet.</td>
<td></td>
</tr>
<tr>
<td>Number keys (one, two, etc.)</td>
<td>&quot;Press the key Five&quot;</td>
</tr>
<tr>
<td>Space bar</td>
<td>&quot;Space bar&quot;</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>&quot;Press the key Space bar&quot;</td>
</tr>
<tr>
<td>Delete / Forward Delete</td>
<td>&quot;Press the key Delete&quot;</td>
</tr>
<tr>
<td>F-Keys (F one, F two, etc.)</td>
<td>&quot;Press the key F-eleven&quot;</td>
</tr>
<tr>
<td>Return / Enter</td>
<td>&quot;Press the key Enter&quot;</td>
</tr>
<tr>
<td>Tab</td>
<td>&quot;Tab key&quot;</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td>Note: Unlike most keys, the Tab key does not require</td>
<td></td>
</tr>
<tr>
<td>Key type</td>
<td>Example command</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>the command &quot;Press the key&quot;—you can just say &quot;Tab key.&quot;</td>
<td>&quot;Press the key Tab&quot;</td>
</tr>
<tr>
<td>Page Up / Down</td>
<td>&quot;Press the key Page Up&quot;</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>&quot;Press the key Right Arrow&quot;</td>
</tr>
<tr>
<td>Home / End</td>
<td>&quot;Press the key Home&quot;</td>
</tr>
<tr>
<td>Escape</td>
<td>&quot;Press the key Escape&quot;</td>
</tr>
</tbody>
</table>

**Modifier keys**

These keys are used in many keyboard shortcuts:
- Command
- Shift
- Option
- Control
- Caps Lock

**Example:** "Press the key Command-Shift-F."

**Related topics:**
- Mouse commands
- Dictating letters
- Menu Walking

**Menu Walking**

You can use Dragon to "walk through" the menu options of any application, just as you would with your mouse and keyboard.

1. Say "Click <menu name> menu" or "Open <menu name> menu"
2. Say "Click <menu item>.

**Example:** "Click File menu," then "Click Print."

If there are submenus, repeat the process as needed.

**Example:** "Click File menu," then "Click Open Recent," then "Click MyDocument."

While these commands are available from any application, the specific options will vary depending on the menu contents of your current application. For example, you can say "Click Bookmarks menu" when you’re using Safari, but not when you’re using TextEdit.

**Related topics:**
- Launching and quitting applications
- Navigating application windows
- Key commands
Mouse commands

These commands allow you to control your mouse pointer with your voice. If you want to move the mouse to a specific part of the screen, you can say "Open MouseGrid" to turn on the MouseGrid.

Moving the mouse

To make the cursor begin moving in a specified direction

- Say "Move mouse <direction>." The cursor can move up, down, left, right, or a combination like left and up.
- Say "Faster" or "Slower" to change how fast the cursor moves.
- Say "Stop" to stop the cursor movement.

To move the cursor a specified number of units in the specified direction

- Say "Move mouse <1-100> <units> <direction>." Units may be pixels, centimeters or inches.

Clicking the mouse

Say one of the following:

- "Mouse click"
- "Mouse double click"
- "Mouse triple click"

You can also use modifiers (Command, Option, Shift, Control) with mouse clicks. For example, you could say "Control mouse click."

- Say "Hold mouse" or "Press mouse" to click and hold the mouse.
- Say "Release mouse" to release the mouse button.

Related topics:

- MouseGrid
- Key commands

MouseGrid

The MouseGrid allows you to move your mouse pointer to a specific area. Summoning the MouseGrid displays a transparent three-by-three grid over your screen with the sections numbered one through nine.
With the MouseGrid on the screen, speak the number you want to focus on. A new three-by-three grid will appear in that spot, with your mouse pointer at the center.

You can repeat the process as many times as you need. When the grid area becomes too small to display numbers, you will see a magnification window.

When the MouseGrid is on, you can use mouse commands, such as "*Mouse click,*" to further control the mouse.

**Opening the MouseGrid**

- Say "Open MouseGrid" to open the full-screen MouseGrid.
- Say "Open small MouseGrid" to open a small grid centered around the pointer's current location.

**Zooming in**

- Say "<1-9>" to select and zoom in on the specified section of the grid.

**Dismissing the MouseGrid**

- Say "Cancel" to remove the MouseGrid.

**Changing MouseGrid settings**

Open the Advanced pane of the Preferences window to adjust the appearance and behavior of the MouseGrid. See Preferences window: Advanced for more information.

**Related topics:**

- Mouse commands
- Key commands
Create documents

Read these topics to learn how to create a document, dictate and revise text, and save your document.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
</table>
| **Working with Microsoft Word** | • Creating a Microsoft Word document  
                              | • Navigating within a document  
                              | • Editing and formatting text  
                              | • Saving a document  
                              | • Printing a document |
| **Working with TextEdit** | • Creating a TextEdit document  
                              | • Navigating within a document  
                              | • Editing and formatting text  
                              | • Saving a document  
                              | • Printing a document  
                              | • Adjusting your view |
| **Navigating within a document** | • Placing the cursor  
                              | • Moving to the beginning or end of a document |

**Working with Microsoft Word**

In this topic, learn how to use your voice to:

- Create a Word document
- Navigate within a document
- Edit and format text
- Save a document
- Print a document

The commands below are available when you are using Microsoft Word 2011 or 2016. Use the menu walking commands to access other Word features. For example, say "Click View menu," then "Click Web Layout."

**Note:** You cannot dictate in tables. Add tables after you have finished dictating the main body of the document.

**Creating a document**

With Word active, do one of the following:

- Say "New file" to create a new document in Word.
- Say "Open file" to access the Open dialog.

**Navigating within your document**

Move your cursor to a different point in your text with the standard navigation commands, such as:

- "Insert before <text>"
- "<Direction> arrow" (up, down, left or right)
- "Go to beginning / end"

See **Navigating within a document** for more information.

**Selecting text**

Use the standard commands for making a selection, such as:

- "Select <text>"
- "Select All"
Select next / previous word
"Unselect that"

See Revising text for more information.

Editing your document

Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
- "Copy <text>"
- "Copy selection"
- "Paste from clipboard"
- "Delete <text>"
- "Delete selection"

See Revising text for more information.

Formatting your document

Use the global commands to format the last word or phrase you spoke:

- "Bold / Italicize / Underline that"

To change the font size

Say "Set font size to <number> points."

To insert a page break

Say "Insert Page Break."

Saving your document

Say "Save this document."

Printing your document

Say "Print the document."

Closing your document

Say "Close file."

Related topics:

- Menu Walking
- Navigating application windows
- Launching and quitting applications

Working with TextEdit

In this topic, learn how to use your voice to:

- Create a TextEdit document
- Navigate within a document
- Edit and format text
- Save a document
- Print a document
- Adjust your view

These commands are available when you are using TextEdit. Use the menu walking commands to access other TextEdit features. For example, say "Click File menu," then "Click Export as PDF."
Creating or open a document

WithTextEdit active, do one of the following:

- Say "New file" to create a new document in TextEdit.
- Say "Open file" to access the Open dialog.

Navigating within your document

Move your cursor to a different point in your text with the standard navigation commands, such as:

- "Insert before <text>"
- "<Direction> arrow" (up, down, left or right)
- "Go to beginning / end"

See Navigating within a document for more information.

Finding text in your document

1. Say "Show Find window."
2. Say the word or phrase you want to search for.
3. Say "Find next / previous" to navigate search results.
4. Say "Go to next field" to return to the document.

Selecting text

Use the standard commands for making a selection, such as:

- "Select <text>"
- "Select All"
- "Select next / previous word"
- "Unselect that"

See Revising text for more information.

Editing your document

Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
- "Copy <text>"
- "Copy selection"
- "Paste from clipboard"
- "Delete <text>"
- "Delete selection"

See Revising text for more information.

To paste text using the font formatting of the paste location

- Say "Paste and match style."

Formatting your document

You can use any of the standard commands to format or align text, such as:

- "Bold / italicize / underline that"
- "Make <text> bold / italic / underline"
- "Make selection bold / italic / underline"
- "Align the text left / center / right"
See [Formatting](#) for more information.

To increase or decrease the font size

- Say "Make selection bigger / smaller."

To apply text spacing, such as indenting and Tabs, from one part of the text to another

1. Place your cursor in the section of the text whose spacing you want to copy.
2. Say "Copy Text Ruler."
3. Move your cursor to the section of the text where you want to apply the Text Ruler.
4. Say "Paste Text Ruler."

Saving your document

- Say "Save this document."
  
  Or
  
  - Say "Show Save As window."

To undo all your changes since the last time you saved

- Say "Revert to last saved version."

Printing your document

- Say "Print this document."

Closing your document

- Say "Close file."

Adjusting your view

- Say "Toggle Text Ruler" to show or hide the Text Ruler.
- Say "Toggle Fonts palette" to show or hide the Fonts palette.

To wrap text

- Say "Wrap text to page."

To bring all TextEdit windows to the front

- Say "Bring all windows to front."

To toggle Zoom view for the current window

- Say "Zoom this window."

To close all TextEdit windows

- Say "Close all windows."

**Related topics:**
- [Menu Walking](#)
- [Navigating application windows](#)
- [Launching and quitting applications](#)

**Navigating within a document**

When you are dictating or editing text, it is important to know how to navigate your document.
In Microsoft Word or TextEdit, you can use your keyboard or mouse to perform these tasks. See [Mixing dictation with typing](#) for information on using your keyboard and mouse while dictating with Dragon.

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move the cursor to the first or last position in the current document</td>
<td>Say &quot;Go to beginning / end.&quot;</td>
</tr>
<tr>
<td>To move the cursor a specified number of words from its current position</td>
<td>Say &quot;Move backward / forward &lt;number&gt; word(s).&quot;</td>
</tr>
<tr>
<td>You can move between 1 and 99 words forward or backward.</td>
<td></td>
</tr>
<tr>
<td>To insert the cursor before a specified word or phrase</td>
<td>Say &quot;Insert before &lt;text&gt;.&quot;</td>
</tr>
<tr>
<td>When you specify a word as an insertion point, if that text appear more than once in the document, Dragon selects the nearest instance.</td>
<td></td>
</tr>
<tr>
<td>To move the cursor to its previous position</td>
<td>Say &quot;Go back.&quot;</td>
</tr>
<tr>
<td>To move the cursor up, down, left or right</td>
<td>Say &quot;&lt;Direction&gt; arrow.&quot;</td>
</tr>
<tr>
<td>The cursor will move one position in the specified direction, as it would if you pressed the arrow keys.</td>
<td></td>
</tr>
<tr>
<td>To move the cursor to a new text field</td>
<td>Say &quot;Click next / previous field.&quot;</td>
</tr>
<tr>
<td>This command is for:</td>
<td></td>
</tr>
<tr>
<td>Documents such as emails that contain multiple text fields</td>
<td></td>
</tr>
<tr>
<td>Dialog boxes, such as sign-in window, that include multiple fields</td>
<td></td>
</tr>
<tr>
<td>Spreadsheets</td>
<td></td>
</tr>
</tbody>
</table>

**Related topics:**
- [Launching and quitting applications](#)
- [Navigating application windows](#)
Use applications

Read this topic to learn how to control popular OS X applications with your voice.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
</table>
| Working with Microsoft Word | • Creating a document  
• Navigating within a document  
• Editing and formatting text  
• Saving a document  
• Printing a document |
| Working with TextEdit | • Creating a document  
• Navigating within a document  
• Editing and formatting text  
• Saving a document  
• Printing a document  
• Adjusting your view |
| Working with Mail | • Opening a new email addressed to anyone in your Contacts  
• Creating new messages  
• Navigating message text  
• Editing and formatting text  
• Sending a message  
• Viewing messages and threads  
• Printing a message  
• Sorting and labeling messages  
• Searching your mail  
• Navigating Mailboxes |
| Working with Safari | • Opening a Web page  
• Entering text  
• Navigating the Web  
• Navigating a Web page  
• Loading a page  
• Using Safari windows and tabs  
• Adding and editing bookmarks  
• Using Auto Fill  
• Sharing a Web page  
• Printing a Web page  
• Adjusting your view |
| Working with Calendar | • Creating and deleting events  
• Changing your view  
• Searching your calendars  
• Backing up your calendars |
| Working with Messages | • Sending a message |

Working with Mail

In this topic, learn how to use your voice to:

- Create new messages in Mail
- Navigate message text
- Edit and format text
- Send a message
- View messages and threads
The commands below are available when you are using Apple Mail. Use the menu walking commands to access other Mail features. For example, say "Click Message menu," then "Click Add Sender to Contacts."

Remember, in some applications, it's better not to use your mouse and keyboard while dictating text. See Mixing dictation with typing for more information, including a list of currently supported applications.

Creating a new message

- Say "New message" to compose a new message from scratch.

To reply to the selected message

Say one of the following:

- "Reply to this message"
- "Reply All to this message"

To forward the selected message

Do one of the following:

- Say "Forward this message" to forward the whole message.
- Say "Forward selection" to forward a selected portion of the message.
- Say "Redirect this message" to send the message directly to a new recipient.

To resend the selected message

- Say "Send this message again."

Navigating within your message

Move your cursor to a different point in your text with the standard navigation commands, such as:

- "Insert before <text>"
- "<Direction> arrow" (up, down, left or right)
- "Click next / previous field"

See Navigating within a document for more information.

You can also say any of the following in Mail:

- "Move to beginning / end of message"
- "Move up / down one paragraph"
- "Move left / right one word"
- "Move to beginning / end of this line"
- "Move left / right one character"

Selecting text

Use the standard commands for making a selection, such as:

- "Select <text>"
- "Select All"
- "Select next / previous word"
- "Unselect that"
See Revising text for more information.

You can also say any of the following in Mail:

- "Extend selection left / right one character"
- "Extend selection to beginning / end of line"
- "Extend selection up / down one line"
- "Extend selection to end of paragraph"
- "Extend selection up / down one paragraph"
- "Extend selection to beginning / end of message"
- "Extend selection to end of window"

Editing your message

Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
- "Copy <text>"
- "Copy selection"
- "Paste from clipboard"
- "Delete <text>"
- "Delete selection"

See Revising text for more information.

You can also say any of the following in Mail:

- "Paste as quotation"
- "Paste and match style"
- "Append selected messages"
- "Check spelling"

Formatting text

You can use the global commands to format the last word or phrase you spoke:

- "Bold / Italicize / Underline that"

You can also say any of the following:

- Say "Make selection bigger / smaller" to increase or decrease the font size by one point.
- Say "Increase / decrease quote level" to format the selected text as a quote and increase or decrease the quote level:

```
  First level
  Second level
  Third level
```

If you want to apply formatting from one section of text to another:

1. Select the formatted text.
2. Say "Copy style of selection."
3. Select the text where you want to apply the formatting.
4. Say "Paste style."
Sending your message

- Say "Send message."

Navigating messages and threads

To scroll within a message or thread
- Say "Move up / down one page."

To toggle viewing threads in the Mailbox pane

Say one of the following:
- "Expand / Collapse this thread"
- "Expand / Collapse all threads"

To move between messages
- Say "Go to next / previous message."

To view your selected message or thread in the Mailbox
- Say "Jump to selection."

To check for new messages
- Say "Get new mail."

Printing a message

- Say "Print this document."

Managing your messages

To sort your messages
- Say "Sort by <property>.

You can sort messages by:
- Attachments
- Date Received
- Date Sent
- Flags
- From
- To
- Subject
- Size

To label the selected message
- Say "Mark as <status>.

You can mark messages as:
- Flagged
- Unflagged
- High Priority
- Low Priority
- Normal Priority
- Junk Mail
- Read
- Unread

To delete the selected message
- Say "Delete selection."
To clear deleted or junk messages

Say one of the following:

- "Erase deleted messages in all accounts"
- "Erase deleted messages on my Mac"
- "Erase Junk Mail"

Searching your messages

To search the text of the current message

1. Do one of the following:
   - Say "Access Find window."
   - With text selected in the current message, say "Use selection for Find."
2. Dictate the word or phrase you want to search for.

To search your Mailbox

1. Say "Find in selected mailboxes."
2. Dictate the word or phrase you want to search for.
3. Say "Find Next / Previous" to switch between Find results.

Navigating your mailboxes

To switch to the Viewer Window

- Say "Show Message Viewer."

To navigate between Mailboxes

Say one of the following:

- "Go to Inbox"
- "Go to Drafts"
- "Go to Sent box"

Creating and deleting mailboxes

To create a new Mailbox

Say one of the following:

- "Make new Mailbox"
- "Make new Smart Mailbox"

To rename the selected Mailbox

- Say "Rename selected Mailbox."

To delete the selected Mailbox:

- Say "Delete this Mailbox."

Adjusting your view

- Say "New Viewer Window" to open a new Viewer Window.
- Say "Show / Hide Mailboxes" to toggle the Mailbox list view.
- Say "Show / Hide Toolbar" to toggle the Toolbar.
- Say "Zoom this window" to toggle Zoom view for the current window.
• Say "Arrange in front" to bring all Mail windows to the front.

Related topics:
• Working with email
• Menu Walking
• Navigating application windows
• Launching and quitting applications
• Working with webmail

Working with TextEdit

In this topic, learn how to use your voice to:

• Create a TextEdit document
• Navigate within a document
• Edit and format text
• Save a document
• Print a document
• Adjust your view

These commands are available when you are using TextEdit. Use the menu walking commands to access other TextEdit features. For example, say "Click File menu," then "Click Export as PDF."

Creating or open a document

With TextEdit active, do one of the following:

• Say "New file" to create a new document in TextEdit.
• Say "Open file" to access the Open dialog.

Navigating within your document

Move your cursor to a different point in your text with the standard navigation commands, such as:

• "Insert before <text>"
• "<Direction> arrow" (up, down, left or right)
• "Go to beginning / end"

See Navigating within a document for more information.

Finding text in your document

1. Say "Show Find window."
2. Say the word or phrase you want to search for.
3. Say "Find next / previous" to navigate search results.
4. Say "Go to next field" to return to the document.

Selecting text

Use the standard commands for making a selection, such as:

• "Select <text>"
• "Select All"
• "Select next / previous word"
• "Unselect that"

See Revising text for more information.

Editing your document
Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
- "Copy <text>"
- "Copy selection"
- "Paste from clipboard"
- "Delete <text>"
- "Delete selection"

See Revising text for more information.

**To paste text using the font formatting of the paste location**

- Say "Paste and match style."

### Formatting your document

You can use any of the standard commands to format or align text, such as:

- "Bold / italicize / underline that"
- "Make <text> bold / italic / underline"
- "Make selection bold / italic / underline"
- "Align the text left / center / right"

See Formatting for more information.

**To increase or decrease the font size**

- Say "Make selection bigger / smaller."

**To apply text spacing, such as indenting and Tabs, from one part of the text to another**

1. Place your cursor in the section of the text whose spacing you want to copy.
2. Say "Copy Text Ruler."
3. Move your cursor to the section of the text where you want to apply the Text Ruler.
4. Say "Paste Text Ruler."

### Saving your document

- Say "Save this document."
  
  Or
  
  Say "Show Save As window."

**To undo all your changes since the last time you saved**

- Say "Revert to last saved version."

### Printing your document

- Say "Print this document."

### Closing your document

- Say "Close file."

### Adjusting your view

- Say "Toggle Text Ruler" to show or hide the Text Ruler.
- Say "Toggle Fonts palette" to show or hide the Fonts palette.
To wrap text
  • Say "Wrap text to page."

To bring all TextEdit windows to the front
  • Say "Bring all windows to front."

To toggle Zoom view for the current window
  • Say "Zoom this window."

To close all TextEdit windows
  • Say "Close all windows."

Related topics:
  • Menu Walking
  • Navigating application windows
  • Launching and quitting applications

Working with Microsoft Word

In this topic, learn how to use your voice to:
  • Create a Word document
  • Navigate within a document
  • Edit and format text
  • Save a document
  • Print a document

The commands below are available when you are using Microsoft Word 2011 or 2016. Use the menu walking commands to access other Word features. For example, say "Click View menu, “ then “Click Web Layout.”

Note: You cannot dictate in tables. Add tables after you have finished dictating the main body of the document.

Creating a document

With Word active, do one of the following:
  • Say "New file" to create a new document in Word.
  • Say "Open file" to access the Open dialog.

Navigating within your document

Move your cursor to a different point in your text with the standard navigation commands, such as:
  • "Insert before <text>"
  • "<Direction> arrow" (up, down, left or right)
  • "Go to beginning / end"

See Navigating within a document for more information.

Selecting text

Use the standard commands for making a selection, such as:
  • "Select <text>"
  • "Select All"
  • "Select next / previous word"
  • "Unselect that"
See Revising text for more information.

Editing your document

Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
- "Copy <text>"
- "Copy selection"
- "Paste from clipboard"
- "Delete <text>"
- "Delete selection"

See Revising text for more information.

Formatting your document

Use the global commands to format the last word or phrase you spoke:

- "Bold / Italicize / Underline that"

To change the font size

Say "Set font size to <number> points."

To insert a page break

Say "Insert Page Break."

Saving your document

Say "Save this document."

Printing your document

Say "Print the document."

Closing your document

Say "Close file."

Related topics:

- Menu Walking
- Navigating application windows
- Launching and quitting applications

Working with Safari

In this topic, learn how to:

- Open a website in Safari
- Dictate text on in a website field
- Navigate between websites
- Navigate within a Web page
- Load a page
- Use Safari windows and tabs
- Add and edit bookmarks
- Use Auto Fill
- Share a Web page
- Print a Web page
- Adjust your view
Use these commands to browse the Internet using Safari. Use the menu walking commands to access other Safari features. For example, say “Click Edit menu,” then “Click Undo Close Tab.”

Make sure you install the Dragon Web Extension for Safari to access links and other Web controls with your voice.

**Opening a Web page**

1. Say "Do Web search" to select the URL bar in the current tab or window.
2. Dictate a Web address or search term.
   - For common domains, just say the name of the site (for example, "CNN"), and Safari will fill in the rest.
   - See [Email and Web addresses](#) for tips on dictating a Web address.
3. Say "Click Enter."
   The Web page opens.

**Entering text**

In general, if you can select a text field, you can dictate into that field. However, mixing dictation and typing may not be supported on all websites, so you should avoid using your keyboard while dictating. Sites that allow mixing typing with dictation include:

- Facebook
- Twitter
- Gmail
- Google Calendar
- Outlook.com
- Yahoo
- CNN
- YouTube
- EBa

See [Mixing dictation with typing](#) for information on how to avoid errors caused by mixing dictation and typing.

**Navigating between pages**

- Say "Jump back / forward" to go back or forward in your browser history.
- Say "Jump Home" to go to your homepage.
- Say "Jump to bookmark <1-9>" to go to a bookmark.

This command is only available for the first nine bookmarks in your Bookmark Bar.

**To switch between tabs**

- Say "Show next / previous tab."

**Navigating within a page**

**To scroll**

- Say "Scroll <direction>" or "Scroll one screen <direction>.

You can scroll up, down, left or right.

**To scroll to the top or bottom of the current page**

- Say "Scroll to top / bottom."

**To jump to the selected text on the current page**

- Say "Jump to selection."
To move between editable text fields
- Say "Move to next / previous text field."

Searching a website
To find specific text on a page
- Say "Show / Hide Find toolbar."
- Say "Use selection for Find" to open the Find dialog with the selected text in the search bar.
To navigate between instances of the search term
- Say "Find next / previous."

Loading pages
- Say "Reload this page" to reload the current page.
- Say "Stop loading this page" to stop a page from loading.

Using tabs
To create a tab
- Say "Make a new tab."
To close tabs
- Say "Close this tab" to close the current tab.
- Say "Close other tabs" to close all tabs except the one currently selected.
To move a tab into a new window
- Say "Move tab to new window."

Safari windows
To close all Safari windows
- Say "Close all windows."
To reopen Safari windows
- Say "Reopen last closed window" to reopen the last window you closed.
- Say "Reopen all windows from last session" to reopen all the windows that were open during your last session.
To bring all Safari windows to the front
- Say "Bring all windows to the front."
To merge all current Safari windows
- Say "Merge all windows."

Adding or editing Bookmarks
To show or hide the Bookmarks Bar
- Say "Show / Hide Bookmarks Bar."
To add a bookmark
- Say "Bookmark this page" to add a bookmark for the current page.
- Say "Access Add Bookmark window" to add a bookmark for the current page and change its name.
- Say "Add bookmarks for these tabs" to add bookmarks for all current tabs.
To show or hide the Bookmark Manager

- Say "Show / Hide All Bookmarks."

While using the Bookmark Manager, you can also say the following:

- "Add bookmark folder" creates a new folder in the bookmark collection.
- "Move to next cell" moves the cursor to the next editable cell.

To create a shortcut in Dragon for the current page

- Say "Create a command for this page."

Auto Fill

- Say "Auto Fill this form" to allow Safari to automatically fill in a form on a Web site.

Sharing a Web page

To email a Web page using your preferred email client, say one of the following:

- "Mail contents of this page"
- "Mail link to this page"

Printing

- Say "Print this document."

Changing your view

- Say "Show / Hide Status Bar" to toggle the Status Bar.
- Say "Show / Hide Tab Bar" to toggle the Tab Bar.
- Say "Show / Hide Toolbar" to toggle the Toolbar.
- Say "Show Downloads window" to show the Downloads window.
- Say "Zoom in / out" to change the text size.

History

- Say "Show all history" to view your browsing history.
- Say "Clear history" to erase your browsing history.
- Say "Private browsing" to browse the Internet without creating a history.

Related topics:

- Dragon Web Extensions
- Working with Firefox
- Working with webmail
- Menu Walking

**Working with Firefox**

The Dragon Web Extension for Firefox lets you navigate websites and use some Web applications, such as Gmail. You can also add a new tab or window, access bookmarks, or any other task available through Firefox's menus. For example, say "Click File menu," then "Click New Tab."

**Opening a Web page**

1. With the cursor in the address bar, dictate the Web address. For example, "w w w dot nuance dot com."
See Email and Web addresses for tips on dictating a Web address.

2. Say “Click Enter.”

The Web page opens.

**Dictating text**

In general, if you can select a text field, you can dictate into that field. However, mixing dictation and typing may not be supported on all websites, so you should avoid using your keyboard while dictating. Sites that allow mixing typing with dictation include:

- Facebook
- Twitter
- Gmail
- Google Calendar
- Outlook.com
- Yahoo
- CNN
- YouTube
- eBay

See Mixing dictation with typing for information on how to avoid errors caused by mixing dictation and typing.

**Related topics:**

- Dragon Web Extensions
- Working with Safari
- Working with webmail
- Menu Walking

**Working with Calendar**

In this topic, learn how to use your voice to:

- Create and delete events
- Change your view
- Search your calendars
- Back up your calendars

These commands are available when using Apple Calendar. Use menu walking commands to access other Calendar features. For example, say “Click View menu,” then “Click Make Text Bigger.”

**To create a new event**

- Say “Create new event.”

**To delete an event**

1. Select the event you want to delete.
2. Say “Delete selection.”

**To search Calendar**

- Say “Put focus in Find field” to search your events.
- Say “Scroll up / down” to move between search results.

**To refresh your calendars**

- Say “Refresh all calendars.”
To back up the selected calendar
   - Say "Access back up window."

Adjusting your calendar view

To change the time period shown
   - Say "Switch to <period> view."
     You can view the calendar by:
     - Day
     - Week
     - Month

To move to a different date
   - Say "Go to next / previous <period>.
     You can navigate to a new:
     - Day
     - Week
     - Month
     - Year
   - Say "Go to today."
   - Say "Go to date" to open a pop-up menu where you can select a specific date to view.

To show or hide all-day events on your calendar
   - Say "Show / Hide all-day events."

To show or hide events on a specific calendar
   1. Select the calendar in the Calendar List.
   2. Say "Show events on this Calendar."

Showing and hiding windows
   - Say "Show calendar" to show the main Calendar window.
   - Say "Bring all windows to front" to bring all open Calendar windows to the front.

To show or hide Calendar panels
   - Say "Show / Hide Notifications."
   - Say "Show / Hide Address Panel."

To toggle Zoom view for the current window
   - Say "Zoom this window."

Related topics:
   - Menu Walking
   - Navigating application windows
   - Launching and quitting applications

Working with Messages

When you are using Messages, you can send the message you just dictated by saying "Send Message."
Use menu walking commands to access other Messages features. For example, say "Click File menu," then "Click New Message."

Remember, in some applications, it's better not to use your mouse and keyboard while dictating text. See Mixing dictation with typing for more information, including a list of currently supported applications.

Related topics:
- Menu Walking
- Navigating application windows
- Launching and quitting applications
## Browse the web

Read these topics to learn how to use your voice to browse the Web.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dragon Web Extensions</strong></td>
<td>• Dragon Web Extension for Safari and Firefox</td>
</tr>
<tr>
<td><strong>Working with webmail</strong></td>
<td>• Dictating in webmail applications&lt;br&gt; • Using Gmail to:&lt;br&gt;</td>
</tr>
<tr>
<td><strong>Posting to Facebook and Twitter</strong></td>
<td>• Posting status updates to Facebook&lt;br&gt; • Posting to Twitter</td>
</tr>
<tr>
<td><strong>Working with Firefox</strong></td>
<td>• Opening a Web page&lt;br&gt; • Entering text</td>
</tr>
<tr>
<td><strong>Working with Safari</strong></td>
<td>• Opening a Web page&lt;br&gt; • Entering text&lt;br&gt; • Navigating the Web&lt;br&gt; • Navigating a Web page&lt;br&gt; • Loading a page&lt;br&gt; • Using Safari windows and tabs&lt;br&gt; • Adding and editing bookmarks&lt;br&gt; • Using Auto Fill&lt;br&gt; • Sharing a Web page&lt;br&gt; • Printing a Web page&lt;br&gt; • Adjusting your view</td>
</tr>
</tbody>
</table>

### Dragon Web Extensions

In this topic, learn how to:

- Install Dragon Web Extensions
- Upgrade Dragon Web Extensions
- Configure Dragon Web Extensions
- Disable or uninstall Dragon Web Extensions

If you want to use your voice to browse the Web, install the Dragon Web Extension for your preferred browser (Safari or Firefox).

These extensions give you access to:

- Commands that allow you to click Web page objects, like buttons and links, by voice.
- Dictating text in many Web page fields and Web applications.

Without the extension installed, you’ll need to use your mouse and keyboard to click Web page objects.

#### Installing Dragon Web Extensions

After installing Dragon, you will be prompted to install Dragon Web Extensions next time you use your browser. Just click the correct link for your browser, then follow the instructions.


### Upgrading Dragon Web Extensions
If you upgraded from a previous version of Dragon, you may need to update your Dragon Web Extensions. You can find all the latest Dragon Web Extensions here.

- **Safari users**: If you upgraded from Dragon Dictate 4, you will need to uninstall the old version to prevent conflicts. See Disabling or Uninstalling Dragon Web Extensions below for directions.
  
  Users upgrading from Dragon for Mac 5 do not need to uninstall or reinstall Dragon Web Extensions.

- **Firefox users**: Older versions of Dragon Web Extensions for Firefox will no longer work. Click the link above and follow the installation instructions.

### Setting up Dragon Web Extensions—Safari

When you first visit a website, you may see a pop-up message like this one:

![Dragon Web Extensions Pop-up Message](image)

Click Trust to allow Dragon to run on that site.

**To allow Dragon to run on all websites**

1. Go to the Safari menu and select Preferences.
2. Click the Security icon.
3. Make sure Allow Plug-ins is checked, then click Plug-in Settings…
4. Select Dragon Internet Plug-in in the left-hand panel.
5. In the When visiting other websites drop-down menu, select Allow or Allow Always.
6. Check the list of websites under Dragon Internet Plug-in.

   If you previously blocked any websites, they are listed under Configured Websites with the setting Block:
7. Click the drop-down menu for any blocked sites and select Allow.

8. Click Done.

Safari will now allow Dragon to run on all websites.

Setting up Dragon Web Extensions—Firefox

When you first visit a website, you may see a message like this at the top of your screen:

1. Click Allow to enable Dragon on the site.

A popup message like this appears:

2. To run the extension automatically next time you visit the website, click Allow and Remember.

To allow Dragon to run on all websites

1. In Firefox, click Tools > Add-ons.

   The Add-ons Manager opens.

2. Click Plugins in the panel on the left.

3. In the list of installed Plugins, find Dragon Internet Plug-In.

4. In the drop-down menu, select Always Activate.

Firefox will now allow Dragon to run on all websites.
Using Dragon Web Extensions to access links and other Web controls

To click a link or other website control

- Say "Click <name of control>.”

For example, “Click Home” would click a link called "Home," or "Click Password" would access a text field called "Password."

In many cases, the name of a control is clear (for example, the text of a link). If you’re not sure, many websites will show the name in a tooltip if you hover over the control.

You can access any of the following website controls by saying their name:
- Links
- Buttons
- Checkboxes
- Images
- Radio buttons
- Text fields
- List boxes

Generally, you do not need to say the entire name of a control because Dragon will click the control once it has a unique match. If there are multiple matches, Dragon will display numbers next to each matching field.

To show all controls

1. Say one of the following:
   - “Show links” or “Click links”
   - “Click button”
   - “Click checkbox”
   - “Click image”
   - “Click radio button”
   - “Click text field”
   - “Click list box”

   Numbers appear next to all controls of that type.

If there is only one control of that type, that control will be clicked.

2. Say "Choose <number>" to make a selection from the numbered controls.

To hide the numbers

If you don’t want to select a number, say one of the following to remove them:
- “Cancel”
- “Hide Numbers”

Disabling or Uninstalling Dragon Web Extensions—Firefox

To disable or uninstall Dragon Internet Extension

1. Click the Tools > Add-ons
   The Add-ons Manager opens in a new tab.
2. Click Extensions in the panel on the left.
3. Find Dragon Internet Extension.
4. Click Disable or Remove.

To disable Dragon Internet Plug-In
1. Click **Plugins** in the panel on the left.
2. Find **Dragon Internet Plug-In**.
3. Select **Never Activate** in the drop-down menu.

Disabling or Uninstalling Dragon Web Extensions—Safari

**To uninstall Dragon Dictate Web Extensions (v4)**

If you upgraded from Dragon Dictate v4, be sure to uninstall Dragon Dictate Web Extensions to prevent conflicts.

1. Click the **Safari** menu and select **Preferences**.
2. In the Preferences window, click the **Extensions** pane, and find **Dragon Dictate**.
3. Click the **Uninstall** button.
4. In the confirmation dialog, click **Uninstall** again.

**To disable or uninstall Dragon Web Extensions (v5 or later)**

1. Click the **Safari** menu and select **Preferences**.
2. In the Preferences window, click the **Extensions** pane, and find **Dragon**.
3. Uncheck **Enable Dragon**, or click the **Uninstall** button.

Related topics:
- Working with Safari
- Working with Firefox
- Troubleshooting Dragon Web Extensions
- Posting to Facebook and Twitter
- Working with webmail

Working with Safari

In this topic, learn how to:

- Open a website in Safari
- Dictate text on in a website field
- Navigate between websites
- Navigate within a Web page
- Load a page
- Use Safari windows and tabs
- Add and edit bookmarks
- Use Auto Fill
- Share a Web page
- Print a Web page
- Adjust your view

Use these commands to browse the Internet using Safari. Use the menu walking commands to access other Safari features. For example, say "Click Edit menu," then "Click Undo Close Tab."

Make sure you install the Dragon Web Extension for Safari to access links and other Web controls with your voice.

Opening a Web page

1. Say "**Do Web search**" to select the URL bar in the current tab or window.
2. Dictate a Web address or search term.
   - For common domains, just say the name of the site (for example, "CNN"), and Safari will fill in the rest.
3. Say "Click Enter."
   The Web page opens.

**Entering text**

In general, if you can select a text field, you can dictate into that field. However, mixing dictation and typing may not be supported on all websites, so you should avoid using your keyboard while dictating. Sites that allow mixing typing with dictation include:

- Facebook
- Twitter
- Gmail
- Google Calendar
- Outlook.com
- Yahoo
- CNN
- YouTube
- EBay

See [Mixing dictation with typing](#) for information on how to avoid errors caused by mixing dictation and typing.

**Navigating between pages**

- Say "Jump back / forward" to go back or forward in your browser history.
- Say "Jump Home" to go to your homepage.
- Say "Jump to bookmark <1-9>" to go to a bookmark.

*This command is only available for the first nine bookmarks in your Bookmark Bar.*

**To switch between tabs**

- Say "Show next / previous tab."

**Navigating within a page**

**To scroll**

- Say "Scroll <direction>" or "Scroll one screen <direction>."

*You can scroll **up**, **down**, **left** or **right**.*

**To scroll to the top or bottom of the current page**

- Say "Scroll to top / bottom."

**To jump to the selected text on the current page**

- Say "Jump to selection."

**To move between editable text fields**

- Say "Move to next / previous text field."

**Searching a website**

**To find specific text on a page**

- Say "Show / Hide Find toolbar."
- Say "Use selection for Find" to open the Find dialog with the selected text in the search bar.

**To navigate between instances of the search term**
● Say "Find next / previous."

Loading pages

● Say "Reload this page" to reload the current page.
● Say "Stop loading this page" to stop a page from loading.

Using tabs

To create a tab

● Say "Make a new tab."

To close tabs

● Say "Close this tab" to close the current tab.
● Say "Close other tabs" to close all tabs except the one currently selected.

To move a tab into a new window

● Say "Move tab to new window."

Safari windows

To close all Safari windows

● Say "Close all windows."

To reopen Safari windows

● Say "Reopen last closed window" to reopen the last window you closed.
● Say "Reopen all windows from last session" to reopen all the windows that were open during your last session.

To bring all Safari windows to the front

● Say "Bring all windows to the front."

To merge all current Safari windows

● Say "Merge all windows."

Adding or editing Bookmarks

To show or hide the Bookmarks Bar

● Say "Show / Hide Bookmarks Bar."

To add a bookmark

● Say "Bookmark this page" to add a bookmark for the current page.
● Say "Access Add Bookmark window" to add a bookmark for the current page and change its name.
● Say "Add bookmarks for these tabs" to add bookmarks for all current tabs.

To show or hide the Bookmark Manager

● Say "Show / Hide All Bookmarks."

While using the Bookmark Manager, you can also say the following:

● "Add bookmark folder" creates a new folder in the bookmark collection.
● "Move to next cell" moves the cursor to the next editable cell.

To create a shortcut in Dragon for the current page

● Say "Create a command for this page."
Auto Fill

- Say "Auto Fill this form" to allow Safari to automatically fill in a form on a Web site.

Sharing a Web page

To email a Web page using your preferred email client, say one of the following:

- "Mail contents of this page"
- "Mail link to this page"

Printing

- Say "Print this document."

Changing your view

- Say "Show / Hide Status Bar" to toggle the Status Bar.
- Say "Show / Hide Tab Bar" to toggle the Tab Bar.
- Say "Show / Hide Toolbar" to toggle the Toolbar.
- Say "Show Downloads window" to show the Downloads window.
- Say "Zoom in / out" to change the text size.

History

- Say "Show all history" to view your browsing history.
- Say "Clear history" to erase your browsing history.
- Say "Private browsing" to browse the Internet without creating a history.

Related topics:

- Dragon Web Extensions
- Working with Firefox
- Working with webmail
- Menu Walking

Working with Firefox

The Dragon Web Extension for Firefox lets you navigate websites and use some Web applications, such as Gmail. You can also add a new tab or window, access bookmarks, or any other task available through Firefox's menus. For example, say "Click File menu," then "Click New Tab."

Opening a Web page

1. With the cursor in the address bar, dictate the Web address. For example, "w w w dot nuance dot com."
   - See Email and Web addresses for tips on dictating a Web address.
2. Say "Click Enter."
   - The Web page opens.

Dictating text

In general, if you can select a text field, you can dictate into that field. However, mixing dictation and typing may not be supported on all websites, so you should avoid using your keyboard while dictating. Sites that allow mixing typing with dictation include:

- Facebook
Posting to Facebook and Twitter

Dragon can post updates to your Facebook and Twitter accounts using the Sharing feature of OS X.

You need to have your Facebook and Twitter accounts set up on your Mac to use this feature. Set up your accounts in the Internet Accounts pane of your System Preferences.

To post the last text you dictated or selected
1. Do one of the following:
   - Dictate text into a document.
   - Select specific text in a document.
2. Say "Post that to Facebook" or "Post that to Twitter."
   The OS X sharing window opens with the specified text entered.
3. Continue dictating or editing text in this window until you are happy with your post.
4. Say "Press Post."
   Dragon posts your status update or Tweet.

   If you don't want to post the text, say "Press Cancel."

To dictate text to post
1. Do one of the following:
   - Say "Post to Facebook <text>" or "Post to Twitter <text>.”
     The OS X sharing window opens with the specified text entered.
   - Say “Post to Facebook” or “Post to Twitter." 
     The OS X sharing window opens with no text entered.
2. Continue dictating or editing text in this window until you are happy with your post.
   Dragon posts your status update or Tweet.

   If you don't want to post the text, say "Press Cancel."
Related topics:

- Working with webmail
- Working with Mail
Make Dragon more accurate

Read these topics to learn how to teach Dragon to better understand the way you speak and the words you use.

Click:  

<table>
<thead>
<tr>
<th>To learn more about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing Dragon’s Vocabulary</td>
</tr>
<tr>
<td>● Using the Vocabulary Editor to:</td>
</tr>
<tr>
<td>○ View the vocabulary list</td>
</tr>
<tr>
<td>○ Add a vocabulary item</td>
</tr>
<tr>
<td>○ Edit a vocabulary item</td>
</tr>
<tr>
<td>○ Train a vocabulary item</td>
</tr>
<tr>
<td>○ Delete a vocabulary item</td>
</tr>
<tr>
<td>○ Export vocabulary</td>
</tr>
<tr>
<td>○ Import vocabulary</td>
</tr>
<tr>
<td>Vocabulary Training</td>
</tr>
<tr>
<td>● Training Dragon to recognize how you use words</td>
</tr>
<tr>
<td>Voice Training</td>
</tr>
<tr>
<td>● Training Dragon to understand how you speak</td>
</tr>
</tbody>
</table>

Editing Dragon’s Vocabulary

In this topic, learn how to use the Vocabulary Editor to:

- View the vocabulary list
- Add a vocabulary item
- Edit a vocabulary item
- Train a vocabulary item
- Delete a vocabulary item
- Export vocabulary
- Import vocabulary

Dragon comes with an extensive built-in vocabulary made up of all the words, numbers and symbols it can type for you in Dictation mode. As you use Dragon, it learns words and phrases that you use and adds them to the vocabulary for your profile. Dragon learns words when you:

- Use Correction to fix Dragon's mistakes.
- Use Vocabulary Training to teach Dragon how you use words.
- Use Transcription Training to improve Dragon's understanding of recorded text.

The Vocabulary Editor allows you to view and edit the list of words Dragon understands.

To open the Vocabulary Editor window

- Say “Edit Vocabulary.”
  Or
  - Click the icon in the menu bar and select Edit Vocabulary...

The Vocabulary list

When you first open the Vocabulary Editor, you see a list of all existing vocabulary items.

- Items marked with a icon are part of the built-in vocabulary.
- Items marked with a icon are User vocabulary items added as you use the product.

Use the drop-down menu at the top of the window to narrow the list of vocabulary shown:

- All
- Built-In
- User
Searching for vocabulary

Use the Search field to find specific vocabulary terms.

1. Click the icon in the search field to select the type of search:
   - Contains
   - Begins with
   - Ends with
2. Enter the search term.
3. Press Return or Enter.

Both the written and spoken forms are searched. For example, a Contains search for “dash” lists “balderdash,” because its written form contains “dash,” but also “—,” because its spoken form is “em-dash.”

If you do a search and no match is found, Dragon will give you the option to add the term to your User vocabulary. Click Yes to create a vocabulary item with your search term as the written form.

To empty the search field and display the full vocabulary list:

- Click the in the search field
- Press the Esc key when the search field has focus.

Adding a User vocabulary item

You can manually add words, short phrases, abbreviations, or other items to the User vocabulary for your profile.

1. Click the button at the bottom of the window.
   A popup panel appears.
2. Type the word, as written, into the Word field.
   **Example:** 21st
3. If the way the word is spoken is not identical to the way it is written (for example, abbreviations, numerals, or punctuation), enter the spoken form of the word into the Spoken field.
   **Example:** twenty-first
4. Click OK.

Editing a user vocabulary item

To edit an item in your User vocabulary:

1. Double-click the item in the vocabulary list.
   A popup panel appears, showing details about the selected vocabulary item.
2. Add or edit the spoken form if the item's written form differs from its pronunciation.
   You cannot edit the Word field. If there is a mistake in the written form of the word, create a new custom word and delete the incorrect vocabulary item. See "Deleting a User vocabulary item," below.
3. Click OK when you are finished.
   If you made any changes to the vocabulary item, a dialog box warns you that any recorded training for this word will be erased.
4. Click **OK** to save your changes.

---

**You can't edit built-in vocabulary items.**

---

**Training a vocabulary item**

If a vocabulary item is not being recognized correctly, you can train the Dragon to understand how you pronounce it.

1. Select the vocabulary item from the list.
2. Click the ✉ icon at the bottom of the list and select **Train**.
   
   A popup pane explains the training process.
3. Click **Train** to begin.
   
   The Vocabulary Training screen appears.
4. Say the word or phrase. The bar turns green when Dragon recognizes the word.
   
   A dialog box confirms that the training is complete.
5. Click **Close**.
   
   Dragon incorporates the recording into your voice model.

---

**Deleting a user vocabulary item**

1. Select the word in the vocabulary list.
2. Press the **Delete** key.
   
   A dialog box appears, confirming that you want to delete the item.
3. Click **OK** to proceed

---

**Exporting vocabulary items**

You can export user vocabulary items to share them with another profile. For example, if you are using Dragon in an office, you might have a specialized vocabulary you want to share with other users.

1. Select the item(s) you want to export from the vocabulary list.
2. Click the ✉ icon and select **Export**.
3. Name the file and decide where to store it.

   An XML file is created.

---

**Importing vocabulary items**

1. Click the ✉ icon and select **Import**.
2. Choose an exported XML file.

---

**Related topics:**

- Using Correction
- Vocabulary Training
- Transcription Training

---

**Voice Training**

Voice Training helps Dragon learn how you speak. Read aloud one of the available Voice Training stories. As you read, Dragon collects information about your speech – your individual accent, intonation, and tone. You can read as many of the stories as you want.
1. To open the Voice Training window, do one of the following:
   - Say "Show Voice Training window."
   - Click the 6 icon in the menu bar and select **Improve Recognition > Voice Training**.

   Dragon shows you a set of instructions for using Voice Training.

2. Click the **Next** arrow to select a story.

   Any stories you have already read are marked with an icon: 🌐.

3. Select a story, then click the **Next** arrow to move to the next panel.

4. Click the microphone button to turn the microphone on.

5. Begin reading the story slowly and in short phrases, pausing until Dragon recognizes your speech. The text turns green as it is recognized.

   If Dragon can't understand a passage, the text turns red. Try reading it again. If a particular word is not being recognized repeatedly, click **Skip Word**.

   After three or four pages of text, you will be able to read at a considerably more normal speed and in larger phrases.

   When you've reached the end of the story, or when Dragon has collected enough audio, the window changes to indicate that your training is being processed into the voice model. This will take a few minutes.

### Related topics:

- **Microphone Setup**
- **Microphone placement**
- **Troubleshooting audio and recognition**

### Vocabulary Training

Vocabulary Training allows you to teach Dragon how you use language. It analyzes your written documents to learn what words you use, how frequently you use them, and the context in which you use them.

**To open the Vocabulary Training window**

- Say "Show Vocabulary Training window."
- Click the 6 icon in the menu bar and select **Improve Recognition > Vocabulary Training**

**To select a file for Vocabulary Training**

Choose one or more documents written by you that reflect how you normally write. Documents can be in text (.txt and .rtf) or Microsoft Word (.doc, and .docx) format. Anything over 3MB in size should be divided into smaller size documents.

1. Click the **Add** button to browse to files, or drag files into the window.

   Click **Remove** to delete the selected file from the Training window.

2. Click the **Next** arrow when you have added all the files you want to analyze.

   Dragon analyzes your file(s) first to see if there are any words it doesn't know. When it's finished, Dragon displays a list of new words in the **Included** column.

3. To exclude a word, such as a typo, that you don't want to add to your vocabulary:
   1. Click on the word in the **Included** column.
   2. Click **Exclude**.

   The word moves to the **Excluded** column.
If Dragon does not find unknown vocabulary in the selected file, it informs you that all the words in the text are already in your vocabulary. You can still improve Dragon's accuracy by continuing the Vocabulary Training process.

4. Click the Next arrow when you are ready to proceed.

Dragon analyzes your writing samples. This may take a few minutes, depending on the size and number of files to be analyzed.

When the analysis is complete, a confirmation dialog box appears.

5. Click Done to exit the Vocabulary Training window.

If you added vocabulary items during the Vocabulary Training process, you can edit them in the Vocabulary Editor.

Related topics:
- Editing Dragon's Vocabulary
- Troubleshooting Vocabulary
Use email

Read these topics to learn how to use Dragon to create, dictate, and send email.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with email</td>
<td>• Open a new email addressed to anyone in your Contacts</td>
</tr>
<tr>
<td></td>
<td>• Work with popular email applications, including Microsoft Outlook</td>
</tr>
<tr>
<td>Working with Mail</td>
<td>• Creating new messages</td>
</tr>
<tr>
<td></td>
<td>• Navigating message text</td>
</tr>
<tr>
<td></td>
<td>• Editing and formatting text</td>
</tr>
<tr>
<td></td>
<td>• Sending a message</td>
</tr>
<tr>
<td></td>
<td>• Viewing messages and threads</td>
</tr>
<tr>
<td></td>
<td>• Printing a message</td>
</tr>
<tr>
<td></td>
<td>• Sorting and labeling messages</td>
</tr>
<tr>
<td></td>
<td>• Searching your mail</td>
</tr>
<tr>
<td></td>
<td>• Navigating Mailboxes</td>
</tr>
<tr>
<td>Working with webmail</td>
<td>• Dictating in webmail applications</td>
</tr>
<tr>
<td></td>
<td>• Using Gmail to:</td>
</tr>
<tr>
<td></td>
<td>• Send an email</td>
</tr>
<tr>
<td></td>
<td>• View an email</td>
</tr>
<tr>
<td></td>
<td>• Reply to or forward an email</td>
</tr>
<tr>
<td></td>
<td>• Delete an email</td>
</tr>
<tr>
<td></td>
<td>• Navigate between messages and folders</td>
</tr>
</tbody>
</table>

Working with email

Use Dragon to dictate emails in your favorite email application.

Creating a new message from anywhere on your Mac

Dragon can create email messages in Mail (or your default email application), pre-addressed to any person or group in your Contacts, no matter what application you are currently using.

Just say "Send an email to <name>." You can also specify multiple recipients – for example, "Send an email to Mom, Cindy and Patricia."

Dragon opens a new email window, addressed as specified, with the insertion point in the Subject line ready for you to dictate a subject.

To use this feature, you need to generate email commands in your Dragon preferences:

1. Click the \6 in the menu bar and select Preferences…
2. In the General pane, select Generate Email Commands.
3. Restart Dragon to generate commands for your contacts.

When you first launch Dragon, OS X generates a dialog box asking you to allow Dragon to access your contacts. To use email commands, you must click OK. If you click Don't Allow, you will need to uninstall and reinstall Dragon to reset Dragon's OS X permissions.

Working with email applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Supports dictating and typing?</th>
<th>Built-in commands included with Dragon?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple Mail</td>
<td>No.</td>
<td>Yes.</td>
</tr>
<tr>
<td></td>
<td>While dictating emails in Mail, avoid using your keyboard or mouse. See Mixing dictation with</td>
<td>See Working with Mail for more information.</td>
</tr>
</tbody>
</table>
### Application | Supports dictating and typing? | Built-in commands included with Dragon?
--- | --- | ---
Microsoft Outlook | Yes. | No. Use menu walking commands to access Outlook's menus. For example, say "Click Message menu," then "Click Reply." See [Menu Walking](#) for more information.
Gmail (accessed with Firefox) | Yes. | Yes. Install Dragon Web Extensions for Firefox to use these commands. See [Using Gmail](#) for more information.

**Other email applications**

You can use global commands such as menu walking in any application. However, Dragon may not offer correction and editing by voice in some applications. Check the Guidance window to see what Dragon can do in your current application. If you do not see the Guidance window, say "Show Guidance." See [Mixing dictation with typing](#) for more information.

#### Related topics:
- [Working with Mail](#)
- [Working with webmail](#)
- [Navigating application windows](#)
- [Launching and quitting applications](#)

### Working with Mail

In this topic, learn how to use your voice to:
- Create new messages in Mail
- Navigate message text
- Edit and format text
- Send a message
- View messages and threads
- Print a message
- Sort and label messages
- Search your mail
- Navigate Mailboxes

The commands below are available when you are using Apple Mail. Use the menu walking commands to access other Mail features. For example, say "Click Message menu," then "Click Add Sender to Contacts."

Remember, in some applications, it's better not to use your mouse and keyboard while dictating text. See [Mixing dictation with typing](#) for more information, including a list of currently supported applications.

### Creating a new message

- Say "New message" to compose a new message from scratch.

### To reply to the selected message

Say one of the following:
- "Reply to this message"
To forward the selected message

Do one of the following:

- Say "Forward this message" to forward the whole message.
- Say "Forward selection" to forward a selected portion of the message.
- Say "Redirect this message" to send the message directly to a new recipient.

To resend the selected message

- Say "Send this message again."

Navigating within your message

Move your cursor to a different point in your text with the standard navigation commands, such as:

- "Insert before <text>"
- "<Direction> arrow" (up, down, left or right)
- "Click next / previous field"

See Navigating within a document for more information.

You can also say any of the following in Mail:

- "Move to beginning / end of message"
- "Move up / down one paragraph"
- "Move left / right one word"
- "Move to beginning / end of this line"
- "Move left / right one character"

Selecting text

Use the standard commands for making a selection, such as:

- "Select <text>"
- "Select All"
- "Select next / previous word"
- "Unselect that"

See Revising text for more information.

You can also say any of the following in Mail:

- "Extend selection left / right one character"
- "Extend selection to beginning / end of line"
- "Extend selection up / down one line"
- "Extend selection to end of paragraph"
- "Extend selection up / down one paragraph"
- "Extend selection to beginning / end of message"
- "Extend selection to end of window"

Editing your message

Use the standard commands for revising your text, such as:

- "Cut <text>"
- "Cut selection"
• "Copy <text>"
• "Copy selection"
• "Paste from clipboard"
• "Delete <text>"
• "Delete selection"

See Revising text for more information.

You can also say any of the following in Mail:

• "Paste as quotation"
• "Paste and match style"
• "Append selected messages"
• "Check spelling"

Formatting text

You can use the global commands to format the last word or phrase you spoke:

• "Bold / Italicize / Underline that"

You can also say any of the following:

• Say "Make selection bigger / smaller" to increase or decrease the font size by one point.
• Say "Increase / decrease quote level" to format the selected text as a quote and increase or decrease the quote level:

```
First level
Second level
Third level
```

If you want to apply formatting from one section of text to another:

1. Select the formatted text.
2. Say "Copy style of selection."
3. Select the text where you want to apply the formatting.
4. Say "Paste style."

Sending your message

• Say "Send message."

Navigating messages and threads

To scroll within a message or thread

• Say "Move up / down one page."

To toggle viewing threads in the Mailbox pane

Say one of the following:

• "Expand / Collapse this thread"
• "Expand / Collapse all threads"

To move between messages

• Say "Go to next / previous message."

To view your selected message or thread in the Mailbox

• Say "Jump to selection."
To check for new messages
  • Say "Get new mail."

Printing a message
  • Say "Print this document."

Managing your messages

To sort your messages
  • Say "Sort by <property>.">

You can sort messages by:
  • Attachments
  • Date Received
  • Date Sent
  • Flags
  • From
  • To
  • Subject
  • Size

To label the selected message
  • Say "Mark as <status>.">

You can mark messages as:
  • Flagged
  • Unflagged
  • High Priority
  • Low Priority
  • Normal Priority
  • Junk Mail
  • Read
  • Unread

To delete the selected message
  • Say "Delete selection."

To clear deleted or junk messages

Say one of the following:
  • "Erase deleted messages in all accounts"
  • "Erase deleted messages on my Mac"
  • "Erase Junk Mail"

Searching your messages

To search the text of the current message
  1. Do one of the following:
     • Say "Access Find window."
     • With text selected in the current message, say "Use selection for Find."
  2. Dictate the word or phrase you want to search for.

To search your Mailbox
  1. Say "Find in selected mailboxes."
2. Dictate the word or phrase you want to search for.
3. Say "Find Next / Previous" to switch between Find results.

Navigating your mailboxes

To switch to the Viewer Window

- Say "Show Message Viewer."

To navigate between Mailboxes

Say one of the following:
- "Go to Inbox"
- "Go to Drafts"
- "Go to Sent box"

Creating and deleting mailboxes

To create a new Mailbox

Say one of the following:
- "Make new Mailbox"
- "Make new Smart Mailbox"

To rename the selected Mailbox

- Say "Rename selected Mailbox."

To delete the selected Mailbox:

- Say "Delete this Mailbox."

Adjusting your view

- Say "New Viewer Window" to open a new Viewer Window.
- Say "Show / Hide Mailboxes" to toggle the Mailbox list view.
- Say "Show / Hide Toolbar" to toggle the Toolbar.
- Say "Zoom this window" to toggle Zoom view for the current window.
- Say "Arrange in front" to bring all Mail windows to the front.

Related topics:
- Working with email
- Menu Walking
- Navigating application windows
- Launching and quitting applications
- Working with webmail

Working with webmail

In this topic, learn how to:
- Dictate in webmail applications
- Use Gmail to:
  - Send an email
  - View an email
  - Reply to or forward an email
• Delete an email
• Navigate between messages and folders

Install Dragon Web Extensions for your browser (Safari or Firefox) to access buttons, links, and other controls by voice in most webmail applications. For example, say "Click send" to click the Send button on your current page. See Dragon Web Extensions for more information.

Dragon allows you to dictate into virtually any webmail application. On some websites, including Gmail and Outlook.com, Dragon allows you to use your keyboard while dictating. Check the Guidance window for information about what Dragon can do in your current text field. See Mixing dictation with typing for more information.

Using Gmail

Using Firefox with Dragon Web Extensions, you can also use your voice to control Gmail.

Below are some of the more common email tasks. You can also access most of the controls in Gmail by saying "Click <button>.

Some control names may overlap: for example, the Inbox link and the Back to Inbox button are both available if you are viewing a message from the Inbox. In this case, if you say "Click Inbox," Dragon shows numbers next to each matching control. Say "Choose <number>" to select the one you want.

Composing a new email

1. Log in to Gmail.
2. Say "Click Compose." A new email appears.
3. Dictate the email address in the Recipients field.
   See Email and Web addresses for tips on dictating an email address.
4. To move to the Subject field, do one of the following:
   • Say "Click Subject."
   • Say "Click Text Field," then say "Choose <number>."
5. Dictate the subject line.
6. To move to the Body field, say "Click Text Field," then say "Choose <number>."
7. Dictate your email message.
8. To send your email, say "Click Send."

Opening an email

Do one of the following:
• Say "Click Link," and then say "Choose <number>."
• Click the message to open it.

Replying to an email

With an email open:
1. Say "Click Reply" or "Click Reply All."
2. Dictate your reply.
3. Say "Click Send."

Forwarding an email

With an email open:
1. Say "Click Forward."
2. Dictate an email address in the **Recipient** field.
3. To move to the **Body** field, say "**Click Text Field,**" then say "**Choose <number>,**".
4. Dictate any text you want to add to the forwarded message.
5. Say "**Click Send.**"

### Deleting an email

With an email open:
- Say "**Click delete.**"

With an email draft open:
- Say "**Click discard draft.**"

### Navigating Gmail

- Say "**Click Inbox**" to return to the Inbox.
- Say "**Click <folder name>**" to view messages in a different folder.
- Say "**Newer**" to move to the next newest message.
- Say "**Older**" to move to the next oldest message.

### Related topics:
- [Dragon Web Extensions](#)
- [Working with email](#)
- [Working with Mail](#)
- [Working with Safari](#)
- [Working with Firefox](#)
AutoTexts

Read these topics to learn how to create and use AutoTexts to insert commonly used text into your documents.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-text commands</td>
<td>• Why you should use Auto-text commands</td>
</tr>
<tr>
<td></td>
<td>• How to create Auto-text commands</td>
</tr>
<tr>
<td></td>
<td>• How to insert Auto-text into a document</td>
</tr>
<tr>
<td>Using fields with Auto-text commands</td>
<td>• When to use fields in an Auto-text command</td>
</tr>
<tr>
<td></td>
<td>• Setting up fields in Auto-text commands</td>
</tr>
<tr>
<td></td>
<td>• Navigating fields in a document</td>
</tr>
</tbody>
</table>

Auto-text commands

Auto-text commands are custom voice commands for inserting specific text into a document.
To use Auto-text commands, say the name of the command (for example, "Add my address") while dictating a document. Dragon inserts the text into your document at the location of the cursor.

Why you should use Auto-text commands

Use Auto-text commands for content you re-use frequently in your documents. They save time and effort, and reduce errors. Typical uses include:

- If you write a lot of business letters, use an Auto-text command to insert your address.
  
  Here's an example
  
  Create a command called "Add location" and define its content to include an address you use in emails.
  
  Start your email and say "Add location" and Dragon will insert this:
  
  221B Baker St.
  Marylebone, London NW1 6XE, UK

- If your work involves creating reports in a certain format, use an Auto-text command to insert a template of details you need to include.
  
  Here's an example
  
  Create a command called "Describe property" and define its content as a list like the one shown below.
  
  Open your document and say "Describe property" and Dragon will insert this:
  
  Property assessed:
  Location:
  Name on deed:
  Year built:
  Square footage:
  Structure value:

- If you have a template with variable fields, like a mailing list, use an Auto-text command that inserts a template of those fields. You can even specify default values.
  
  Here's an example
  
  Create a command called "List member" and define its content as a label layout that uses fields for the address details, like in the example below.
  
  To start entering the addresses, open your document and say "List member" and Dragon will insert this:
  
  To:
  
  [first] [last]
Creating an Auto-text command

1. Click the icon in the menu bar and select Add New Auto-text…

The Quick Auto-text window appears.

2. Fill in the fields:
   - **Auto-text Name**: Enter what you say to run the command.
     Choose a phrase that is easy to remember but not likely to be used in normal dictation. Do not include numerals, special characters, or spaces before or after the text.
     
     **Important**: To avoid misrecognition and conflicts with existing commands, it is important that you choose a name that is at least two words. Avoid words such as "that," "one," "two," etc.

   - **Auto-text Description** (Optional): Enter a brief description of what the command does.

   - **Auto-text Contents**: Enter the text you want Dragon to insert when you use this command.

3. Click **Create** to save your Auto-text.

Alternatively, you can use the Commands window to create Auto-text commands.

   1. Click the icon in the menu bar and select Show Commands…
   2. Select **Auto-text** in the context list.
   3. Click the button at the top of the window.
   4. In the popup panel, fill in the **Spoken Phrase**, **Description** (optional) and **Text** fields.
   5. Click **Save**.

Editing an Auto-text command

1. Click the icon in the menu bar and select Show Commands…

2. Select **Auto-text** from the list.

   All Auto-text commands appear to the right of the context list.

3. Double-click the command you want to edit.

   The command editor popup window appears.

4. Make any changes needed.

5. Click **Save**.

For more information about editing commands, see **Editing a custom command**.

Related topics:

- **The Commands window**
- **Using fields with Auto-text commands**

Using fields with Auto-text commands

Add fields to the content of an Auto-text command to hold the place of information that varies from one document to another.

For example, you could use fields for:
Each element of an address on a mailing label
The recipient’s name in a form letter
Cost breakdowns or surcharges in an invoice

Setting up your fields

In your Auto-text content, enter square brackets to indicate a text field.

<table>
<thead>
<tr>
<th>Text field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank text field – empty brackets noting a text field to be filled in</td>
<td>Dear [],</td>
</tr>
<tr>
<td>Named text field – brackets containing a placeholder describing the text field</td>
<td>Dear [name],</td>
</tr>
<tr>
<td>Default text – brackets containing a default value for the text field</td>
<td>Dear [customer],</td>
</tr>
</tbody>
</table>

Navigating fields and specifying their values

When you insert your Auto-text into a document, you see your text fields marked by brackets.

**Example:**

[first] [last]
[street]
[city], [state] [zip]
[United States]

**To fill in the text fields**

1. Select a text field:
   - Say "First input field" to jump to the first text field.
   - Say "Next / previous input field" to jump between text fields.
   Dragon highlights the contents of the text field, including the brackets.

2. Do one of the following:
   - Dictate the text you want to enter in its place.
     **Example:** With [first] selected, say "James."
   - Say "Accept default" to use the default value entered.
     **Example:** With [United States] selected, say "Accept default."

Dragon replaces the contents of the text field with what you dictated (or the default text), and no longer considers it an input field.

When you are done, the example Auto-text will look something like this:

James Smith
123 Main St.
Springfield, MA 01111
United States

**Related topics:**
- [Using fields with Auto-text commands](#)
Manage Dragon Commands

Read these topics to learn how to use commands to customize Dragon.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn about:</th>
</tr>
</thead>
</table>
| **The Commands window**        | • How to access the Commands Manager  
• How to search for a command  
• How to view details about a command  
• How to edit custom commands  
• How to deactivate or delete a command |
| **Create a command**           | • Creating custom commands to access:  
  • Websites  
  • Files or Folders  
  • Menu Items  
  • Keystrokes  
  • Applications |
| **Import and export commands** | • Exporting a Command Set  
• Importing a Command Set |

**The Commands window**

In this topic, find out how to:

• View the commands list  
• View command details  
• Edit a command  
• Deactivate a command  
• Delete a command

To open the Commands window, click the icon in the menu bar and select Show Commands...

**Viewing the commands list**

Commands are organized by the context in which they are available (globally or in a specific application).

Click the name of the context in the list to view the commands available in that context. Commands are listed alphabetically.
To return to the contexts list

In the path at the top of the Commands window, click **Commands**:

To filter commands

- Select an option in the dropdown menu at the top of the screen to filter commands by how they were created:
  - **All**—Show all commands in the selected context.
  - **Built-in**—Show only the commands that come with Dragon.
  - **User**—Show only custom commands you created.

- Use the **Search** field to view only commands in each context that contain a particular word or phrase.

Viewing command details
Double-click a command to open the command details popup panel. The panel shows information about the selected command, including:

- **Command name**: What you say to access the command
- **Command description**: A brief description of what the command does
- **Context**: When the command is available
- **Type**: The type of command
- **Command details**: The script or other content of the command.
  The information shown varies based on the command type.
- **Active** checkbox: Whether the command is available to use

### Creating a custom command

Click the button at the bottom of the panel to create a new command.

See [Create a command](#) for more information.

### Editing a custom command

1. Double-click a User command to open the command details popup panel.
2. Edit the fields as needed.
3. Click **Save**.
   The command details popup panel closes.

You can't edit a built-in command.

### Deactivating a command

1. Double-click a command to open the command details popup panel.
2. Deselect the **Active** checkbox.
3. Click **Save**.
   The command details popup panel closes.

Deactivated commands are grayed out in the Commands list. You cannot issue a deactivated command, but it can be reactivated later if needed. Deactivating unused commands can be useful if you're certain you don't need them.

### Deleting a custom command

1. Select a command from the list.
2. Press the Delete key.
   Or
   Click the icon and select **Delete Command**.

You can't delete a built-in command.

### Related topics:

- [Create a command](#)
- [Import and export commands](#)
- [Auto-text commands](#)
Create a command

In this topic, learn how to create custom commands to:

- Access a website
- Open a specific files or folders
- Access menu items in a specific application
- Use keyboard shortcuts
- Open an application
- Perform a variety of more complex actions (scripting knowledge required)

What are custom commands?

Custom commands allow you to make Dragon work better for you. For example, you might create a command to:

- Access your favorite website.
- Open a frequently used document.
- Quickly access a frequently used menu item in an application.
- Perform a keyboard shortcut in an application.

You can also add Auto-text commands to quickly insert frequently-used text. See Auto-text commands for more.

Creating a custom command

1. Click the **Show Commands** icon in the menu bar and select **Show Commands**…
   Or
   Say “**Show Commands window.**”

   The Commands window opens.

2. Click the button at the top of the window.

   The new command panel opens.

3. Enter the **Spoken Phrase** you want to use to trigger the command.

   **Important**: To avoid misrecognition and conflicts with existing commands, it is important that you choose a name that is at least two words. Avoid words such as “that,” “one,” “two,” etc.

4. Optionally, enter a brief command **Description**.

5. Select the **Context** where you want to use the command.

To create a new context:
1. Click Choose…
2. Browse to an application on your hard drive and select it.
3. Click Open.

6. Select the **Type** of command you want to create.

The fields you see in the panel vary based on the command type you choose.

### Menu Item

A Menu Item command selects a specified item in the menu bar of a specified application.

To create a Menu command:

1. Select **Menu Item** in the **Type** dropdown, even if it is already selected, to load the **Select a menu item** dropdown with the menu options for the selected context.

   **Note:** If the application you chose as the context is not currently running, the Launch Context… button may appear. Click the button to load the menu options for the application.

2. Open the dropdown to see the menus of your selected context (application).
3. Click the menu and submenus (if needed), then select the item.
   Your selection appears in the **Menu** field.
4. Click **Save**.

Here’s an example

While using Microsoft Word, saying “Add link” selects the menu item Hyperlink… in the **Insert** menu:

![Menu Item Example](image)

You can access menus in any application by saying “Click <menu name> menu.” However, you can save time by creating custom Menu Item commands for frequently used items.

**Tip:** Use Menu Item commands to access iTunes scripts with Dragon. Just select **Script** from the dropdown menu and find your script in the submenu.

### Keystroke

A Keystroke command accesses a keyboard shortcut on your Mac or in a specific application.

To create a Keystroke command:

1. Select **Keystroke** in the **Type** dropdown.
The Keystroke list appears.

2. Click + to add a keystroke to the list.

3. To the right of the Keystroke list, type the key you want to use into the Key field, or select a special character from the dropdown.

4. Select the modifier keys you want to use.

5. Click Save.

Here’s an example

While using Microsoft Excel, saying “New workbook” activates ⌘ N, the keyboard shortcut for creating a new workbook:

You can access any keyboard shortcuts using key commands, such as “Press the key combo Command N.” However, you can save time by creating custom Keystroke commands for frequently used shortcuts.

### Bookmark

A Bookmark command jumps to a URL in your default browser.

To create a Bookmark command:

1. Select Bookmark in the Type dropdown.
   - The URL field appears.
2. Paste the URL you want to access into the text field.
3. Click Save.

Here’s an example
Saying "Jump to Nuance" opens the URL http://www.nuance.com/index.htm in the default browser:

You can also create a Bookmark command by saying "Create a command for this page" while browsing with Safari.

File or Folder
A File or Folder command opens a specified file in its default application, or a folder in the Finder.

To create a File or Folder command:

1. Select File or Folder in the Type dropdown.
   The Target Path field appears.
2. Click Choose Target
   The Open dialog appears.
3. Select the file or folder, then click Select Target.
   The path to the selected file or folder appears in the Target Path field.
4. Click Save.

Here's an example

Saying "Open Budget file" opens a file called Budget2016.xlsx:
An Application command launches a specified application.

To create an Application command:

1. Select **Application** in the **Type** dropdown.
   
The **Application Name** field appears.
2. Click **Choose Application** to select an application.
   
The Open dialog appears.
3. Select an application and click **Select Application**.
4. Click **Save**.

Here's an example

Saying “Show calculator” opens the Calculator application:
By default, Dragon will generate commands to launch all your applications. However, if you prefer to deselect that option in the Advanced Preferences pane, you can create your own command to access a frequently used application.

Advanced commands
Users with coding knowledge can create more complex custom commands to perform a wide variety of tasks.

Click for details

**AppleScript**
The AppleScript command type is the most flexible, offering users familiar with the scripting language fine control over a wide variety of tasks.

1. Select **AppleScript** from the **Type** dropdown.

   An AppleScript script editing environment appears.

2. Enter your script in the **Source** field: you can compile and run it right in the Commands Manager.

Many built-in Dragon commands are AppleScript commands. For example, the command to the right is the built-in command to close the current file.

**Automator Workflow**
If you have an Automator Workflow file, you can create a command to execute it. For example, if you made a workflow to resize photos, you can create a command to trigger that workflow by saying "Resize photos."

1. When you select **Automator Workflow** in the **Type** dropdown.

   The **Workflow location** field appears.

2. Drag the workflow file to the field, or enter the path to its location.

**Shell Script**
You can use shell script commands to perform a variety of tasks. The script should begin with a "shebang" line (e.g. #!banshee).

1. Select **Shell Script** in the **Type** dropdown.

   A Shell Script editing environment appears.

2. Enter the script you want to execute.

   For example, enter `open -a safari` to create a command that launches.

Running a shell script does not open the Terminal, and there is no means of viewing output. You should generally create and test your shell scripts elsewhere before adding them to Dragon.
Import and export commands

Whether you have a new computer, use Dragon on multiple devices, or want to share custom commands with a colleague, importing and exporting commands can be a useful tool.

To begin importing or exporting commands, open the Commands windows by clicking the ☰ icon in the menu bar and selecting Manage Commands...

Exporting commands

1. Click the ☰ icon at the top of the Commands window and select Export Command(s)...
2. In the Command Export window, check the context(s) you want to export, or click the arrow next to a context to view and select individual commands.
3. Click Export...
4. Name the Exported Command Set and click Save.
5. Dragon prompts you to save
Trigger Terms for the Exported Command Set.

By default, this file will use the name of the Exported Command Set plus "- Terms" (for example, MyCommands-Terms).

6. Click **Save**.

You should see a message from Dragon confirming that the commands export was successful.

**Importing commands**

1. Click the **import** icon at the top of the Commands window and select **Import Commands**…

2. Browse to the Command Set you want to import. It should have the file extension .commandstext.

3. Click **Select Command Set**.

   Dragon prompts you to select the Trigger Terms for the Command Set.

4. Select the Trigger Terms file. It should have the file extension .dynamictext.

5. Click **Select Trigger Terms**.

   You should see a message from Dragon confirming that the command import was successful.

**Related topics:**
- The Commands window
- Create a command
Troubleshooting

Read these topics if you are having problems using Dragon Professional Individual for Mac.

<table>
<thead>
<tr>
<th>Click:</th>
<th>To learn:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting overview</td>
<td>If you are having trouble using Dragon, start with these general steps to determine the cause of the problem.</td>
</tr>
</tbody>
</table>
| Troubleshooting audio and recognition | - What to do if Dragon does not detect an audio signal  
- What to do if your audio quality is poor  
- What to do if your recognition is poor |
| Troubleshooting Vocabulary | - What to do if you can't add documents to Vocabulary Training |
| Troubleshooting Commands | - What to do if your custom commands are not working |
| Issues with Upgraded Profiles | - What to do if your Dragon Dictate 4 or Dragon for Mac 5 profile does not upgrade correctly  
- Where to find upgraded Transcription profiles |
| Uninstall Dragon Professional Individual for Mac version 6 | - How to uninstall Dragon  
- How to remove Dragon's data from your hard drive |

**Troubleshooting overview**

In this topic, learn what to do if you have problems such as:

- Recognition is poor  
- Cursor is jumping to the wrong place  
- Dragon is only responding to commands  
- Dragon does not detect any audio  
- Commands are not working  
- Correction is not working  
- Dragon is not working in my Web browser  
- Dragon menu is not showing in the menu bar  
- Dragon is unresponsive

If you are having trouble with Dragon, find the type of problem you are having below, then try the tips and links to resolve the issue.

If you need help getting started with Dragon, see [Getting started with dictation](#) and [FAQs](#) for tips.

**Recognition is poor**

Have you gotten better results from Dragon in the past?

Yes:

1. Make sure you have selected the correct profile.
   1. Click the ![Dragon icon](#) in the menu bar and make sure a check mark appears next to your profile in the Recent Profiles list.
   2. If a different profile is selected, click your profile to load it, then try again. See [Switching profiles and dictation sources](#) for more information.
2. Are you in a different environment than usual? Background noise can decrease accuracy. Try moving to a quieter environment and see if the recognition improves.
3. Try running Microphone Setup again.
1. Click the 📕 icon in the menu bar and select Improve Recognition > Microphone Setup…
2. Follow the on-screen instructions to complete Microphone Setup. See Microphone Setup for more information.
3. If Dragon is not responding to any audio input, try these steps:
   1. Check the microphone mode. Dragon can only hear audio when the Microphone button in the Status Window is green ( микрофон). For more information, see Microphone modes.
   2. Make sure that you're not in Transcription mode. Dragon cannot hear you when you are transcribing audio. When you are finished using transcription, click Switch to Dictation. See Transcribing recorded audio for more information.
   3. Make sure your microphone is working properly. See No audio signal for steps to test your microphone.

No audio detected

- If Dragon is responding to commands, but not dictation, you may be in the wrong recognition mode. Check the Recognition mode indicator in the Status Window. If you are in Command mode, you will see the 📌 icon. In Command mode, Dragon is only listening for commands. When dictating text, you should generally use Dictation mode 📝. For more details, see Recognition modes.
- If you are in the correct mode, make sure your cursor is active in a word processing application or a text field. If your cursor is not blinking:
  - Click on the application or text field you want to dictate into.
  - Say “Activate <application>” to bring the application to the front.

Are you having trouble with a specific word?

If you are having trouble with recognition of specific words, you can teach Dragon to understand how you pronounce those words. See Training a vocabulary item for more information.

Cursor is jumping to the wrong place

In some applications, typing and dictating in the same document causes Dragon to lose track of where the cursor is. To resolve cursor issues in the current document, say “Cache document” to allow Dragon to read the contents of the document and learn its current content.

Be aware that after caching a document, you can no longer use Correction on your previously dictated text.

For best results, dictate into a fully supported application such as Word 2016, TextEdit, or Pages. See Mixing dictation with typing for more information, including an up-to-date list of supported applications.
Commands are not working

Are you using a custom command?

Yes:

- See Troubleshooting Commands for tips on solving the problems with your custom commands.

No:

1. Check your Recognition mode in the Status Window. To use commands, you should be in Dictation mode ( or Commands mode ). See Recognition modes for information about changing Recognition modes.

2. If you are in Dictation mode, make sure you pause briefly before and after you issue a command. If you don’t pause, Dragon may transcribe the command as dictated text. See Using commands in Dictation mode for more information.

3. Make sure the command you are trying to use is available in the current context. See The Commands window for more information.

4. If the command you are trying to use is not available in the context you are in, try using a different type of command, such as menu walking, to get the result you need. See Menu Walking for more information.

Correction is not working

If you are using an application that is not supported by Dragon, you may not have access to features such as Correction. Check the Guidance window for information about what Dragon can do in your current application. See Mixing dictation with typing for more information.

Even if you are using a fully supported application, be aware that Correction is also not available for Transcription files. You can edit transcribed text by voice, but Dragon does not have access to the audio required to use Correction. See Editing a transcribed file for more information.

If you selected Always Show Correction Window When Dictating in the Advanced Preferences panel, the Correction window displays a warning when Correction is not available. See Preferences window: Advanced pane for more information.

Dragon is not working with my Web browser

Are you using Firefox or Safari?

No:

Currently, Dragon offers Web extensions only for Firefox and Safari. If you wish to use a different browser, you can access some Dragon functions:

- You can dictate into most text fields, but you may not have access to correction or editing by voice. Check the Guidance window for information about what Dragon can do in the selected text field. See Mixing dictation with typing for more information.

- You can use menu walking commands to access functionality built into the browser. For example, say "Click File menu," then say "Click New Tab." See Menu Walking for more information.

You cannot use your voice to access links, buttons, or other Web page features. If you need access to these features, use Safari or Firefox instead.

Yes:

1. Make sure you have installed Dragon Web Extensions for your current browser.

2. Make sure you have the latest version of your browser.

3. See Troubleshooting Dragon Web Extensions for more details.
Dragon menu is not showing in the menu bar

If you have a small screen and many items in the menu bar, Dragon can get squeezed out. Things you can do:

- Set Dragon to launch at startup so it loads earlier and appears closer to the right of the menu bar.
- If you have Fast User Switching on, go to System Preferences > Users & Groups and click Login Options at the bottom of the left-hand panel. Set Show fast user switching menu as to Icon, or turn it off entirely.
- In System Preferences, turn off menu bar icons for Bluetooth, mirroring options (in the Displays pane), or Time Machine.

Auto Sleep is not working

In order for the microphone to automatically go into Sleep mode, Dragon must detect no sound input for the time period specified in the Preferences pane (by default, 1 minute). See General Preferences pane for more information.

If your microphone is very sensitive, it may be detecting too much background noise, which Dragon could interpret as audio input. Try running Microphone Setup and manually adjusting the audio input level (gain). See Microphone Setup for more information.

Dragon is not responding

If Dragon is not responding and you are not able to quit through the Dragon menu:

1. Launch Activity Monitor from the Applications/Utilities folder on your Mac.
2. Scroll through the list or search for Dragon.
3. Select Dragon in the list.
4. Click the button at the top left.

Related topics:

- FAQs
- Troubleshooting audio and recognition
- Troubleshooting Dragon Web Extensions
- Troubleshooting Commands
- Troubleshooting Vocabulary

Troubleshooting audio and recognition

In this topic, learn:

- What audio devices are supported
- What to do if Dragon does not detect an audio signal
- What to do if your audio quality is poor
- What to do if your recognition is poor

Supported Devices

A complete list of Nuance-supported devices is available at http://support.nuance.com/compatibility/default.asp. If your microphone is not on this list, Nuance cannot guarantee that it will work with Dragon.

Also keep in mind the following:

- All iMac and MacBook computers have excellent built-in microphones. Nuance encourages users to dictate using the internal microphone where possible.
- USB devices must be plugged directly into your computer. USB hubs are not supported.
- To use a Bluetooth audio device, you must have a USB adapter (dongle). The audio quality of the built-in Bluetooth receiver is too low.
• Be aware that older devices, such as analog devices with two 1/8 inch jacks, are likely to cause more audio problems than an internal or USB device.

No audio signal
If Dragon is unable to hear you speak, try these steps to solve the problem.

Check your microphone mode
Make sure that your microphone is turned on; the microphone button in the Status Window should appear green (●).

• If the button is red (●), your microphone is off. Click the button to turn the microphone on.

If the microphone button does not turn green, your microphone may not be properly connected. See "Check your connection," below.

• If the button is blue (●), the microphone is in sleep mode. Say "Wake up" to turn it on.

See Microphone modes for more information.

Check your connection
Make sure your selected microphone is connected to your computer. If you're not sure what microphone is selected, click the ● icon in the menu bar and select Manage Profiles... Look under Dictation Sources – your selected microphone should be marked with a green dot. Missing microphones are marked with a warning icon (●).

If your microphone is missing, do one of the following:

• Select another microphone from the Dictation Sources panel and click Load. If you don't have an alternative audio source listed, click the + icon under the Dictation Sources panel to add one to your profile.

See Add a dictation source to an existing profile for more information.

• Unplug the microphone and plug it in again. If you are using a USB microphone, make sure it is plugged directly into your computer and not a USB hub.

• For a Bluetooth microphone, go to System Preferences > Bluetooth and make sure that Bluetooth is turned on for your computer and that your microphone is connected.

Check microphone settings
If you do not see the missing microphone icon (●) next to your microphone, check for problems with the microphone itself.

1. In the Apple menu, select System Preferences...
2. Click Sound.
   The Sound screen opens.
3. Click the Input tab.
4. Make sure the microphone appears in the listed devices.
   If your microphone does not appear in the Sound Preference Pane, it will not work in any application.
5. Make sure the microphone you configured with Dragon is selected, then speak into the microphone.
   You should see the Input level indicator respond to the sound of your voice. If it does not respond, there is a problem with your microphone.

   • Check whether your microphone has a mute switch. If it does, make sure the mute switch is off.
   • If you are using a Bluetooth microphone, make sure it is turned on and has enough charge.
   • If your microphone can be turned off, try restarting it.
   • Try using your microphone with a different computer or device.

Restart
Try restarting Dragon.
1. Click the  icon in the menu bar and select **Quit Dragon**.
2. Go to your Applications folder and double-click **Dragon**.

It may also be a good idea to restart your computer.

**Poor audio quality**

If Dragon is able to hear your voice, but the recognition seems poor, you may have a problem with the quality of your audio input.

**Check your microphone placement**

Ensure the microphone is positioned properly and has not moved away from where you originally positioned it when you ran Microphone Setup. See [Microphone placement](#) for more information.

**Recalibrate your microphone or reset the gain**

To make sure your microphone is properly calibrated for your voice and environment, you must go through Microphone Setup for every profile and every dictation source you use.

If your audio input level (gain) is too high or low, you can go through Microphone Setup again at any time by clicking the  icon in the menu bar and selecting **Improve Recognition > Microphone Setup**...

**Reduce background noise**

For best recognition, always try to minimize background noise. Many microphones have noise canceling capabilities, which filter out background noise, but it's still a good idea to keep background noise consistent.

**Listen to your audio**

If the above steps do not solve the problem, try listening to your dictated audio:

1. Dictate some text into a document.
2. Say "*Select <text>*," or "*Select all.*"
3. Say "*Play the selection.*"

If you hear gaps in the audio, or interference such as crackling sounds, your microphone may be the source of the problem.

- If your microphone needs to be plugged into your computer, check the connection. Try unplugging the microphone and plugging it in again. If you are using a USB microphone, make sure it is plugged directly into your computer and not a USB hub.

- If you are using a Bluetooth microphone, make sure it is adequately charged.

- Try using the microphone with a different computer or device, if possible.

- Try using a different microphone.

> Make sure you run Microphone Setup when you connect a new microphone.

**Poor recognition**

If your audio quality is good, but Dragon is not recognizing your speech, try these steps.

**Check your profile**

If you have multiple profiles on your computer, make sure the correct user profile is open.

1. Click the  icon in the menu bar and make sure that your profile has a check mark next to it.
2. If a different profile is checked, select your profile from the **Recent Profiles** list. If you don't see your profile, click **Manage Profiles**... and select and load your profile in the Profiles pane.
Voice Training

The more Dragon hears you speak, the better it understands you. Voice Training helps Dragon learn your speech patterns, intonations, and accent.

- To start Voice Training, click the icon in the menu bar and select Improve Recognition > Voice Training...

See Voice Training for more information.

Vocabulary Training

Vocabulary Training teaches Dragon how you use language. Select one or more text files you have written, and Dragon reads your text to analyze what words you use and when, and how often, you use them.

- To start Vocabulary Training, click the icon in the menu bar and select Improve Recognition > Vocabulary Training...

See Vocabulary Training for more information.

Re-create dictation source

In some cases, re-creating your dictation source can improve recognition. This will preserve all your custom vocabulary and commands, while allowing Dragon to improve how it recognizes your voice.

1. Click the icon in the menu bar and select Manage Profiles...

   The Profile pane opens.

2. Select your profile in the left column.
3. Under **Dictation Sources**, click the button.

   A pop-up panel appears.

   ![Profiles window](image)

4. In the **Microphone** drop-down list, select the same microphone you are currently using and give it a unique name. For example, if you are using the Internal Microphone, you could name this new audio source "Internal Mic" to distinguish it.

5. Click **Continue**.

   The Preferences window closes, and Microphone Setup opens.

6. Complete Microphone Setup. This step can take up to 5 minutes.

7. **Optional**: Go back to the Profiles pane and delete the old audio source:

   1. Select the old audio source from the **Dictation Sources** list.
   2. Click the button at the bottom of the **Dictation Sources** list.
Troubleshooting Dragon Web Extensions

Currently, Dragon offers Web extensions only for Firefox and Safari. If you wish to use a different browser, you can access some Dragon functions:

- You can dictate into most text fields, but you may not have access to correction or editing by voice. Check the Guidance window for information about what Dragon can do in the selected text field. See Mixing dictation with typing for more information.
- You can use menu walking commands to access functionality built into the browser. For example, say "Click File menu," then say "Click New Tab." See Menu Walking for more information.

You cannot use your voice to access links, buttons, or other Web page features. If you need access to these features, use Safari or Firefox instead.

If you are having trouble using Dragon with Safari or Firefox, try these steps:

1. Make sure you have the latest version of Dragon Web Extensions for your current browser.
   - Safari users:
     1. In Safari, click the Safari menu and select Preferences.
        The Preferences window opens.
2. Click Extensions.
3. Check for Dragon in the extensions list on the left.
4. If you have the Dragon Dictate extension installed, you need to uninstall it to prevent conflicts. See Disabling or Uninstalling Dragon Web Extensions—Safari for more information.
5. If you do not see any Dragon extensions listed, click here to install the Safari extension.

- Firefox users:
  1. In Firefox, click Tools > Add-ons.
     The Add-ons Manager opens in a new browser tab.
  2. Click Extensions in the menu on the left.
  4. If you have an outdated version of Dragon Web Extension, Firefox may have disabled it. Click here to install the latest extension.

2. Make sure you have the latest version of your browser:

- Safari users:
  1. On your Mac, open the App Store.
  2. Click Updates.
  3. Install any available updates for Safari or OS X.

- Firefox users:
  1. In Firefox, click the Firefox menu and select About Firefox.
     The About window appears. Firefox automatically checks for a more recent version.
  2. If Firefox finds an available update, follow the instructions to install it. You may need to restart your browser after updating.

3. Many browsers automatically block websites from running extensions and plug-ins. Make sure you have enabled Dragon Web Extension in your browser.

   For details, click the link for your browser:

   - Setting up Dragon Web Extensions—Safari
   - Setting up Dragon Web Extensions—Firefox

Dictation is not working properly in my Web browser

If you are dictating into a Web browser, check the Guidance window for information about what Dragon can do in the selected text region. Even with Dragon Web Extensions installed and working properly, you may not be able to mix talking and typing on some websites.

See Mixing dictation with typing for more information.

Related topics:
- Troubleshooting overview
- Dragon Web Extensions

Troubleshooting Commands

In this topic, learn what to do if you have problems such as:

- MouseGrid does not display on a second monitor
- Custom commands do not work
Custom commands are missing
Custom commands upgraded from Dragon Dictate 4 do not work

MouseGrid does not appear on my second display

If you use more than one display with your computer, MouseGrid may only display on your primary display. To allow MouseGrid to work on both displays:

1. Go to System Preferences and click Mission Control.
2. Deselect Displays have separate Spaces.
3. Close the Mission Control window.
4. Click the Apple menu and select Log Out <User>…
   A confirmation dialog box appears.
5. Click Log out.
7. Start Dragon again if it is not already running.
8. Say “Show MouseGrid.”
   You should now see the MouseGrid on both displays.

New or duplicated commands do not work

If your custom command is not working, try these steps to solve the problem:

- Single-word command triggers are not recommended, as they could be easily misrecognized. For example, if you wanted an Auto-text with your signature, name it "My Signature" rather than "Signature."
- Avoid using words such as "that," "one," "two," etc. in your command triggers, as they may cause conflicts with existing commands.
- Make sure you created the command in the correct context. If you created a command in the Calendar context, for example, it will not work in Finder.
- AppleScript commands need to be Compiled or Run before saving.
  - Open the Commands Manager and find your command in the list.
  - Double-click the command to open the command editor popup window.
  - Click either Compile or Run. Dragon will tell you if there are any errors and change the color of the text if successful:
Custom commands are missing

Occasionally, technical support may tell you to delete the Dragon home folder (/Users/<your username>/Library/Application Support/Dragon). Because your custom commands are stored in this folder, they will no longer appear in your profile.

Important: Do not delete or alter the Dragon home folder unless specifically instructed by Nuance technical support.

Dragon backs up your custom commands in your Documents folder. To restore your commands:

1. Click the ⚙ in the menu bar and select **Show Commands**...
   The Commands window appears.

2. Click the Tools menu (🔧) and select **Import Commands**...

3. Browse to the backup command files in Documents/Dragon/Support/<profile> and import them.

   See [Import and export commands](#) for more information on importing commands.
Commands from Dragon Dictate 4 do not work
If you wrote your own AppleScript commands for Dragon Dictate 4, you need to update those commands. Change any reference in the scripts from "Dragon Dictate" to "Dragon."

Related topics:
- Troubleshooting overview
- The Commands window
- Create a command
- Import and export commands
- MouseGrid
- Where are my files?

Troubleshooting Vocabulary

I can't add documents to Vocabulary Training
If you are unable to add your written documents to the Vocabulary Training window, try these steps to solve the problem.

- Make sure the documents you want to add are in text (.txt and .rtf) or Microsoft Word (.doc and .docx) format.
- Remove any graphics from the documents.
- Divide large files over 3MB into smaller files.

My custom vocabulary words are missing
Occasionally, technical support may tell you to delete your profile. Because your custom vocabulary items are stored in this folder, they will no longer appear if you create a new profile.

Important: Do not delete your profile unless specifically instructed by Nuance technical support.

Dragon backs up your custom vocabulary words in your Documents folder. To restore your vocabulary:

1. Click the in the menu bar and select Edit Vocabulary...
   The Vocabulary Editor appears.
2. Click the Tools menu ( ) and select Import...

Related topics:
- Vocabulary Training
- Editing Dragon's Vocabulary
- Troubleshooting overview
- Troubleshooting audio and recognition

Issues with Upgraded Profiles

In this topic, learn what to do if:

- Your profile upgrade failed
- You can't find your upgraded Transcription profiles

Profile upgrade failed

Dragon does its best to upgrade existing profiles. In rare cases, profiles can contain damage that cannot be repaired when upgraded. If you have no custom vocabulary, the simplest answer is to create a new profile and delete the old damaged profile.

If you have custom vocabulary you need to preserve, you can try these steps:
Option 1:
Before upgrading your profile, Dragon saves a copy in a zip file stored in the /Documents/Dragon/Support folder. Try restoring this backup copy and upgrading again.

1. Quit Dragon.
2. Find your upgraded profiles in /Documents/Dragon.
3. Move any new profiles to the Trash, but DO NOT EMPTY THE TRASH.
4. Unzip the old Dragon version 4 or 5 profile in /Documents/Dragon/Support.
5. Open Dragon and try upgrading the profile again.
   You may or may not be asked to repeat Microphone Setup, based on Dragon’s analysis of how to provide the highest quality recognition after upgrading.
6. Test this upgraded profile to ensure the imported vocabulary works as expected. If so, it is safe to empty the Trash.

Option 2
If you can load the profile, export the user-added vocabulary, then import it to a new profile.

1. Immediately after launching Dragon, load the suspect profile (if not the default), and choose Edit Vocabulary… from the Dragon menu (licas).
   The Vocabulary Editor opens.
2. Choose User from the drop-down list to view only user-added custom vocabulary.
3. Press Command-A on the keyboard to select all items.
4. Click the menu at the bottom of the Vocabulary Editor and select Export.
   A popup window appears.
5. Enter a name for the file in the Save As field
6. In the Where field, select the folder where you want to save the file.
7. Click Export.
   Dragon creates an .xml file containing all custom vocabulary for the selected profile. A notification appears when the export is complete.
8. Click OK, then close the Vocabulary Editor and quit Dragon.
9. Move the suspect profile to the Trash, but DO NOT EMPTY THE TRASH.
10. Launch Dragon.
11. Create a new profile, or use a profile that does not appear to be having issues.
12. Click the icon in the menu bar and select Edit Vocabulary…
13. Click the menu at the bottom of the Vocabulary Editor and select Import.
   A Finder window appears.
14. Select the file you previously saved and click Import.
15. Test this new profile to ensure the imported vocabulary works as expected. If so, it is safe to empty the Trash.

Transcription profile is missing
Dragon Professional Individual for Mac 6 handles Transcription differently than previous versions. If you had profiles set up specifically for Transcription in Dragon for Mac 5 or Dragon Dictate 4, they do not appear in the Profiles pane. Instead, they appear in the Speaker dropdown list in the Transcription window. See What happened to Transcription sources? for more information.
Uninstall Dragon Professional Individual for Mac version 6

In this topic, learn how to:

- Uninstall Dragon
- Remove Dragon's data from your computer
- Remove Dragon Anywhere data from your computer
- Remove Dragon Web Extensions

To uninstall Dragon

1. In the Finder, open your Applications folder.
2. Find Dragon and drag the application to the Trash.
   When prompted, enter your OS X user name and password.

To remove Dragon's data from your hard drive

1. In the Finder, click the Go menu and select Go to Folder...
2. Enter /Library/Application Support and click Go.
3. Find the Dragon folder and drag it to the Trash.
4. Open the Go to Folder... dialog again, enter ~/Library/Preferences and click Go.

   Make sure you include the ~ at the beginning of the path. Your Dragon settings are stored in the
   Preferences folder for your OS User, not the global Preferences folder accessible through your
   hard drive.

5. Find the file com.dragon.dictate.plist and drag it to the Trash.

To remove Dragon Anywhere data

1. Go to the folder Applications/Utilities and open Keychain Access.
2. Find and select Dragon Anywhere Login and press the Delete key to remove it.
3. In the confirmation popup, click Delete.

To remove the Dragon Web Plug-in

1. In the Finder, click on the Go menu and select Go to Folder...
2. Enter /Library/Internet Plug-Ins and click Go.
3. Find the file npDDRia.plugin and drag it to the Trash.

To remove the Dragon Web Extension for Safari

1. In Safari, select Preferences... from the Safari menu.
   The Preferences window opens.
2. Select the Extensions pane.
3. In the left column, select Dragon.
4. Click the Uninstall button.
5. Close the Preferences window.
To remove the Dragon Web Extension for Firefox

1. In Firefox, select **Add-ons** from the **Tools** menu to open the Firefox Add-ons tab.
2. In the Firefox Add-ons tab, click **Extensions** in the panel on the left.
3. Find **Dragon Internet Extension**.
4. Click the **Remove** button.

Related topics:
- Troubleshooting overview
- Where are my files?
- Dragon Web Extensions